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Preface 

The C•CURE 9000 C•CURE ID User Guide is for new and experienced security system users who want to learn to use 
C•CURE ID for the C•CURE 9000 Security Management System. 

In this preface 

How to Use this Manual 12 
Finding More Information 13 
Conventions Used in This Manual 14 
Software House Customer Support Center 15 

C•CURE 9000 C•CURE ID User Guide Preface 11 

EFTA01224888



How to Use this Manual 

How to Use this Manual 

Ibis manual is organized into the following chapters that provide information about C•CURE ID. 

Chapter 1: Introducing C•CURE ID 

Provides basic information about the badging option, including hardware and software requirements. 

Chapter 2: Setting Up a Badging Station 

Tells you how to enable C•CURE ID by registering it in the licensing program, and describes how to set up the 
software and image•capture environments. 

Chapter 3: Setting Up C•CURE ID 

Describes how to use the Badge Setup option on the Administration Client application to customize C•CURE ID for 
your site. 

Chapter 4: Smart Card Setup 

Describes how to set up Smart Card devices and Smart Card templates for programming and enrolling Smart Cards. 

Chapter 5: Designing a Badge 

Describes how to design a badge with C•CURE ID. The chapter explains how to configure portraits, images, text, 
barcodes, and magnetic stripes on a badge layout. 

Chapter 6: Creating Badges for Personnel 

Describes how to perform badging functions such as portrait, fingerprint, and signature capture using C•CURE ID. 

Chapter 7: Printing Badges 

Describes how to preview and print badges for personnel records. 

Chapter 8: Smart Card Programming, Enrollment, and Printing 

Describes how to perform Smart Card programming, enrollment, and printing. 
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Finding More Information 

Finding More Information 

You can access C•CURE 900(1 manuals and online Help for more information about C•CURE 9000. 

Manuals 
C•CURE 9000 software manuals and Software House hardware manuals are available in Adobe PDF format on the 
C•CURE 9000 DVD. 

You can also access the manuals if you install the Adobe Acrobat reader and copy the appropriate PDF files from the 
DVD. See the C• CURE 9000 Installation and Upgrade Guide for more information on copying the C•CURE 9000 
manuals to your system. 

The available C•CURE 9000 and Software House manuals are listed in the C•CURE 9000 Getting Started Guide 
Product Guides and Help section, and appear as hyperlinks in the online.pdf file on the DVD. If you copy the 
manuals folder from the DVD, you can click on any manual listed in online.pdf to open that manual. 

These manuals are also available from the Software House Member Center website 

Online Help 

You can access C•CURE 9000 Help by pressing Fl or clicking Ifelp from the menu bar in the 
Administration/Monitoring Station applications. 
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Conventions Used in T his Manual 

Conventions Used in This Manual 

This guide uses the fol owing text formats and symbols. 

Convention Meaning 

Bold T his font indicates screen elements, and also indicates when you should take a direct action in a procedure. 

Bold font describes one of the following items: 

• A command or character to type 

• A button or option on the screen to press 

• A key on your keyboard to press 

• A screen element or name 

blue color text Indicates a hyperlink to a UR L, or across-reference to a figure, table, or section in this guide. 

Regular Irak font Indicatesa new term, or a book title. 

<text> Indicates a variable. 

The following items are used to indicate important information. 

NOTE 

TIP 

STOP 

Indicates a note. Notes call attention to any item of information that may be of special importance. 

Indicates an alternate method of performing a task. 

Indicates a caution. A caution contains information essential to avoid damage to the system. A 
caution can pertain to hardware or software. 

Indicates a warning. A warning contains information that advises users that failure to avoid a 
specific action could result in physical harm to the user or to the hardware. 

Indicates a danger. A danger contains information that users must know to avoid death or serious 
injury. 
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Software House Customer Support Center 

Software House Customer Support Center 

Telephone Technical Support 

During the period of the Agreement, the following guideline apply: 

• Software House accepts service calls only from employees of the Systems Integrator of Record for the installation 
associated with the support inquiry. 

Before Calling 

Ensure that you: 

• Are the Dealer of record for this account. 

• Are certified by Software House for this product. 

• Have a valid license and current Software Support Agreement (SSA) for the system. 

• Have your system serial number available. 

• Have your certification number available. 

Hours Normal Support Hours Monday through Friday, 8:00 to 8:00 , EST. Except holidays. 

Emergency Support Hours 24 hours/day, seven days a week, 365 days/year. 

Requires Enhanced SSA'7 x 24- Standby Telephone Support 

(emergency) provided to Certified Technicians. 

Fur another customers, billable on time and materials basis. 
Minimum charges apply — See MSR P. 

Phone U.S. 
Puerto Rico 
U.S. Virgin Islands 

+1-800-392-2873 

For other regions, see 
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Software House Customer Support Center 
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Introducing C•CURE ID 

C•CURE ID is a photo badging system that provides imaging and badging technology for Software House Security 
Management Systems. 

In this chapter 

Overview 18 
What's New 19 
Hardware Requirements 20 
Software Requirements 22 
How to Use C•CURE ID 23 
Using Help 25 
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Overview 

Overview 

C•CURE ID is an optional software product for Software House Security Management Systems that provides 
imaging station and badging station capabilities. 

An Imaging Station is a C•CURE 9000 client PC with a video capture capability and a camera that is used to take 
photographs of personnel and store those photos in Personnel records for use on access card badges. 

A Badging Station is a C•CURE 9000 client PC that is used to design badge layouts and to print personnel badges to 
a PVC Badge Printer. An Imaging Station and a Badging Station can be combined on the same client PC. 

NOTE To capture images, you must purchase hardware that supports the TWAIN protocol. See Hardware 
Requirements on Page 20. 
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Wears New 

What's New 

1'1w C•CURE ID Badging Application, version 3.4, has the following new features. 

Enhancements in Version 3.4 

■ Support for the following new devices: Magicard RIO Pro printer, Fargo DTC4500 printer, SCM SDI 011 
Contactless Interface (SCM Wedge), Videology 20K758USB-CL6, 24C738USB-CL8, and 20K758USBSYS cameras. 
See Supported Devices on Page 86. 

Enhancements in Version 3.2 

■ Enrollment for proximity cards on Fargo HDP 5000 printers. This function uses Smart Card configuration to 
define a proximity card template for the OMNIKEY CardMan PC/SC encoder on the Fargo HDP 5000 printer. 
See Enrollment for Proximity Cards on Page 40. 

Enhancements in Version 3.1 

■ Smart Card Programming and Enrollment allows you to program and modify MIFARE smart cards for C•CURE 
9000 Personnel, and enroll MIFARE, iCLASS, and DESFire Smartcard credentials into C•CURE 9000 Personnel 
records. See Smart Card Overview on Page 86. 

■ Smart Card Printing allows you to set up Smart Card printers to program and print Smart Cards individually or 
use the Batch Print Manager to program and print multiple cards. See Smart Card Device Configuration on Page 
89 and Using Print Badge for Smart Card Enrollment, Programming, and Printing on Page 251. 

■ Support for the SCM Microsystems Inc. SDI010 Contactless Reader. The SCM wedge device supports the PC/SC 
interface and includes a MIFARE reader and encoder. See Supported Devices on Page 86. 

■ Support for the Fargo HDP 5000 printer with an OMNIKEY CardMan 5x21-CL 0 PC/SC interface encoder for 
MIFARE or iClass smart cards. See Supported Devices on Page 86. 

■ Import and Export of badge layouts to/from C•CURE 800/8000 to/from C•CURE 9000. In addition, exported 
badge layouts can be used like templates because they can be exported from one system and imported into 
another. See Importing a Badge Layout on Page 133 and Exporting a Badge Layout on Page 134. 

■ Badge sizes up to 11"x 11" inches (27.94 x 27.94 centimeters) are supported. See Setting the Badge Size on Page 
159. 
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Hardware Requirements 

Hardware Requirements 

Both Badging Stations and Imaging Stations must comply with the C•CURE 9000 minimum hardware requirements 
for a client workstation. See the C•CURE 9000 Data Sheet for client workstation requirements. 

In addition, the Badging Station requires the following hardware: 

• C•CURE ID Video Identification and Badging System Package, or equivalent: 

• Camera 

• Tripod 

• Rash 

• Cables 

• PVC Badge Printer (for example: Fargo, MagicCard, Nisca). See Supported Printers on Page 20. 

• Badging Camera (for example, Digi International V2 and VA,3, Videology). See Supported Cameras on Page 21 

Supported Printers 

C•CURE ID supports the badge printers listed in Table 1 on Page 20. 

Table 1: Supported Badging Printers 

Printer Model 

Supported Drivers 

Windows 
XP 

Windows 
2003 

Windows 
Vista 

Windows 7 
32-bit 

Windows 7 
64-bit 

Windows 
2008 32-bit 

Windows 
2008 R2 64- 
bit 

Nisca 5350, 5350i, 
5350m 

0 El I e e p 

Fargo DTC 400, 

DTC550, 

DTC400e 

V 0 0 

Fargo HDP600 ..0 e v V 

Fargo HOP 5000 V 0 V V El 

Fargo DTC4500 V e e v E v zi 

Magicard Tango 
2e, Rio 2e, 
RIO Pro 

0 0 V V V V El 

1 Microsoft Vista is supported, but the user must either log in to the PC as an Administrator or run the Administration 

Workstation appli ation as an administrator. UAC must be turned off only when SMART Card encoding is being used. 
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Hardware Requirements 

Supported Cameras 

C•CURE ID supports the following cameras: 

■ Digi International Watchport/V2 USB digital camera. 

■ Video Associates VA-3 USB digital camera. 

■ Videology 20K758USB-CL6, 24C738USB-CL8, 20K758USB-SYS. 

NOTE 
Software House has qualified the Digi International Watchport/V2 USB digital camera and the VA-3 
USB digital camera for use with the C•CURE ID badging station. 

The Digi International Watchport/V2 USB digital camera is not supported on systems with DEP 
(Data Execution Prevention) enabled. You must turn off DEP to use this camera. 
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Software Requirements 

Software Requirements 

The following are minimum software requirements for a C•CURE ID client: 

■ The system must meet the requirements for a C•CURE 9000 client. See the C•CURE 9000 Data Sheet for more 
information. 

■ The system must have the printer drivers for any installed badge printers. 

Display Properties for Badging Stations 

1he Badging Station display settings should be set to Highest Color (32 bit) and 1024 x 768 pixels. 

To Set the Display Properties on Your Windows System 

1. From the Windows desktop, click Start>Settings and select Control Panel. (On Windows XP, click Start>Control 
Panel). 

2. Double-click Display. The Display Properties dialog box opens. 

3. Click the Settings tab and check that Color quality is set to Highest Color (32 bit) and that the Desktop area is set 
to 1024 by 768 pixels. 
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How to Use C•CURE ID 

How to Use C•CURE ID 

This section outlines the process of setting up and using C•CURE.1O with your C•CURE 9000 Security System. 

Table 2: How to Use C•CURE ID 

Task For More Information 

1. Set up a Badging Station. Chapter 2. Setting Up a Badging Station 

• Setting Up the Room on Page 31 

• Registering C•CURE ID on Page 28 

• Setting Up Permissionson Page 29 

2. Use C•CURE ID Setup to oonfigure the 
system badging and imaging options. 

Chapter 3. Setting Up C•CURE ID 

• Setting Batch Printing Optionson Page 50 

• Configuring a Sheet Layout on Page 56 

• Setting Printer Optionson Page 62 

• Magnetic Encoding Optionson Page 64 

• Configuring Portrait Capture Settingson Page 68 

• Signature Settingson Page 74 

• Configuring Biometric Capture Settingson Page 80 

3. Use C•CURE ID Setup to configure Smart 
Card devices and printers. 

Chapter 4. Smart Card Setup 

• Smart Card Overview on Page 86 

• Smart Card Device Configuration on Page 89 

• Configuring a Smart Card Device on Page 91 

• Smart Card Templateson Page 98 

• Configuring an iClass Smart Card Template on Page 102 

• Configuring a DESF ire Smart Card Template on Page 104 

• Configuring a MIFARE Smart Card Template on Page 106 

4. Use C•CURE ID Badge Designer to design 
your badge layout. 

Chapter 5, Designing a Badge 

• The Badge Designer on Page 124 

• The Badge Layout Panel on Page 138 

• The Badge Layout Properties Panel on Page 151 

• The Image Properties Panel on Page 166 

• The Text Properties Panel on Page 180 

• The Barcode Properties Panel on Page 187 

• Expression Builder on Page 196 

5. Use the Personnel Badging tab in the 
Personnel Record to create personnel 
badges and print them. 

Chapter 6, Creating Badges for Personnel 

• Accessing Personnel Badging on Page 213 

• Assigning a Badge Layout on Page 217 

• Taking Portrait Pictureson Page 218 

• Taking Signatures Using Signature Devices on Page 223 

• Importing Existing Portraitsor Signatureson Page 225 

• Enrolling Fingerprintson Page 227 
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How to Use C•CURE ID 

How to Use C•CURE ID (continued) 

Task For More Information 

6. Use the Personnel Badging tab in the 
Personnel Record to print badges. 

Chapter 7, Printing Badges 

• Previewing a Badge on Page 235 

• Printing a Badge on Page 236 

• Batch Printing Badgeson Page 238 

7. Program, Enroll, and Print Smart Cards Chapter 8, Smart Card Programming, Enrollment, and Printing 

• Smart Card Programming and Enrollment on Page 250 

• Using the EnrolVProgram Smart Card Button on Page 251 

• Using Print Badge for Smart Card Enrollment. Programming. and P:.nt.nd c' 
Page 251 
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Using Help 

Using Help 

The C•CURE ID Badge Setup dialog box and the C•CURE ID Badge Designer provide online help so you can get 
help information while you are using C•CURE ID. 

To Access Help From C•CURE ID Setup 

1. Choose Options & Tools>Badge Setup from the C•CURE 9000 Administration Navigation pane application 
menus. The C•CURE ID Badge Setup dialog box appears. 

2. Click Help or Fl in the C•CURE ID Badge Setup dialog box to open the C•CURE ID Help window. 

To Access Help From C•CURE ID Badge Designer 

1. Choose >Personnel>Badge Layout from the C• CURE 9000 Navigation pane. The Badge Layout Selection dialog 
box appears. 

2. Click New. The C•CURE ID Badge Layout dialog box appears. 

3. Type a name for the Badge Layout in the Name field. 

4. Click Launch C•CURE ID Badge Designer. 

5. Click Help>Help Contents from the menu or Fl in the C•CURE ID Badge Designer to open the C•CURE ID 
Help window. 
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Using I le:p 
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2 

Setting Up a Badging Station 

Once you have installed C•CURE 9000 on your computer, you need to enable C•CURE ID by registering it in the 
C•CURE 9000 licensing program, set up permissions for access to the C•CURE ID software, and set up the image-
capture devices for your badging station. 

In this chapter 

Registering C•CURE ID 28 
Setting Up Permissions  29 
Setting Up the Room 31 
Printer Set-up for Fargo HDP5000 or DTC400e with Encoder 33 
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Registering C•CURE ID 

Registering C•CURE ID 

Use the C•CURE Licensing program to update your license information and enable the C•CURE ID software option. 

Software House includes a license information document with your software. Ensure that you have the license 
information document for C•CURE ID before starting the licensing program. For additional information on running 
the License Program, refer to the C•CURE 9000 Installation and Upgrade Guide. 

When the Administration client application is running, you can view the number of simultaneous badging stations 
allowed by your license on the About C•CURE 9000 dialog box License tab by right-clicking the C•CURE 9000 
System Tray Icon and choosing About from the context menu. If the number of simultaneous badging stations 
displayed on the License tab matches the number on your license information document, that means C•CURE ID is 
licensed and ready to run. 

You can run the licensing program whether or not the C•CURE server is running; however, you must restart the 
C•CURE 9000 Server Service and Framework Service for changes to the licensing program to take effect. 

To Register the Software or Update Your Licenses 

1. Log in to an account with the appropriate privileges. See the C•CURE 9000 Installation and Upgrade Guide for 
information. 

2. Click Start>Programs>SoftwareHouse>C•CURE9000>Licensing. After a few seconds, the C•CURE 9000 
Licensing Program opens with the General Tab displayed. 

3. In the Capabilities section, verify the Simultaneous Badging Stations allowed on your system. See the 
C•CURE 9000 license information document included in your software package for the number allowed. 

4. Click 0 to close the Licensing Application. 
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Setting Up Permissions 

The ability to use the imaging and badging features at a Software House C•CURE 9000 security workstation is 
affected by the following: 

• The number of badging stations specified in the product license for C•CURE 9000. See Simultaneous Badging 
Stations on Page 29. 

• Privileges assigned to each Operator in the Security Management System. See Simultaneous Badging Stations on 
Page 29. 

• Selections made in C•CURE ID Badge Setup. For example, Portrait, Fingerprint, and Signature settings must be 
configured in order to capture or import images, fingerprints, or signatures. Otherwise these options are 
unavailable in the Personnel Editor. 

Simultaneous Badging Stations 

Your license defines the number of clients that can run the C•CURE ID Badging Station components of C•CURE 
9000 at the same time. For example, if you have two licenses, one client can be running the Badge Designer, while 
another could be performing image captures. If a third user tried to use a third client to print badges, they would be 
denied access. The number of Simultaneous Badging Stations is displayed on the About Box License tab. 

Setting Up Operator Permissions 

Before you can use any of the Badging functions, you must make sure your Operator account has the appropriate 
access Privileges to run C•CURE ID. 

An Operator who needs to create and edit Badge Layouts needs to have Edit, Delete, and New Permissions for Badge 
Layout. 

An Operator who needs to import/capture images and assign them to Personnel records needs to have Edit, Delete, 
and New Permissions for Images. 

An Operator who needs to Capture Portraits and Signatures, Print Badges, Enroll Fingerprints, Preview Badges, and 
Batch Print Badges needs to be Granted each of these Permissions under Personnel in Privileges. 

For more information on Privileges, see the C• CURE 9000 Software Configuration Guide. 

To Set Up Operator Permissions 

1. In the C•CURE 9000 Admin client, click the Configuration button in the Navigation pane. 

2. Choose Operator from the drop-down menu in Configuration. 

3. Click ai m to open a Dynamic View listing all Operators. 

4. Select the Operator you want to configure from the list, and double-click that Operator to edit the record. 

5. Note the Privileges assigned to this Operator. 

6. Choose Privilege from the drop-down menu in Configuration. 

7. Click am to open a Dynamic View listing all Privileges. 
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8. Select the Privilege(s) that the Operator was assigned, and review them to make sure that the appropriate 

privileges are enabled, as shown in Table 3 on Page 30. 

Table 3: Bodging Prtviege Settings 

Badging Functions Permissions 

Create arid edit Badge Layouts Badge Layout 

• Edit 

• Delete 

• New 

Import images Images: 

• Edit 

• Delete 

• New 

Perform Personnel Badging functions Personnel: 

Capture Portraitsand 
Signatures 

• Print Badge 

• Enrol Fingerprint 

• Preview Badge 

• Batch Print Badges 
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Setting Up the Room 

C•CURE 113 113 was designed for a typical ID badging office. Your office should include the following equipment for 
an ID setup: 

• A desk for the computer and printer 

• A chair without arms for your subject to sit in 

• A backdrop with backlighting 

• An appropriate power source for the computer, badge printer, and other peripherals 

Place the chair so that the backdrop is about 1 to 2 feet behind the chair, and provide some sort of even backlighting. 
There should be no shadows behind your subject. 

You might want to use a halogen light behind the chair to illuminate the backdrop. You might need a dimmer 
control for adjusting the intensity of the backdrop light. Avoid dark colored walls, and do not place the capture 
system in a dark colored cubicle, as this reduces the amount of lighting on your subject. 

Ambient Lighting 

Try to provide a space that ensures even and controlled ambient lighting. Avoid rooms with large open windows 
that allow sunlight to shine directly on your subject. 

Overhead fluorescent lighting casts a greenish tint that can affect images. To counter this, you can use color-corrected 
fluorescent tubes, available at most speciality lighting stores. Or, you should ensure that your subject is centered 
under the fluorescent lights, then provide enough portrait quality light to compensate. 

Positioning the Camera 

The distance of the camera from the subject is important. The type of camera and lighting you choose dictates the 
proper distance. The following list gives some guidelines for cameras with an f1.8 lens. For specifications, refer to 
the documentation that came with your camera. 

• Place the camera so that it is level or slightly higher than your subject's head. Tilting the camera up yields 
unflattering results. 

• Have the subjects turn their heads slightly to the left or right from the camera, to give a pleasing semi-profile 
image. Positioning the subject in this way also gives some depth to the portrait. 

Portrait Lighting 

The portrait lighting stand (not included) comes with a silver umbrella for reflecting light onto your subject. You can 
substitute a white umbrella and project the light through it for a softer light. 

Flash Lighting 

Place the stand for flash lighting approximately 5 to 6 feet from your subject. 

As in conventional photography, flash introduces a shadow behind the subject's head. To compensate, you should 
consider using a slave strobe flash, such as the Morris AC Slave. The slave strobe has an electric eye that causes it to 
fire when the camera flash goes off. Place the slave strobe on the back of the chair and aim it at the backdrop to 
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eliminate the shadow. Depending on how close the backdrop is, you may have too much light from the slave, which 
creates a flare. In this case, you should use a less powerful slave or place a piece of white paper over the strobe to 
reduce the light. 

NOTE 
If there is more than one capture system in the same room, all the slave strobes may go 
off when one of the main cameras flash. You may need to reorient the capture stations or 
place dividers between the chairs. 

To Ensure Consistent Lighting When Using a Flash 

• Turn the flash on at least five minutes before you start taking pictures, to ensure the flash is fully charged. The 
green light on the back of the flash means that the flash is 80% charged. 

• Set the thyristor control on the front of the flash appropriately. A recommended value to start with is 1/16. The 
M (manual) setting usually emits too much light. 

Portrait Backdrops 

The backdrop you use should be large enough to fill the window of your capture window. Generally, a 36 inch 
square is sufficient. 

The software recognizes any consistent solid color as background and processes the image to remove it or allow 
changes to another color. The only requirement is that the background color must be different from any color in the 
subject (face, clothes, etc.). Blue produces the best results. 

When you place a portrait in a badge layout, the software can examine the top-left and top-right corners of the image 
to determine the background color. If the color is not consistent across the top, automatic detection is not possible. 
The software can also scan the entire image, line by line, and change all the pixels that fall within the specified 
range to a solid known color. 

See Setting Background Detection Properties on Page 172 or information on background detection and adjusting the 
color range. 

NOTE 
If C•CURE ID detects the background color in a person's face or clothing, those pixels 
also change. For this reason, select a backdrop color that is not likely to be in a person's 
hair, eyes, face, or clothing. 
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Printer Set-up for Fargo HDP5000 or DTC400e with Encoder 

The Fargo HDP5000 or DTC400e printer with a MIFARE or iClass encoder requires additional drivers to be installed 
on the badging client workstation connected to the printer. These drivers must be installed in the correct order to 
support all of the Smart Card badging functions provided by the printer. 

To Set-up the Fargo HDP5000 Badge Printer with Encoder on Page 33 

To Set-up the Fargo DTC400e Badge Printer with Encoder on Page 33 

To Set-up the Fargo HDP5000 Badge Printer with Encoder 

1. Perform printer installation according to the Fargo documentation. 

NOTE Do not plug in the printer-to-encoder USB cable until prompted to do so. 

2. Download the most up-to-date driver for the Fargo HDP5000 printer by navigating to the Fargo Support website 
) and selecting Printer from the What type of product drop-down list, then 

selectHDP5000 printer from the available choices and click Go. 

3. Select HDP5000 Driver Windows to download the printer driver. 

4. Navigate to the following webpage to download the OMNIKEY DRIVER: 

5. Select OMNIKEY, then select the OMNIKEY 5125 Reader Board USB PROX encoder. 

6. Choose the Operating System from the drop-down list for the system to which you will connect the printer. 

7. Download the Synchronous API for HID OMNIKEY Readers (currently HID_OMNIKEY_Syrichronous_API_V1_ 
1_1_4B.zip). 

8. Download the OMNIKEY 5x2x Driver PC/SC Driver (currently OMNIKEY5x2x_V1_2_5_2.exe for 32-bit systems 
and OMNIKEY5x2x_V1_2_5_2_x64.exe for 64-bit systems). 

9. Install the PC/SC driver for the Encoder (for example, OMNIKEYfix21_V1_2_5_2.exe) on your badging client PC. 

10. Install the Synchronous API for the Encoder (HID_OMNIKEY_Synchronous_API_V1_1_1_4B.zip) on your 
badging client PC by extracting the contents of the ZIP file to your system and runnung setup.exe from the folder. 

11. Install the Fargo HDP5000 printer driver (HPD5000DRV_2305.exe) on your badging client PC. 

12. Plug in the HDP5000 USB cable as specified in the Fargo 5000 Printer installation instructions. 

13. Restart your badging client PC. 

You can verify the installation by accessing Control Panel/System/ Device Manager on your badging client PC. The 
Encoder should be present in Device Manager under Smart card readers. 

To Set-up the Fargo DTC400e Badge Printer with Encoder 

Pertorzn printer installation according to the Fargo documentation. 

NOTE 
Do not plug in the printer-to-encoder USB cable until prompted to do so. 
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2. Download the most u to-date driver for the Fargo DTC400e printer by navigating to the Fargo Support website 
and selecting Printer from the What type of product drop-down list, then 

selectDTC400e printer from the available choices and click Go. 

3. Select DTC400e Driver Windows to download the printer driver 

4. Select OMNIKEY DRIVER LINK to download information about software downloads for the Encoder. This 
PDF file directs you to the OMNIKEY link at HID Global 

5. Select OMNIKEY, then select the OMNIKEY 5125 Reader Board USB PROX encoder. 

6. Choose the Operating System from the drop-down list for the system to which you will connect the printer. 

7. Download the Synchronous API for HID OMNIKEY Readers (currently HID_OMNIKEY_Synchronous_API_V1_ 
1_1_4B.zip). 

8. Download the OMNIKEY 5x2x Driver PC/SC Driver (currently OMNIKEY5x2x_V1_2_5_2.exe for 32-bit systems 
orOMNIKEY5x2x_V1_2_5_2_x64.exe for 64-bit systems). 

9. Install the PC/SC driver for the Encoder (for example, OMNIKEY5x21_V1_2_5_2.exe) on your badging client PC. 

10. Install the Synchronous API for the Encoder (HID_OMNIKEY_Synchronous_API_V1_1_1_4B.zip) on your 
badging client PC by extracting the contents of the ZIP file to your system and runnung setup.exe from the folder. 

11. Install the Fargo DTC400e printer driver (DTC400e DRV 1200.exe) on your badging client PC. 

12. Plug in the DTC400e USB cable as specified in the Fargo 5000 Printer installation instructions. 

13. Restart your badging client PC. 

You can verify the installation by accessing Control Panel/System/ Device Manager on your badging client PC. The 
Encoder should be present in Device Manager under Smart card readers. 
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Setting Up C•CURE ID 

Setting Up C•CURE ID describes how to use the C•CURE ID Setup dialog box to specify settings for capturing, 
storing, and printing badges. 

In this chapter 

Using C•CURE ID Badge Setup 36 
Enrollment for Proximity Cards  40 
Setting Batch Printing Options  50 
Setting Up Batch Printing 52 
Configuring a Sheet Layout 56 
Setting Printer Options  62 
Magnetic Encoding Options  64 
Setting Magnetic Encoding Options  65 
Configuring Portrait Capture Settings  68 
Signature Settings  74 
Configuring Biometric Capture Settings  80 
Setting up a Bioscrypt Device 82 
C•CURE ID Biometric Configuration Definitions  83 
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Using C•CURE ID Badge Setup 
C•CURE ID Badge Setup lets you configure the settings for data, printers, capture devices, and badge design. 

The following sections provide more information about using C•CURE ID Setup. 

• Accessing C•CURE ID Badge Setup on Page 36 explains how to access C•CURE ID Setup. 

• Badge Setup Tasks on Page 37 provides links to the settings you can configure with C•CURE ID Setup. 

• Badge Setup Definitions on Page 38 gives more information about the fields and buttons on the C•CURE ID 
Setup dialog box. 

The choices you make in C•CURE ID Badge Setup affect the way you use C•CURE ID to: 

• Design badges - see The Badge Designer on Page 124 

• Print badges - see Setting Printer Options on Page 62 

• Capture images - see Configuring Portrait Capture Settings on Page 68 

• Capture biometric data - see Configuring Biometric Capture Settings on Page 80 

You need to view and adjust these settings to make sure that the devices and options for C•CURE ID are configured 
correctly for your system. 

Backing Up Your Images 

Images in C•CURE 9000 are stored in the C•CURE 9000 database and are backed up by C•CURE 9000 database 
backup. See the C•CURE 9000 System Maintenance Guide for more information. 

Accessing C•CURE ID Badge Setup 

The C•CURE ID Badge Setup dialog box lets you specify settings for image capture, magnetic encoding, batch 
printing, and your badge printer. 

To Access the Badge Setup Dialog Box 

1. From the C•CURE 9000 Administration Client, choose Options & Tools>Badge Setup from the Navigation 
pane. 

The C•CURE ID Badge Setup dialog box appears, as shown in Figure 1 on Page 37. 
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Figure 1: C•CURE ID Badge Setup Dialog Box 

Catennt•eOn:•- TeCi :•teep• L<Catee,

CCLOMID S.0,0140 00AbaSe 

Imp01/100.161t• PM, CACCuPe007.000n0 

SoNe Desit. 50.1•9$ 
VAR.: 
0 x 100 
O rag • 20 

C00tire f•05.0. 

CD SinatC•rd 

as

0000•Dreell• 

I ot 

2. See Badge Setup Tasks on I age 37 for more information about the tasks you can perform from 

C•CURE ID Setup. 

3. See Badge Setup Definitions on Page 38 for definitions of the fields and buttons on this dialog box. 

Badge Setup Tasks 

Table 4 on Page 37 lists the tasks that you can perform using C•CURE. ID Badge Setup. 

Table 4: C•CURE ID Badge Setup Tasks 

To Perform this Task... See this Section... 

Set the Import/Export data path. Import/Exportdata path on Page 38. 

Set the Badge Unit of Measure (Inchesor MM). Unitson Page 38. 

Set the options for batch badge printing. Setting Batch Printing Optionson Page 50. 

Set the options for your badge printer. Setting Printer Optionson Page 62. 

Set the options for Magnetic encoding on badges. Magnetic Encoding Optionson Page 64. 

Set the options for Portrait image capture. Configuring Portrait Capture Settingson Page 68. 

Set the options for Signature data capture. Signature Settingson Page 74. 

Set the options for Biometricdata capture. Configuring Biometric Capture Settingson Page 80. 

Set the options for Smart Card programming and enrollment Smart Card Overview on Page 86. 
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Badge Setup Definitions 

The fields and buttons on the C•CURE ID Badge Setup Dialog Box are defined in Table 5 on Page 38. 

Table 5: C•CURE ID Badge Setup Definitions 

Field/Button Description 

C•CURE ID Setup 
File 

C•CURE ID places the initialization file in the location specified here during installation. Any cha nges you make to C•CURE 
ID Badge Setup are written and saved to this file on your computer. 

Import/Export 
data path 

Enter the pathname of the directory from which you want to import badge layouts and/or store exported badge layouts. This 
directory is the location displayed when you select import or Export from the Badge Designer File menu. 

Units 

Inches x 100 

MMx10 

T h is option allows you to size badges in inches or millimeters. Select Inches x 100 or MM x 10. The d ispLay size of these 
measurements is relative to the pixels per inch displayable on your monitor. 

Mag Encoding Lets you specify a badge printer for cards with mag encoding. You can specify a printer and the Encoder prefix and suffix 
used for each magnetic track. To use magnetic encoding. your printer must have an encoding option. 

See Magnetic Encoding Options on Page 64. 

Batch Printing Select th is option if you want to specify batch printing of badges. See Setting Batch Printing Options on Page 50. 

Batching Options Thisoption onty appearswhen Batch Printing is selected. Opens the C•CURE ID Batch/Sheet Printer dialog box where 
you specify batch printing options. 

When you select Batch Printing. all printing is done in batch mode using the C•CURE ID Batch Print Manager. Settings that 
you make on thisdialog box supersede any settings you enter in Printer Options. 

See Batch Print Manager on Page 244 for more information about the Batch Print Manager. 

Printer Options Opens the C•CURE ID Badge Printer Co nt Igu rat ion dialog box where you speedy printer options. These settings onty 
appty if you do not select Batch Printing. 

See Setting Printer Optionson Page 62. 

Portrait check box 

Portrait Settings 
button 

Select this option to specify settings for the portrait capture device. 

Click Portrait Settings to set the options. 

See Configuring Portrait Capture Settings on Page 68. 

Fingerprint check 
box 

Fingerprint 
Settings button 

Select th is option to specifysettingsfor the fingerprint capture device. 

Click Blomotric Settings to set the options. 

See Configuring Biometric Capture Settings on Page 80. 

Signature check 
box 

Signature Settings 
button 

Select th is option to specify settings for the signature capture device. 

Click Signature Settings to set the options. 

See Signature Settings on Page 74. 
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C•CURE ID Badge Setup Definitions (continued) 

Fiekleutton Description 

SmartCard check 
box 

SmartCard 
Settings button 

Select thisoption to specify settings for your Smart Card device. 

CbckSmartCard Settings to set the options. 

See Smart Card Device Configuration on Page 89. 

Help Click Help to open the C•CURE ID Help system. See Using Help on Page 25. 

OK Click OK to accept the changes you have made to C•CURE ID Setup and return to the C•CURE 9000 Administration Client. 

Cancel ClickCancel to exit C•CURE ID Setup and return to the C•CURE 9000 Administration Client. 
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Enrollment for Proximity Cards 

You can configure C•CURE ID to perform individual or batch enrollment of card numbers from proximity cards on 
a Fargo HDP 5000 printer that is equipped with an OMINKEY CardMan 5x25 encoder. The printer's encoder enrolls 
the card number from the card to the chosen Personnel record, and the printer prints the badge design on the card. 

Typically, you use batch enrollment to create badges for a selected group of Personnel from a pre-numbered batch of 
proximity cards. Batch enrollment captures the card number and uses an Import definition to add the card number 
to the correct Personnel record in C•CURE 9000. 

You set up batch enrollment using C•CURE ID Setup, and you create a C•CURE 9000 Import definition to import 
the data read from the proximity cards into the C•CURE 9000 Personnel database. You can then enroll a multiple 
cards to selected Personnel using the Batch Print Badge selection on the Personnel Dynamic View context menu. 

Configuring Enrollment 

You can configure Proximity Card enrollment three different ways: 

• Batch Enrollment - Configure Botching Options in C•CURE ID Setup to use a Proximity Card Enrollment 
template, then queue a batch of credentials to print using Badge Batch Print from the Credentials or Personnel 
Dynamic View. 

• Individual Enrollment - Configure Printer Options in C•CURE ID Setup to use a Proximity Card Enrollment 
template, then send individual credentials to print using Print Badge from the Personnel editor Badging tab. 

• Individual Enrollment without Printing - Configure SmartCard Settings in C•CURE ID Setup to use a Proximity 
Card Enrollment template, then send individual credentials to enrollment using Enroll/Program Smart Card 
from the Personnel editor Badging tab. 

How Batch Enrollment Works 

1. You use C•CURE ID Badge Setup to configure Batch Printing with enrollment using the Fargo HDP 5000 printer 
with an OMNIKEY CardMan 5x25 encoder. 

NOTE (Alternatively, you can configure the Personnel Badging tab Print Badge button to enroll/print badges 
individually, or the Enroll/Program Smart Card button if you do not want to print the badges.) 

2. You define a C•CURE 9000 Import definition to listen for new imports and import the Enrollment data into 
Personnel records. 

3. You select the Personnel records to which you want the proximity card data enrolled from the Personnel or 
Credentials Dynamic View, and send the records to batch print using Batch Print Badges. 

4. The printer prints the badge and encodes the data to a .CSV file. 

5. The Import Watcher notices the new .CSV file and uses the Import definition you defined to import the data. 

6. For each of the Personnel you selected, the card number of the proximity card you printed as a badge is enrolled 
to the correct Personnel record. 

NOTE The import of batch enrollment data into Personnel records makes use of the Text24 and Text25 fields 
of the personnel record. This means that these two fields are not available for other use. If you have 
previously used these fields in Personnel records, and subsequently batch enroll data from a proximity 
card, any data that existed in the Text24 and Text25 fields is overwritten. 
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Batch Enrollment Tasks 

You need to perform the following tasks to configure and perform batch enrollment of proximity cards. 

• Configuring Batch Enrollment for Proximity Cards on Page 41. 

• Configuring Individual Enrollment for Proximity Cards on Page 42. 

• Configuring an Import Definition for Batch Enrollment on Page 44. 

• Performing Batch Enrollment for Proximity Cards on Page 253. 

• Performing Individual Enrollment for Proximity Cards on Page 254. 

Configuring Batch Enrollment for Proximity Cards 

To set up batch enrollment for proximity cards, your badge printer must be a Fargo HDP 5000 with an OMNIKEY 
CardMan 5125 encoder. With this encoder, you can enroll card number information into selected Personnel records 
while you are printing your C•CURE ID card design onto the cards. 

To Configure Batch Enrollment in Badge Setup 

1. Access C•CURE ID Badge Setup. See Accessing C•CURE ID Badge Setup on Page 36. 

2. On the Badge Setup dialog box, select ElBatch printing?, then click Batching options. The Batch/Sheet Print 
Configuration dialog box opens. 

3. Select 0Smartcard, then click Smartcard. the Smart Card device Configuration dialog box opens. 

4. Select Fargo - Prox : USB from the Device Type drop-down list. 

5. Select the OMNIKEY Cardman 5x25 CL encoder from the Encoder Name drop-down list. If this encoder name 
is not available, you should check to make sure the encoder is installed correctly in your Fargo printer, and that 
your printer is accessible to your Badging Station. 

6. Select your Fargo HDP 5000 printer from the Printer Name drop-down list. 

7. Select 0 Create Import File so that the enrollment process creates a file to be imported containing the enrollment 
data. 

8. Click New Template to create a new Smart Card Template for your proximity cards. The SmartCard Template 
dialog box appears (see Figure 2 on Page 41). 

Figure 2: SmartCard Template Dialog Box 
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9. Select Prox and click OK. The Prox Configuration dialog box appears (see Figure 3 on I age 42). 
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Figure 3: Prox Configuration Dialog Box 
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10. Type a name for the Prox Configuration template in the Name field. 

11. Confirm Enrollment Data is not used with batch enrollment, so you need not select this option. 

12. Select a proximity card format from the Card format drop-down list. 

13. Click OK. The Smart Card Device Configuration dialog box re-appears, with the template you defined added to 
the list of Available templates. 

14. Select your new template in the Available list and click Add —> to add the template to the Selected list for the 
device. 

15. Click OK to close the Smart Card Device Configuration dialog box. 

16. Click OK to close the Batch/Sheet Printer Configuration dialog box. 

17. Click OK to close C•CURE ID Badge Setup, saving your changes. 

Configuring Individual Enrollment for Proximity Cards 

To set up individual enrollment for proximity cards, your badge printer must be a Fargo HDP 5000 with an 
OMNIKEY CardMan 5125 encoder. With this encoder, you can enroll card number information into selected 
Personnel records while you are printing your C•CURE ID card design onto the cards. 

NOTE 
If you configure Batch Enrollment using Batching Options, those settings take precedence 
over any settings you configure using Printer Options. You can still enroll and print 
individual cards by selecting them to print individually from the Batch Print Manager 
Queue (see Batch Print Manager on Page 244). 

You can configure individual enrollment two ways: 

• For enrollment and printing using Printer Options in Badge Setup and the Print Badges button on the Personnel 
Editor Badging tab. 

• For enrollment only using Smartcard in Badge Setup and the Enroll/Program Smart Card button on the 
Personnel Editor Badging tab. 

To Configure Individual Enrollment and Printing in Badge Setup 

1. Access C•CURE ID Badge Setup. See Accessing C•CURE ID Badge Setup on Page 36. 

2. On the Badge Setup dialog box: 

3. To configure enrollment only, skip to step 5. 
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4. To configure enrollment and printing, select 0 Printer Options, then click Batching Options. The Batch/Sheet 
Print Configuration dialog box opens. 

5. Select 2 Smartcard, then click Smartcard. The Smart Card device Configuration dialog box opens. 

6. Select Fargo - Prox : USB from the Device Type drop-down list. 

7. Select the OMNIKEY Cardman 5x25 CL encoder from the Encoder Name drop-down list. If this encoder name 
is not available, you should check to make sure the encoder is installed correctly in your Fargo printer, and that 
your printer is accessible to your Badging Station. 

8. Select your Fargo HDP 5000 printer from the Printer Name drop-down list. 

9. Select 2 Create Import File so that the enrollment process creates a file to be imported containing the enrollment 
data. 

10. Click New Template to create a new Smart Card Template for your proximity cards. The SmartCard Template 
dialog box appears (see Figure 4 on Page 43). 

Figure 4: SmartCard Template Dialog Box 
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11. Select Prox and click OK. The Prox Configuration dialog box appears (see Figure 5 on Page 43). 

Figure S: Prox Configuradon Dialog Box 

Pcox fordequration 

Comm 

Name 

❑ Cmarm Epiphyte Data 

Ora 

[radioing 
LI

OK 

Cancel 

12. Type a name for the Prox Configuration template in the Name field. 

13. Confirm Enrollment Data is not used with batch enrollment, so you need not select this option. 

14. Select a proximity card format from the Card format drop-down list. 

15. Click OK. The Smart Card Device Configuration dialog box re-appears, with the template you defined added to 
the list of Available templates. 

16. Select your new template in the Available list and click Add —> to add the template to the Selected list for the 
device. 

17. Click OK to close the Smart Card Device Configuration dialog box. 

18. Click OK to close the Batch/Sheet Printer Configuration dialog box. 

19. Click OK to close C•CURE ID Badge Setup, saving your changes. 
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Configuring an Import Definition for Batch Enrollment 

To enroll proximity cards to C•CURE 9000 Personnel records from C•CURE ID, you need to set up an Import 
definition to import the card number data from the proximity card into the correct Personnel record and credential. 

Whenever proximity cards are enrolled, a new .CSV file is added to the watched folder you defined in 
C•CURE ID Setup. The Import Watcher associated with your Import Definition processes this file and uses the field 
mapping and match fields you have specified to import the proximity card number information into the correct 
Personnel records for each proximity card. 

You need to perform the following tasks to configure an Import definition for batch enrollment. 

• Creating a Data Import Definition for Batch Enrollment on Page 44 

• Specifying the Data Conversion for the Import on Page 46 

• Defining the Match Fields for the Import on Page 48 

For more information about Data Imports, see the C•CURE 9000 Software Configuration Guide. 

Creating a Data Import Definition for Batch Enrollment 

The Data Import definition uses the Import Watcher server component to initiate a data import when a new file is 
created in a watched folder on the C•CURE 9000 server. You configure the Data Import to watch for new .csv files in 
a specific directory, and when a .csv file appears, the Data Import updates the records in the database that match the 
Personnel and Credential GUM numbers in the .csv file. 

To Create a Data Import Definition for Batch Enrollment 

1. From the Configuration pane, select Data Import from the drop-down list. 

2. Click New to create a new Data Import definition. The Data Import editor opens. (See Figure 6 on Page 45.) 
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Figure 6: Data Import Editor 
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3. Type a name for the Data Import in the Name field. 

Example: 

Prox Card Enrollment 

4. Click El in the Source Type field and select CSV File import source for the Source type. 

5. Select Listening on data from the Automation mode drop-down list. 

6. Specify the folder that you want the Import Watcher to monitor for new .csv files in the Folder on server field. 

Choose the folder that you specified in C•CURE ID Badge Setup as the Import/Export data path (see Badge Setup 
Definitions on Page 38). 

The default value for this folder is typically C: \ Program Files \ Software House \ SWHSystem Badging. 

7. Specify .csv as the File Pattern. 

8. Select Delete source file after import (because you are using the automated import mode Listening on data). If 
you do not select this option, you will need to manually delete the import files from the folder. 

9. Set the Default Import Mode to Update only matched; do not add records. The Enrollment process does not 
support adding new Personnel records. (If a dialog box appears asking "To complete import configuration it is 
necessary to select matching fields. Do you want to do it now? Yes/No" click No because it is easier to define 
data conversion first. 
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10. You can click Save and Close to save your changes, or continue to edit the Import definition by Specifying the 
Data Conversion for the Import on Page 46. 

Specifying the Data Conversion for the Import 

To import the enrolled data from the proximity card to a C•CURE 9000 Personnel record requires data conversion 
from a .csv flat file to a hierarchical structure. To configure a Data Import definition, you need to have enrolled one 
or more proximity cards using Batch Print Badges, or you can use the sample .CSV file 
(SWEISystem \ Client \ ImportScripts SampleProxEnroll.csv) as an import sample. 

To Specify the Data Conversion for the Import 

1. In the Data Import editor, click the Data Conversion tab. (See Figure 7 on Page 46.) 

Figure 7: Data Import Data Conversion Tab 
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2. Click the down-arrow on the Add button and select Field Mapping Tool. 

3. A Select File with Sample dialog box opens. Navigate to the folder containing a .csv file that resulted from 
enrolling proximity cards, or use SWHSystem \ Client \ ImportScripts SampleProxEnroll.csv, the sample file 
provided with C•CURE 9000. Select the sample file you wish to use and click OK. 

4. The Field Mapping Tool appears. (See Figure 8 on Page 47) 
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Figure 8: Field Mapping Tool 
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5. In the C•CURE 9000 Data Target type field, click the drop-mow and select Personnel. 

6. Make sure the Data Source Fields row labeled GUID has GUM selected in the C • CURE 9000 Target Fields 
column. 

7. Click on the Field Mapping Tab control (circled in Figure 8 on Page 47) to create a new Mapping tab. 

8. In the C•CURE 9000 Data Target type field, click the drop-arrow and select Credential. The tab name changes 
from Mapping to Credential. 

9. Select Card Number from the drop-down list in the Data Source Fields row labeled Credential_CardNumber. 

10. Select GUM from the drop-down list in the Data Source Fields row labeled Credential_GUID. 

11. Click Save and Close. The Field Mapping Tool closes and a field mapping tool row has been added to the Data 
Conversion table. 

12. Click the down-arrow on the Add button and select Custom Stylesheet. The Custom Stylesheet dialog box 
appears (see Figure 9 on Page 48). 
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Figure 9: Custom Stylesheet Dialog Box 
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13. Click Select Stylesheet. Select PersonnelFlattoNestedaslt (you may need to navigate to Program Files \ Software 
House \ SWHSystem \ Client \ ImportScripts to find this file) and click Open. 

14. Click Save and Close. 

15. You can click Save and Close to save your changes, or continue to edit the Import definition by Defining the 
Match Fields for the Import on Page 48. 

Defining the Match Fields for the Import 

The converted data needs to be mapped into the appropriate field in the Personnel record using the Field Mapping 

To Define the Match Fields for the Import 

I. In the Data Import editor, click the Match Fields tab (see Figure 10 on Page 49). 

2. Click Add and select Personnel from the selection dialog box that appears. The schema for Personnel appears. 
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Figure 10: Match F 'MOO al) Personnel Schema 
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1. Select GUM from the right-hand column. 

2. Click next to Personnel, then click on Credential. 

3. Select GUID and Card number (only) in the right-hand column. 

4. Click Save and Close to save your Import Definition. 

The Import Watcher should begin to process any enrollment .CSV files in the target folder. Whenever you enroll 
additional proximity cards, the Import Watcher will use the data in the resulting .CSV files to import the enrollment 
data to C•CURE 9000 Personnel records. 
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Setting Batch Printing Options 
Batch Printing allows you to print several badges together or on a sheet printer designed for this purpose. 

To configure batch printing, select Batch Printing in the C•CURE ID Badge Setup dialog box, and the Batching 
Options button becomes available. You can then specify batch printing options for your badges from the C•CURE ID 
Batch/Sheet Printer dialog box. 

See Batch Printing Definitions on Page 54 for more information about the fields and buttons on this dialog box. 

Batch Printing Setup Tasks 

You can perform the following tasks to configure C•CURE ID Batch Printing. 

■ Accessing the Batch/Sheet Printer Dialog Box on Page 50 

■ Setting Up Batch Printing on Page 52 

■ Setting the Origin Offset for Badge Printing on Page 53 

■ Setting Up Batch Queue Mode on Page 53 

■ Configuring the Badge Sheet Layout for a Badge Printer on Page 56 

Accessing the Batch/Sheet Printer Dialog Box 

To setup your badge printer for batch/sheet printing, perform the following steps. 

To Access the Batch/Sheet Printer Configuration Dialog Box 

L Select Batch Printing? from the C•CURE ID Badge Setup dialog box. The Batching Options button becomes 
available. 

2. Click Batching Options. The Batch/Sheet Printer Configuration dialog box opens, as shown in Figure 11 on Page 
51. 
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Figure 11: Batch/Sheet Printer Configuration Dialog Box 
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You can select the settings for Batch Printing (see Setting Batch Printing Options on Page 50). 

Click OK to save the settings you configured, or Cancel to discard any changes. 
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Setting Up Batch Printing 

Perform the following steps to set up Batch Printing in C•CURE ID Badge Setup. 

To Set Up Batch Printing 

1. Access C•CURE ID Badge Setup (see Accessing C•CURE ID Badge Setup on Page 36). 

2. Click Batch Printing? to make the Batching Options button available. 

3. Click Batching Options in the C•CURE ID Setup dialog box. The C•CURE ID Batch/Sheet Printer Configuration 
dialog box opens. 

4. Select a specific printer or the Windows default printer from the Selected Badge Printer for Batch and Sheet 
Printing drop-down list of available printers on your system. 

5. You can view and adjust the settings for your printer by clicking Printing Preferences to display the Windows 
standard printer properties dialog box. 

6. If necessary, provide the origin offset values for the x-axis and y-axis (see Setting the Origin Offset for Badge 
Printing on Page 53). 

7. If your batch printer is a Smart Card printer, select the Smartcard check box and click the Smartcard button to 
configure the Smart Card printer (see Smart Card Device Configuration Tasks on Page 89). Note that Smartcard 
and Use Sheet Layout are mutually exclusive. You cannot use the printer for both Smartcard 
enrollment/programming and sheet printing. 

8. Select the Batch Queue Mode: 

Always Ask - When you select Print Badge from Edit Personnel Record, the Batch Print Manager dialog box 
appears to let you choose between printing a single badge and printing additional badges in the badge print 
queue. 

Auto Print - When you select Print Badge from Edit Personnel Record, the badge is sent to print, unless you 
had chosen Use Sheet Layout? during set up. If Use Sheet Layout? was selected, the badge is added the 
print queue. When the number of badges queued matches the number of badges on the Badge sheet layout, a 
sheet of badges is automatically printed. 

Manual Print - Select Manual Print to always send the current badge to the batch printing queue.You can 
then print the badge manually from the queue. To print the badges in the queue, see Printing a Badge on 
Page 236. 

9. If you have a badge sheet printer and wish to set up a sheet layout, select Use Sheet Layout? and the Layout 
Sheet button becomes available. 

10. If you want to set up sheet printing, click Layout Sheet. See Configuring a Sheet Layout on Page 56 for more 
information. 

11. Click OK to save your changes to the C•CURE ID Batch/Sheet Printer dialog box. 

Selecting a Batch Printer 

To identify the badge printer you want to use for batch/sheet printing, perform the following steps. 
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To Select a Batch Printer 

1. Open the C•CURE ID Batch/Sheet Printer dialog box (see Accessing C•CURE ID Badge Setup on Page 36). 

2. Select a specific printer or the Windows default printer from the available printers on your system in the 
Selected Badge Printer list. 

3. Click OK to save your changes and close the C•CURE ID Batch/Sheet Printer dialog box. 

Setting the Origin Offset for Badge Printing 

The Origin Offset settings move the badge image right or left on the x-axis and up or down on the y-axis from the 
top-left corner of a badge during printing. You can use this option to adjust the placement of the printed image on 
the badge if necessary. 

If you have selected inches as the unit of measurement, the offset values are in 1/104)ths of an inch. 

If you have selected millimeters as the unit of measurement, the offset values are in 1/10ths of a millimeter. 

• A positive X value moves the image right. 

• A negative X value moves the image left. 

• A positive Y value moves the image down. 

• A negative Y value moves the image up. 

To Set Origin Offsets for Batch Printing 

1. Open the C•CURE ID Batch/Sheet Printer dialog box (see Setting Batch Printing Options on Page 50). 

2. Enter a number for the offset values on the x-axis in the X: field. 

3. Enter a number for the offset value on the y-axis in the Y: field. 

4. Click OK to save your changes and close the C•CURE ID Batch/Sheet Printer dialog box.' 

To Set Origin Offsets for Badge Printing 

1. Open the C•CURE ID Badge Printer dialog box (see Setting Printer Options on Page 62). 

2. Enter a number for the offset values on the x-axis in the X: field. 

3. Enter a number for the offset value on the y-axis in the Y: field. 

4. Click OK to save your changes and close the C•CURE ID Badge Printer dialog box. 

Setting Up Batch Queue Mode 

You can set the Batch Queue mode to determine how C•CURE ID processes a request to print a badge. Perform the 
following steps to configure this setting. 
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To Set Batch Queue Mode 

1. Open the C•CURE ID Batch/Sheet Printer dialog box (see Accessing C•CURE ID Badge Setup on Page 36). 

2. Select the Batch Queue Mode: 

• Always Ask: to ask the user whether to print the badge now or send it to the batch printing queue. 

• Auto Print to always print the current badge. 

• Manual Print to always send the current badge to the batch printing queue.You can then print the badge 
manually from the queue. 

3. Click OK to save your changes and close the C•CURE ID Batch/Sheet Printer dialog box. 

Batch Printing Definitions 

The fields and buttons on the C•CURE ID Batch/Sheet Printer dialog box are defined in Table 6 on Page 54. 

Table 6: Batch/Sheet Printer Configuration Dialog Box Definibons 

FlekUButton Description 

Selected 
Batch Printer 

Select a printer from the list of available Windows printers that are on your system. 

Printing 
Preferences 

Opens a standard Windows Printer Propertiesdialog box so that you can examine and modify the printer 
settings. 

Origin Offset Moves the badge image from the top-left corner of a card right or left (x), up or down (y). 

If the selected measurement unit is inches, the values shown represent the offset in 1/100 of an inch. 

If the selected measurement unit is millimeters, the values shown represent the offset in 1/10 of a millimeter. 

A positive offset value moves the image right or down while a negative value moves the image left or up. 

Smartcard 
check box 

Smartcard 
button 

Select this option to specify settings for your Smart Card batch printer. Click SmartCard to set the options. 

if you select the Smartcard duackbox, Use Sheet Layout? becomes unavailable. You cannot use sheet 
layout with a Smart Card printer. 

See Configuring a Smart Card Device on Page 91. 

You can also use this setting to configure Batch Enrolment of HID Corporate 1000 proximity cards on a 
Fargo HDP 5000 printer. See Enrollment for Proximity Cards on Page 40. 

Windows 
Default Printer 

Displays the name of the printer currently selected as the default Windows printer. 

Queue 
Storage 
Location 

In C•C UR E 9000, the Batch Print queue information is stored in the database. 

Batch Queue 
Mode 

Choose one of the following Batch Queue modes: Always Ask. Auto Print. or Manual Print. 

AlwaysAsk When you selects Print Badge from Edit Personnel Record, a Print Badges Now? dialog appears to let 
the user choose between printing a single badge and printing all badges in the badging dialog. 
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Batch/Sheet Printer Configuration Dialog Box Definitions (continued) 

Field/Button Description 

Auto Print When you select Print Badge from Edit Personnel Record, the badge is sent to print, unless you had 
chosen Use Sheet Layout? during setup. If Use Sheet Layout? was selected, the badge is added the 
print queue. When the number of badges q ueued matches the number of badges on the Badge sheet 
layout, a sheet of badges is automatically printed. 

Manual Print When you select Print Badge from the Personnel Badging tab. it adds the badge to the badge print queue, 
rather than sending it to print. You can then manually print the badge from the queue. 

Use Sheet 
Layout? 

If you wish to set up a sheet layout to print multiple badges per sheet, select Use Sheet Layout? and the 
Layout Shoot button becomesavailable. 

If you select the Smarteard checkbox, Use Sheet Layout? becomes unavailable. You cannot use sheet 
layout with a Smart Card printer. 

Layout Sheet If you want to set up sheet printing, click Layout Sheet. See Configuring a Sheet Layout on Page 56 for 
more information. 

Help Launches the online help for the Batch/Sheet Printer Configuration dialog box. 

OK Accepts and saves your changes in the Badge Printer dialog box and returns you to the C•CUREID Badge 
Setup Dialog box. 

Cancel Returns you to the C•CUREID Badge Setup dialog box without accepting or saving any changes made in 
the Badge Printer dialog box. 
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Configuring a Sheet Layout 

The Sheet Layout Design dialog box lets you configure the way badges are printed to a printer that supports badge 
sheet printing. The Sheet Layout Design dialog box shows a preview of the badge sheet as it is currently configured. 
You adjust the settings so that the preview matches the way your sheets of badges are laid out, so that C•CURE ID 
can print your badge sheets correctly. As you adjust the settings on the dialog, the preview changes to reflect the 
changes you have made. 

Example: 

If your badge sheets have four rows, each with two badges, you can use this dialog box to configure C•CURE ID 
so that the correct amount of spacing between badges is allotted when a badge sheet is printed. 

C•CURE ID now provides the ability to use AveryTM Label Templates as badge sheet layouts for batch/sheet 
printing. You can select an Avery label template as the basis of your sheet layout, so that you can easily print label 
versions of your badges, or use the Label Designer to create a label design to print database information on labels, 
such as mailing labels. See Using the Label Designer to Create/Modify a Custom Layout on Page 58 for more 
information. 

See Sheet Layout Configuration Dialog Box Definitions on Page 59 for more information about the fields and buttons 
on this dialog box. 

You need to enable Batch Printing to access the Sheet Layout Design dialog box. See Setting Batch Printing Options 
on Page 50. 

Sheet Layout Design Tasks 

You can perform the following tasks from the Sheet layout Configuration dialog box. 

• Configuring the Badge Sheet Layout for a Badge Printer on Page 56 

• Saving a Custom layout on Page 57 

• Loading a Custom layout on Page 58 

• Using the label Designer to Create/Modify a Custom Layout on Page 58 

Configuring the Badge Sheet Layout for a Badge Printer 

To Configure the Badge Sheet Layout for a Badge Printer 

1. Open the Batch/Sheet Printer dialog box (see Accessing the Batch/Sheet Printer Dialog Box on Page 50). 

2. Select Use Sheet Layout? from the Batch/Sheet Printer dialog box. 

3. Click Layout Sheet to set up the print page layout. The Sheet layout Configuration dialog box opens. 
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Figure 12: Sheet Layout Configuration Dialog Box 

4. Verify that the correct printer is listed in the Sheet Printer section. If the correct printer is not listed, click Cancel, 
then select the correct printer from the Batch/Sheet Printer Configuration dialog box. 

5. Select the Layout Name from the drop-down list for the sheet layout you want to use. A visual depiction of the 
sheet layout is displayed in the Layout Preview area of the dialog box. 

6. If you want to change the order in which badges are printed in the layout, click Re-Order to toggle the print 
order (in a 2x3 layout, you would toggle between a 123456 and a 142536 print order). The change in print order 
is shown on the layout preview. 

7. If you want to create a new custom layout based on the layout you selected, click New. If you want to modify a 
custom layout, click Edit 

8. If you want to delete the currently selected layout, click Delete. 

9. Click OK to save your settings on the Sheet Layout Design dialog box. 

10. Click OK to save your changes and close the C•CURE ID Batch/Sheet Printer dialog box. 

Custom Sheet Layout Templates 

You can use any of the templates as the basis of a custom sheet layout. In a custom sheet layout you can change 
settings like the side and top margins, horizontal spacing, and the number of rows or columns. You can save your 
custom sheet layout with a name you choose, and select this custom sheet layout for batch sheet printing. 

Saving a Custom Layout 

You can save the settings that you configure on the Sheet Layout Configuration dialog box so that you can 
subsequently load and use these settings. This capability is useful if you are setting up a new printer or diagnosing 
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an issue with an existing one. You can save your settings, experiment with new settings, and restore the saved 
settings if needed. 

To Save a Custom Layout 

1. Open the Batch/Sheet Printer Configuration dialog box (see Accessing the Batch/Sheet Printer Dialog Box on 
Page 50). 

2. Select Use Sheet Layout? from the Batch/Sheet Printer Configuration dialog box. 

3. Click Layout Sheet to set up the print page layout. The Sheet Layout Configuration dialog box opens. 

4. Select a layout from the Layout Name field. 

5. Click New to create a new layout, or Edit to edit an existing layout. 

6. Make any needed changes to the layout, then click Save to save the new settings. 

7. Click OK to set the currently selected layout to be used to batch print badges. 

Loading a Custom Layout 

If you have previously saved a layout, you can load it and replace the settings currently displayed on the Sheet 
Layout Design dialog box. 

To Load a Custom Layout 

1. Open the Batch/Sheet Printer Configuration dialog box (see Accessing the Batch/Sheet Printer Dialog Box on 
Page 50). 

2. Select Use Sheet Layout? from the Batch/Sheet Printer Configuration dialog box. 

3. Click Layout Sheet to set up the print page layout. The Sheet layout Configuration dialog box opens. 

4. Select the layout you want to load from the layout Name drop-down list. 

5. Click OK to set the currently selected layout to be used to batch print badges. 

Using the Label Designer to Create/Modify a Custom Layout 

You use the Label Designer dialog box to create new custom layouts or modify existing ones. 

To Use the Label Designer to Create/Modify a Custom Layout 

1. From the Sheet layout Configuration dialog box, click New or Edit to open the label Designer dialog box. 
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Figure 13: Label Designer Dialog Box 
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2. Type in a layout name for the new layout (if you are editing an existing layout, this field is read only). 

3. Make any adjustments to the settings for the layout by using the spinners for each field, or typing in the field 
box. As you make change, they are reflected in the Label Properties graphic depiction at the top of the dialog 
box. See Table 8 on Page 61 for definitions of the fields. 

4. Click Save to create a new sheet layout, or save the change you made to an existing sheet layout. 

Sheet Layout Configuration Dialog Box Definitions 

The fields and buttons on the Sheet Layout Configuration dialog box are defined in Table 7 on Page 59. All 
measurements are in the unit of measure specified for the badge deign on the Setup dialog box (see Badge Setup 
Definitions on Page 38). 

Table 7: Sheet Layout Configuration Definitions 

Box Description 

Layout Preview of 
the page 

This area of the dialog box shows a visualrepresentation of the layout selected in the Layout 
Name field. 

Sheet Printer 
Name 

Displays the name of the batch sheet printer you configured on the Batch/Sheet Printer 
Configuration dialog box. This is a read-only field. 

Print Width The print width of the badge sheet in the unit of measure selected, based on the size of the 
page the printer can print. This is a read-only field. 
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Box Description 

Print Height The print wdth of the badge sheet in the unit of measure selected, based on the size of the 
page the printer can print. This is a read-only field. 

Layout Name Thisdrop-down list includes all the Avery Label Templates that are included with C•CURE ID 
and the custom label templates that you have designed and saved. The template that you 
select is used to batch print badges. The settings for the selected template are displayed in the 
fields below, and are shown in the Layout Preview area. This selection is also used as the 
basisof a custom design when you click the Newor Edit buttons. 

Side Margin Shows the setting for the left side margin for the selected badge layout. 

Top Margin Shows the setting for the top margin for the selected badge layout. 

Label Height Shows the height of each badge/label for the selected badge layout. 

LabelWdth Shows the wdth of each badge/label for the selected badge layout. 

Vertical Spacing Shows the vertical spacing between the labels for the selected badge layout. 

Horizontal Shows the horizontal spacing between the labels for the selected badge layout. 
Spacing 

Number of Rows Shows the number of rows in the selected badge layout. 

Number of Shows the number of columns in the selected badge layout. 
Columns 

OK Click this button to set your currently selected sheet layout as the sheet layout for your batch 
printer. 

Cancel Click this button to discard all changes and close the Sheet Layout Configuration dialog box. 

Help Click this button to open online Help for the Sheet Layout Configuration dialog box. 

Re-order Click this button to toggle the number order for badges on the sheet layout. The number order 
is displayed on the Layout Preview. 

Example: 

If you have a 2 x3 badge layout, the badge number order is either of: 

1 2 1 4 
3 4 2 5 
5 6 3 6 

New Click to open the Layout Designer dialog box with the current layout as a default. You can make 
changes to the layout and then save it as a custom layout. 

Edit Click to open the Layout Designer dialog box and edit a custom layout. You can only edit 
custom layouts. However, you can use New to open a standard layout and save it as a custom 
layout. 

Delete Click to delete the selected sheet layout. 

Use carefully. because you can delete any layout. and there is no undo function. If you delete a 
custom layout by mistake. you will have to recreate it. 
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Label Designer Dialog Box Definitions 

The fields and buttons on the Label Designer dialog box are defined in Table 8 on Page 61. All measurements are in 

the unit of measure specified for the badge design on the Badge Setup dialog box (see Badge Setup Definitions on 

Page 38). 

Table 8: Layout Designer Dialog Box Definitions 

Box Description 

Label 
Properties 

This area of thedialog box shows a visual representation of the label settings for the layout. 

Layout Name Displays the name of the layout you are editing. If you are creating a new layout you can type a name in the field. If you are editing 
an existing layout, this field is read-onty. 

Side Margin Sets the left side margin (distance between the left edge of the sheet and the left column of labels) for the sheet layout. 

Top Margin Sets the top margin (distance between the top edge of the sheet and the first row of labels) for the sheet layout. 

Horizontal 
Spacing 

Sets the amount of space between label colu m ns for the sheet layout. The number in this field is the total of the abetwidth and the 
space between columns. 

Vertical 
Spacing 

Sets the amount of space between label rows for the sheet layout. The number in this field is the totalof the label height and the 
space between rows. 

Height Sets the height of each badge/label for the sheet layout. 

Width Sets the width of each badge/label for the sheet layout. 

Rows Sets the number of rows in the sheet layout. 

Columns Sets the number of columns in the sheet layout. 

Save Click this button to save your settings for this sheet layout. 

Cancel Click this button to discard all changes and close the Label Designer dialog box. 
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Setting Printer Options 

From the C•CURE ID Setup dialog box, you can click Printer options to configure your badge printer. 

You can print badges on individual cards to a printer designed to print badges. 

For instructions on connecting your printer to the computer, see the documentation supplied with your printer. 

To set up batch printing of badges, refer to Setting Batch Printing Options on Page 50. 

To Set Up a Badge Printer 

1. In the C•CURE ID Badge Setup dialog box, click Printer options. The C•CURE ID Badge Printer Configuration 
dialog box opens. 

Figure 14: Badge Printer Dialog Box 
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2. Select a specific printer or the Windows default printer from the available printers on your system in the 
Selected Badge Printer list. 

3. Provide the Origin offset values in the X-axis and Y-axis fields. See Setting the Origin Offset for Badge Printing 
on Page 53 for information about Origin offset values. 

4. If your printer supports Smart Card printing, you can click 0 Smartcard to enable Smart Card configuration, 
then click Smartcard— to configure this printer for Smart Card printing. See Smart Card Device Configuration on 
Page 89. 

5. Click OK to finish configuring your Badge Printer. 

Badge Printer Configuration Dialog Box Definitions 

The Badge Printer Configuration dialog box has the following fields and buttons. 
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Table 9: Badge Printer Configuration Options 

Field Description 

Selected Badge 
Printer 

Select a printer from the list of available Windows printers that are on your system. 

Printing 
Preferences 

Opens a standard Windows Printer Properties dialog so that you can examine and modify the printer 
settings. 

Origin offset (x/y) Moves the badge image from the top-left corner of a card right or left (x), up or down (y). This adjustment 
can be used to position the badge image to print correctlywith your printer. If the selected measurement 
unit is inches, the values shown represent the offset in 1/100 of an inch. If the selected measurement unit is 
millimeters, the values shown represent the offset in 1/10 of a millimeter. A positive offset value moves the 
image right or down whae a negative value moves the image left or up. 

Smartcard 
checkbox 

Smartcard button 

Select this option to specify settings for your Smart Card printer. 

Click SmartCard to set the options. 

See Configuring a Smart Card Device on Page 91. 

Windows Default 
Printer 

Displays the name of the printer currently selected as the default Windows printer. 

Help Launches the online help for the Badge Printer Configuration dialog box. 

OK Accepts and saves your changes in the Badge Printer dialog box and returns you to the C•CURE ID Badge 
Setup Dialog box. 

Cancel Returns you to the C•CURE ID Badge Setup dialog box without accepting or saving any dianges made in 
the Badge Printer Configuration dialog box. 

Changing the Default Printer 

The badging printer must be a specific printer, rather than a default printer. If you do not have another printer 
connected to your computer, set up a "dummy" default printer and install the printer driver. 

- Or - 

If you have two printers attached to your system, including your badging printer, you can change the Windows 
default printer. 

To Change the Windows Default Printer 

1. On the desktop, click Start>Settings>Printers. 

2. Select the name of the printer you want to make the default. 

3. Choose File>Set as Default Printer. 
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Magnetic Encoding Options 

You can encode information from the C•CURE 9000 Personnel record in one of the three magnetic tracks available 
with magnetic cards. 

The following links provide more information about C•CURE ID Magnetic Encoding Configuration. 

■ Setting Magnetic Stripe Encoding Formats on Page 165 

■ To Access C•CURE ID Magnetic Encoding Configuration on Page 65 

■ To Configure Magnetic Encoding on Page 65 

■ Magnetic Encoding Definitions on Page 65 

The encoded information on a magnetic card can include the information in Table 10 on Page 64. 

Table 10: MagneticCard Information 

Available for All Card Formats Available for Enhanced (256-bit) Card Formats Only 

• 

• 

• 

• 

• 

Facilityorcompanycc& 

Issuecode 

Siteoode 

Card number 

Expiration date 

• 

• 

• 

• 

Agency code 

System code 

Credential series 

Credentialissue 

The Controller interprets the encoded information in a track when a user swipes a magnetic card containing encoded 
information, such as a card number, through a card reader. 

Once you have set up the magnetic encoding hardware as described here, you can add up to three tracks to a badge 
layout and specify the information you want to include. 

NOTE Card readers that are sold by Software House for use with C•CURE 9000 for access 
control can, by default, read Track 2 only. 

You must have a printer with the encoding option. You can then specify which magnetic tracks will be used. The 
prefix and suffix for each magnetic track are special characters encoded by the printer to indicate the start and end of 
the data that you want to include in the track. 

You should be familiar with the card formats being used by your readers. See Mag Encoding Tab on Page 154 for 
information on configuring the magnetic tracks. 
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Setting Magnetic Encoding Options 

The C•CURE ID Magnetic Encoding dialog box lets you configure the settings for a encoding magnetic tracks on the 
badges you print. 

To Access C•CURE ID Magnetic Encoding Configuration 

From the C•CURE ID Setup dialog box, you can click Mag Encoding to configure your magnetic encoding device. 

Once you have set up the magnetic encoding hardware you can add up to three tracks to a badge layout and specify 
what information you want to include. See Encoding Magnetic Tracks on Page 160 for more information. 

NOTE You must have a printer with the encoding option to specify the magnetic tracks used. The 
prefix and suffix for each magnetic track are special characters encoded by the printer to 
indicate the start and end of the data that you want to include in the track. 

To Configure Magnetic Encoding 

1. From the C•CURE ID Setup dialog box, click Mag Encoding. The C•CURE ID Magnetic Encoding dialog box 
opens. 

2. Select your printer from the Select Encoder Device drop-down list. The Encoder text string prefix and suffix for 
each track then fills automatically. 

3. You can change the default string prefix and suffix for each track by typing different text strings into these fields. 

4. If your printer needs to use text for magnetic encoding rather than character images (glyphs) select Write 
encoded data as text 

5. To reset encoder text strings to default settings for the chosen printer type, click Reset. 

6. If you do not want to use the Encoder text string prefix and suffix for a track, click in the 1'refix or Suffix field, 
highlight the text, and press Delete. 

7. Click OK. 

Magnetic Encoding Definitions 

The following fields and buttons appear on the Magnetic Encoding Configuration dialog box. 

Table 11: Magnetic Encoding Configuration Options 

Name Description 

Select 
Encoder 
Device 

The Select Encoder Device drop-down list provides a list of the supported devices. See Table 12 on Page 66. 

Encoder 
Text 
Strings 

The Encoder text string weft< and suffix for each track is filled automatically with the supplied default values for each of the devices. If 
you need to change these values to work with your printer, you can type a new value in the appropriate box. You can reset the values to 
the default settings by decking Reset. 

Track 1 
Prefix 

Enter the prefa value used to tel the printer device to turn on Mag Track 1 Encoding for the data that folows. 
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Magnetic Encoding Configuration Options (continued) 

Name Description 

Track 1 
Suffix 

Enter the suffix value used to tell the printer device to turn off Mag Track 1 Encoding following the data. 

Track2 
Prefix 

Enter the prefix value used to tell the printer device to turn on Mag Track 2 Encoding for the data that follows. 

Track2 
Suffix 

Enter the suffix value used to tell the printer device to turn off Mag Track 2 Encoding following the data. 

Track 3 
Prefix 

Enter the prefixvalue used to tell the printer device to turn on Mag Track 3 Encoding for the data that follows. 

T rack 3 
Suffix 

Enter the suffixvalue used to tell the printer device to turn off Mag Track 3 Encoding following the data. 

Reset Click to reset the Suffix and Prefixvalues for the currently selected Encoding Device back to the Default settings. 

Help Click to launch the online help for the Magnetic Encoding dialog box. 

OK Click to save the current cha nges and return you to the C•CURE ID Badge Setup dia log box. 

Cancel Click to return to the C•CURE ID Badge Setup dialog box without saving changes. 

Fable 12 on Page 66 provides the prefix and suffix defaults for each device type. 

Table 12: Magnetic Encoding Device Defaults 

Device Prefix Defaults Suffix Defaults 

Atlantek Track 1 -1= 

Track 2 -2= 

Track 3 -3= 

Track 1 (None] 

Track 2 ]None] 

Track 3 ]None] 

Datacard Ill Track 1 ]None] 

Track 2 ]None] 

Track 3 ]None] 

Track 1 ]None] 

Track 2 ]None] 

Track 3 ]None] 

Datacard IV Track 1 ]None] 

Track 2 ]None] 

Track 3 ]None] 

Track 1 ]None] 

Track 2 ]None] Track 3 (None] 

Ettron Track 1 -1 

Track 2 -2 

Track 3 -3 

Track 1 ]None] 

Track 2 ]None] 

Track 3 ]None] 
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Magnetic Encoding Device Defaults (continued) 

Device Prefix Defaults Suffix Defaults 

Fargo Track 1 -1% 

Track 2 -2: 

Track 3 -3: 

Track 1 , 

Track 2 ? 

Track 3 ? 

Nisca Track 1 -@1,0,0:

Track 2 —@1,2,0, 

Track 3 -@1.4.0. 

Track 1 (None] 

Track2 (None] 

Track3 ]None] 

Polaroid Track 1 -1 

Track 2 -2 

Track 3 -3 

Track 1 (None] 

Track 2 (None] 

Track 3 (None] 

Other Track 1 -1 

Track 2 -2 

Track 3 -3 

Track 1 (None] 

Track 2 (None] 

Track 3 ]None] 
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Configuring Portrait Capture Settings 

The C•CURE ID Portrait Configuration dialog box lets you configure the settings for portrait capture. 

You need to view and adjust these settings to make sure that the devices and options for C•CURE ID portrait 
capture are configured correctly for your system. 

NOTE You must select Portrait in the C•CURE ID Setup dialog box to enable the Portrait Settings option, or 
you will not be able to access the C•CURE ID Portrait Configuration dialog box. 

See Portrait Configuration Tasks on Page 69 for a list of Portrait Settings configuration tasks you can perform from 
C•CURE ID Setup. 

For more information about the fields and buttons on the Portrait Configuration dialog box, see Portrait 
Configuration Dialog Box Definitions on Page 72. 

To Access Portrait Configuration 

To access the C•CURE ID Portrait Configuration dialog box: 

1. Choose Options & Tools>Badge Setup from the C•CURE Administration Client. The C•CURE ID Badge Setup 
dialog box appears. 

2. Select the Portrait checkbox, then click Portrait Settings. The C•CURE ID Portrait Configuration dialog box opens 
(see Figure 15 on Page 68). 

Figure 15: C•CURE ID Portrait Configuration Dialog Box 
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Portrait Configuration Tasks 

From the C•CURE 11.) Portrait Configuration dialog box, you can perform the following tasks to set up portrait 
capture: 

• Setting the Height and Width for Graphics on Page 69 

• Choosing a Graphic Format on Page 69 

• Selecting a Capture Device for Portraits on Page 70 

• Setting Up a TWAIN Device for Portrait or Signature Capture on Page 71 

• Setting Up Import from File for Portrait Capture on Page 72 

Setting the Height and Width for Graphics 

You can set height and width values for portraits by entering values in the appropriate boxes in the C•CURE ID 
Portrait Configuration dialog box. 

The Capture Width and Capture Height values determine the proportions of the images you capture. The default 
value, 375 by 300, captures a 1 1/4 inch x 1 inch (32 x 25 mm) image consisting of 375 rows, each 300 pixels wide. 

The default capture height and width are suitable for most image captures. An image capture size of 1 inch x 1 inch 
(25 x 25 mm) is a good size for a credit-card size badge; a resolution of 300 pixels maintains image quality with 
some enlargement. 

NOTE 
You can shrink or enlarge an image on the badge layout. If you enable the option 
Proportional Stretch, the image will not distort; if you have disabled Proportional Stretch, 
the image might be distorted if you shrink or enlarge it. See Image Source Tab Definitions 
on Page 168. 

The actual printed size may be scaled differently, since you determine the printed size when you design the badge. In 
the C•CURE ID Badge Designer, the Formatlingfieicts in the Image Properties panel lets you set the size of printed 
images. See The Image Properties Panel on Page 166 for more information. 

There is a slight performance advantage if you avoid unnecessary scaling. Un-scaled images process faster and are 
usually sharper than scaled images. Software House recommends the following formula: 

image width (pixels) = printer resolution (dots/inch) X image size (inches) 

If the print resolution is greater than 300 dots per inch, capture enough pixels for a 300 resolution printer and let the 
system automatically scale the image. 

Choosing a Graphic Format 

C•CURE ID can create images in several different file formats. The default format is Joint Photographic Experts 
Group or JPEG, a compression technique that achieves higher compression by reducing the resolution of an image. 
JPEG is the best choice for portrait images, unless you need to use another image processing product that cannot 
handle JPEG. The best file type for signatures is TIF Mono. 
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NOTE 
For consistent results, you should decide on a format before beginning your image captures. 

For Portrait captures, set the Graphic format in the Image File Type field in the Portrait Configuration 
Dialog Box Definitions on Page 72. 

For Signature captures, set the Graphic format in the Image File Type field in the Signature 
Configuration Dialog Box Definitions on Page 79. 

To Choose a Graphics Format 

• In the C•CURE ID Portrait or Signature Configuration dialog box, choose from a list of possible formats from the 
Image File Type drop-down list: 

Table 13: Image Format List 

Image 
File 
Type 

Description 

jpg Recommended for portraits. JPEG format provides the best compression, but image information is lost during compression. 
The system stores images with the extension .JPG. 

If you choose this format, a value for the JPEG quality appears to the right. Supply a value in this box to indicate the balance 
between compression and image quality. A value of 100 produces the highest image q uaty with minimal compression. The 
default value, 70, provides a good compromise between high compression and good image quality. 

Tif 
Mono 
(1bpp) 

This version of Tagged Image File Format (TIFF) is recommended for signatures. The Tif Mono selection uses 1 bit per pixel. 
For black and white images only: not for grayscale. 

Tif Tagged Image File Format (TIFF) with a file extension of .tif. This format is popular format for high color-

depth images. 

BMP 

(BOP) 

Provdes an uncompressed Windowscolor bitmap. The system stores imageswith the extension .BMP. 

BMP 
(24bpp) 

Provides a compressed Windowscolor bitmap. The system stores images with the extension .BMP. 

BMP 

(fibPP 
GRAY) 

Provdes an uncompressed Windowsgrayscale bitmap. The system stores imageswith the extension .BMP. 

WMF Provides a Windows Meta F ile. The system stores images with the extension .WMF. 

Selecting a Capture Device for Portraits 

The Capture Device list in the Portrait Configuration dialog box lets you select a capture device for portraits. 

To Select a Capture Device for Portraits 

1. On the C•CURE ID Setup dialog box, select (CI) Portrait , then click Portrait Settings. The C•CURE ID Portrait 
Configuration dialog box opens. 
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2. In the Capture Device Settings list, select one of the following options: 

Table 14: Portrait Capture Devices and Descriptions 

Option Description 

Import 
from 
File 

Select this option to import existing portrait or signature images. See Setting Up Import from File for Portrait Capture on Page 
72. 

TWAIN Select this option if you are using a TWAIN interface board to capture signatures or portraits. 

If you are using the WatchportN USB Digital Camera, select TWAIN as your device. Use the TWAIN setup to set your camera 
up. 

C•CURE ID supports the TWAIN interface, but the TWAIN interface does not support all of the C•CURE ID software options, 
such as software-controlled zooming. The quality of images captured using TWAIN hardware and interface may not equal the 
qualityof images ca ptured using the Flashpoint VGA capture board. See Setting Up a TWAIN Device for Portrait or Signature 
Capture on Page 71. 

NOTE 
C•CURE ID supports the TWAIN interface, but C•CURE ID does not control the TWAIN functionality. 
Refer to the documentation for your TWAIN capture device for information on using these features. 

Selling Up a TWAIN Device for Portrait or Signature Capture 

If you have a TWAIN device on your system, use the following procedure to choose capture options for capturing 
Portraits or Signatures. 

You can use a TWAIN device to capture both portraits and signatures. 

NOTE 
If you are using a TWAIN protocol capture device, you might not have access to all of the software-
controlled camera and flash options. Refer to the documentation provided by your TWAIN supplier. 

To Set up a TWAIN Device for Portrait or Signature Capture 

1. In the C•CURE ID Portrait or Signature Configuration dialog box, select Twain from the Capture device list. 

Figure 16: Capture Device Settings Selection 
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Figure 17: TWAIN Source Configuration Dialog Box 
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3. Select either a specific driver to always use to capture portraits, or select Always Ask to select a specific driver 
each time you capture an image. 

4. Click OK to save the settings. 

Setting Up Import from File for Portrait Capture 

If you already have portraits or signatures in a compatible file format you can import them into the personnel 
records. 

To Set Up Import from File as the Capture Device 

1. From the C•CURE ID Badge Setup dialog box, select (o) Portrait, then click Portrait Settings. The C•CURE ID 
Portrait Configuration dialog box opens. 

2. From the Capture Device drop-down list, choose Import from File. 

3. You can set other Portrait Configuration options from this dialog, and when you are ready to save your settings, 
click OK. 

Portrait Configuration Dialog Box Definitions 

The Portrait Configuration dialog box has the following fields and buttons. 

Table 15: C•CURE ID Portrait Configuration Properties 

Field Description 

Capture Width and 
Capture Height 

Enter the height and width of images on badges in *els. See Setting the Height and Width for Graphics on Page 69 
for more information. 

Capture Image Fie Type 

and JPEGOuakty 

Specify the graphic format for images. See Choosing a Graphic Format on Page 69 for more information. 
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C•CURE ID Portrait Configuration Properties (continued) 

Field Description 

Autocrop Select this option to a utomaticalty size captured images. If this option isnot selected, you can ma n ualty size (crop) 
images after capture. 

Brightness/Contrast 
enabled 

Select this for an optional after-ca pture adjustment of the brightness and contrast. Brightness and contrast can be 
adjusted on the second window that dispLays after the Ise image has been captured. 

Enable both device 
capture and import from 
file 

Select this to display both optionson the Personnel Imaging tab. The Imaging tab then displays a button labeled 
Capture I Import is displayed to allow you to choose either: 

• Capture via a Capture Device. 

• Import from file 

If you do not select this option, then the button displays as Capture 

Capture Device Select the device that you will use to capture images. 

• Twain - Use this option if the input device is a scanner or camera which uses the industry standard TWAIN 
interface. Device setup for this option is dependent upon the Twain Device Driver/ Manufacture. 

• Import from file - Use this option if the image is already in a file somewhere on your computer or network. No 
device settings are available for this option. 

See Selecting a Capture Device for Portra its on Page 70. 

Device Setup Device Setup is available when you select a Capture Device option other than Import from File. 

• See Setting Up a TWAIN Device for Portrait or Signature Capture on Page 71 for instructionson Device setup 
for a TWAIN device. 

Help Click this button to access the help for C•CURE ID Setup. 

OK Click this button to save your changes and return to the C•CURE ID Setup dialog box. 

Cancel Click this button to cancel your changes and return to the C•CURE ID Setup dialog box. 
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Signature Settings 

The C•CURE ID Signature Configuration dialog box lets you specify image options for signatures. Use this window 
to specify a location, size, and graphics format for image files, a capture device for taking images, and device 
options. 

You need to view and adjust these settings to make sure that the devices and options for C•CURE ID signature 
capture are configured correctly for your system. 

To Access Signature Configuration Settings 

1. Choose Options>Badge Setup from the C•CURE Administration Client menus. 

2. Select the Signature check box, then click Signature Settings. The C•CURE ID Signature Configuration dialog 
box opens. 

Figure 18: C•CURE ID Signature Configuration Dialog Box 
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For more information about the fields and buttons on the Signature Configuration dialog box, see Signature 
Configuration Dia og Box Definitions on Page 79. 

Signature Configuration Tasks 

From the C•CURE ID Signature Configuration dialog box, you can perform the following tasks to set up signature 
capture: 
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• Specifying Capture Settings for Signatures on Page 75 

• Selecting a Capture Device for Signatures on Page 76 

• Configuring a Penware Tablet as the Capture Device on Page 76 

• Configuring a Topaz Tablet as the Capture Device on Page 77 

• Choosing Cropping Options for Signatures on Page 75 

• Enabling Brightness/Contrast Adjustment on Page 75 

• Configuring Import from File as the Signature Capture Device on Page 78 

Choosing Cropping Options for Signatures 

If you want to be able to crop the signature after it is taken, you need to clear the Auto crop option, to enable a 
bounding box that you can resize to fit the part of the image you want to use. If you select Auto crop, the image is 
automatically sized for you. 

To Choose Cropping Options for Signatures 

1. From the C•CURE ID Badge Setup dialog box, select the Signature check box, then click Signature Settings. The 
C•CURE ID Signature Configuration dialog box opens. 

2. In the Capture Settings section of the dialog, select Auto crop to enable images you have captured to 
automatically be cropped to the Capture Width and Capture Height you have specified.When Auto crop is not 
selected, a bounding box is displayed after captures, and you can manually resize the box to crop the captured 
image. 

3. You can set other Signature Configuration options from this dialog, and when you are ready to save your 
settings, click OK. 

Enabling Brightness/Contrast Adjustment 

If you want to be able to adjust brightness and contrast after the signature is taken, you need to enable 
Brightness/Contrast adjustment. 

To Enable Brightness/Contrast Adjustment 

1. From the C•CURE ID Badge Setup dialog box, select the Signature check box, then click Signature Settings. The 
C•CURE ID Signature Configuration dialog box opens. 

2. Select the Brightness/Contrast enabled check box if you want to be able to adjust the brightness and contrast of 
captured signatures. 

3. You can set other Signature Configuration options from this dialog, and when you are ready to save your 
settings, click OK. 

Specifying Capture Settings for Signatures 

You configure the settings for capturing signatures by on the C•CURE ID Signature Configuration dialog box. 
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To Specify Capture Settings 

1. From the C•CURE ID Badge Setup dialog box, select the Signature check box, then click Signature Settings. The 
C•CURE ID Signature Configuration dialog opens. 

2. In the Capture width (pixels) field, enter the width in pixels for captured images. 

3. In the Capture height (pixels) field, enter the height in pixels for captured images. 

4. Select the graphic format for images in the Image File Type field from the drop-down list. The choices for 
graphic formats are the same as those for Portraits. The best file type for signatures is TIFF Mono. 

5. If you have selected JPEG as the Image File Type, you can set the JPEG Quality for the captured image, with a 
range from 1 to 100 (100= best quality). Type in a number from 1 to 100 to set the JPEG Quality. 

6. You can set other Signature Configuration options from this dialog, and when you are ready to save your 
settings, click OK. 

Selecting a Capture Device for Signatures 

The Capture Device field in the C•CURE IDSignature Configuration dialog box lets you select a capture device for 
signatures. 

To Select a Capture Device for Signatures 

1. Click Signature Settings in the C•CURE ID Badge Setup dialog box. 

2. In the Capture Device list, select one of the following options: 

Table 16: Signature Capture Devices and Descriptions 

Option Description 

Import 
from File 

Select this option to import existing signature images. See Selecting a Capture Device for Signatures on Page 76. 

Penware 
Sig 
Tablet 

Select this option to use a Penware signature tablet for signatures. See Selecting a Capture Device for Signatures on Page 76 for 
more information. 

Topaz 
Sig 
Tablet 

Select this option to use a Topaz signature tablet for signatures. See Selecting a Capture Device for Signatures on Page 76 for more 
information. 

TWAIN Select thlsoption if you are using a TWAIN interface board tocapture signatures. 

If you are using the WatchportN USB Digital Camera, select TWAIN as your device. Use the TWAIN setup to set your camera up. 

C•CURE ID supports the TWAIN interface, but the TWAIN interface does not support al of the C•CURE ID software options, such as 
software-oontrolled zooming. See Setting Up a TWAIN Device for Portrait or Signature Capture on Page 71. 

Configuring a Penware Tablet as the Capture Device 

Perform the following steps to configure a Penware tablet as your capture device for signatures. 
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To Configure a Penware Tablet as the Capture Device 

1. From the C•CURE ID Badge Setup dialog box, select the Signature check box, then click Signature Settings. [he 
C•CURE ID Signature Configuration dialog opens. 

2. From the Capture Device drop-down list, choose Penware Sig Tablet 

3. Click Device Setup. The Penware Signature Configuration dialog box opens. 

Figure 19: Penware Signature Configuration Dialog Box 

Penware Signature Configuration 

Line weight g 

Help OK Cancel 

 • 

4. Type a value between 1 and 10 in the Line weight field to specify the thickness of the line. The default value is 3. 

5. Click OK. 

6. You can set other Signature Configuration options from this dialog, and when you are ready to save your 
settings, click OK. 

Configuring a Topaz Tablet as the Capture Device 

Perform the following steps to configure a Topaz tablet as your capture device for signatures. 

NOTE 
To configure a Topaz Signature Tablet to perform signature capture from a Client running Windows 
Vista, the Operator must be logged on as an Administrator. 
Once the Topaz Tablet is configured in C•CURE ID Setup, a non-Administrator user can capture 
Signatures with the tablet from the Personnel Badging tab. 

To Configure a Topaz Tablet as the Capture Device 

1. From the C•CURE ID Badge Setup dialog box, select the Signature check box, then click Signature Settings. The 
C•CURE ID Signature Configuration dialog box opens. 

2. From the Capture Device drop-down list, choose Topaz Sig Tablet 

3. Click Device Setup. The Topaz Signature Configuration dialog box opens. 
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Figure 20: Topaz Signature Configuration Dialog Box 
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4. Select the type of tablet you are using from the Topaz tablet type list. 

NOTE 
If you change the tablet type selection, the system attempts to update the Sigplus.ini file 
(typically in C: \ Windows). The current user must have write permissions to this folder. On 
Vista, UAC must be off (temporarily) for this operation to succeed. 

If this update is not successful, when you attempt to capture a signature an error message is 
displayed stating that "No Topaz device is attached". 

5. In the Communication port field, type the Communication port that is being used to connect the signature tablet 
to the system. The default is 1. 

6. In the Pen width field, enter a line weight value between 1 and 9. The default line thickness is 3. 

7. Click OK. 

Configuring Import from File as the Signature Capture Device 

If you already have signatures in a compatible file format you can import them into the personnel records by 
configuring Import from File as your device for Signature capture. 

To Configure Import from File as the Capture Device 

1. From the C•CURE ID Badge Setup dialog box, select the (0) Signature check box, then click Signature Settings. 
The C•CURE ID Signature Configuration dialog box opens. 

2. From the Capture Device drop-down list, choose Import from File. 

3. You can set other Signature Configuration options from this dialog, and when you are ready to save your 
settings, click OK. 
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Signature Configuration Dialog Box Definitions 

The Signature Configuration dialog box has the following fields and buttons. 

Table 17: C•CURE ID Signature Configuration Properties 

Field Description 

Signature Storage 
Location 

In C•CURE 9000, Signatures are stored in the C•CURE 9000 data base. 

Capture Width and 
Capture Height 

Enter the height and width of images on badges in pixels. See Signature Configuration Tasks on Page 74 for more 
information. 

Image File Type Specify the gra ph ic format for images. See Signature Configuration Tasks on Page 74 for more information. 

Brightness/Contrast 
enabled 

Select this for an optional after-capture adjustment of the brightness and contrast. Brightness and contrast can be 
adjusted on the dialog box that displays after the image has been captured. 

Auto crop Select thisoption to a utomaticalty size captured images. If thisoption is not selected. you can ma n ua lty size (crop) images 
after capture. 

Capture Device Select the device that you will use to capture images. You can use a camera, a TWAIN device, a signature device, or 
Import from file. See Signature Configuration Taskson Page 74. 

Device Setup Select your options for capture devices. See the appropriate section for the device you are using. See: 

• Configuring a Penware Tablet as the Capture Device on Page 76 

• Configuring a Topaz Tablet as the Capture Device on Page 77. 
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Configuring Biometric Capture Settings 
The C•CURE ID Biometrics Configuration dialog box lets you configure the settings for a fingerprint capture device, 
as well as how the system should communicate with the hardware and how the data is encoded for storage. 

You need to view and adjust these settings to make sure that the devices and options for C•CURE ID fingerprint 
capture are configured correctly for your system. 

NOTE 
You must select Fingerprint in the C•CURE ID Setup dialog box to enable the Biometric Settings option 
before you can set up the device options for capturing fingerprints. 

C•CURE ID Biometric Configuration Tasks 

From the C•CURE ID Biometric Configuration dialog box, you can: 

■ Accessing C•CURE ID Biometric Configuration on Page 80 

■ Setting up a Bioscrypt Device on Page 82 

See C•CURE ID Biometric Configuration Definitions on Page 83 for more information about the fields and buttons on 
this dialog. 

Accessing C•CURE ID Biometric Configuration 

lb configure a biometric device to capture fingerprints, you must enable the Fingerprint image capture setting on the 
Badge Setup dialog box. 

 m•I 
To Access C•CURE ID Biometric Configuration 

1. Choose Options & Tools>Badge Setup from the C•CURE Administration Client Navigation pane. 

2. Select the Fingerprint check box, then click Biometric Settings.The C•CURE ID Biometrics Configuration dialog 
box opens. 
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Figure 21: C•CURE ID BametricsConfigurabon dialog box 
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Setting up a Bioscrypt Device 

Perform the following steps to set up a Bioscrypt device for capturing fingerprints. 

To Set up a Bioscrypt Hardware Device 

1. From the C•CURE ID Badge Setup dialog box, click Fingerprint, then click Biometric Settings. The C•CURE ID 
Biometrics Configuration dialog box opens. 

2. Select Bioscrypt from the Sensor Type drop-down list. 

3. Set the Reader Type to the correct setting for your reader (either V-Smart or V-Station). 

4. Set the COMMS Port that your computer uses to communicate with the reader. The default value is serial port 1. 

5. Set the Network ID to the physical ID of the reader attached to the serial port. The default Network ID is 1. 

6. Set the Baud Rate that your reader uses from the drop-down list. 

7. Set the Card Type that your reader uses from the Card Type drop-down list. 

8. If you want to display the fingerprint on the computer screen during the enrollment process, select Display 
Fingerprint Image. 

9. Select the Save in reader prompt option if you want to display a prompt after you capture fingerprints that asks 
"You have captured fingerprints. Do you want to keep them in the Bioscrypt unit?" 

10. Select the Max Fingerprints per Card for your reader. Choices are One or Two. 

11. Click OK to save your settings. 
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C•CURE ID Biometric Configuration Definitions 

Table 18 on Page 83 provides definitions of the fields and buttons on the C•CURE.1O Biometric Configuration dialog 

box. 

Table 18: Biometric Configuration Definitions 

Field Description 

Allow Central 
Storage 

Thisoption isnot available on C•CURE 9000. All biometric settings are stored in the database. 

Sensor Type Select the Biometriccapture device type. 

Only Bloserypt is available for C•CURE 9000. 

Reader Select the capture and encoding device that matches your installation. 

• For Bioscrypt, the possible choices are V-Smart or V-Station. 

You can have ontyone enrollment station per client. Software House onty supports an RS232 connection for this purpose. 

COMMS Port Select the communications port for the capture devices. Typical values anal 'or'2' for serial ports one and two respectively. 

Device number Thisoption is used with RS485 based devices to specify a specdic device on the RS485 network. Refer to the installation guide 
for your Biometric device for additional information. 

If you do not use an RS485 device, this option can be ignored. 

Baud Rate Select the communications speed for your device. This field appearsonty for Bioscrypt devices. Refer to the installation guide 
for your Bioscrypt device for additional information about this setting. 

Cancel Click this button to discard your changes and return to the C•CURE ID Setup dialog box. 

Card Type Only SimplexWiegand 26 is supported for C•CURE 9000. 

Display 
Fingerprint 
Image 

Select th is option to display captured fingerprints on the computer screen during the enrollment process. 

Save in reader 
prompt 

Select this option to display a prompt when you capture a fingerprint asking 'You have captured fingerprints. Do you want to 
keep them in the Bioscrypt unit?• 

If you do not select thisoption, the prompt does not appear. 

Max 
Fingerprints per 
Card 

For a Bioscrypt reader, you can select One or Two for the number of fingerprints that can be stored on a card. 

Help Click this button to access the help for C•CURE ID. 

OK Click this button to save your changes and return to the C•CURE ID Setup dialog box. 
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Smart Card Setup 

This chapter explains how to configure Smart Card settings in C•CURE ID Badge Setup so that you can program, 
enroll, and print Smart Cards. 

In this chapter 

Smart Card Overview 86 
Smart Card Device Configuration  89 
Configuring a Smart Card Device 91 
Smart Card Device Configuration Definitions  96 
Smart Card Templates  98 
Creating a New Smart Card Template 100 
Editing a Smart Card Template 101 
Configuring an iClass Smart Card Template 102 
iClass Template Configuration Definitions  103 
Configuring a DESFire Smart Card Template 104 
DESFire Template Configuration Definitions  105 
Configuring a MIFARE Smart Card Template 106 
Smart Card Keys  111 
Smart Card Key Definitions  116 
MIFARE Template Configuration Definitions  118 

C•CURE 9000 C•CURE ID User Guide Chapter< 85 

EFTA01224962



Smart Card Overview 

Smart Card Overview 

C•CURE ID provides the capability to program and enroll Smart Cards. You can: 

• Program and modify MIFARE smart cards for personnel records. 

• Enroll data from MIFARE, iCLASS, and DESFire smart cards into personnel records. 

Programming and enrolling smart cards is accomplished with a Smart Card Wedge Device or a Smart Card Printer. 
You perform enrollment from the Personnel Badging tab, in a manner similar to the other C•CURE ID functions 
such as Take Picture, Preview Badge, Print Badge, etc. 

You can perform programming and enrollment from: 

• Smart Card Printer - This feature allows you to configure a Printer to perform Smart Card programming and 
enrollment when the Print Badge function is activated. In general, when the user clicks the current Print Badge 
button, the smart card programming/enrollment function occurs, and then the print badge function follows. It is 
thus possible to program, enroll and print a badge in one operation. See Using Print Badge for Smart Card 
Enrollment, Programming, and Printing on Page 251. 

• Smart Card Device - On C•CURE 9000, a Smart Card button has been added on the Personnel Badging tab to 
utilize a Smart Card Device (Wedge or Printer). In general, when this button is clicked, the user can program 
and/or enroll a smart card for that particular Personnel record. See Using the Enroll/Program Smart Card 
Button on Page 251. 

NOTE 
The Smart Card Device can be a printer. The printer can be used for 
programming/enrolling a Smart Card without actually printing the badge (for badges that 
have already been printed). 

Example: 

For a MIFARE card that is programmed and locked when purchased, you can read the card information into 
C•CURE ID. You can re-program the card allowing you to more fully utilize the card's capabilities (perhaps 
including Vending. Finance and Parking credentials). 

Smart Card Programming and Enrollment is supported for the following card types: 

• MIFARE (first 1K block for 1K & 4K Cards) - Program and enroll. 

• iCLASS - Enroll the Card Serial Number and sector data for this HID product. 

• DESFire - Enroll the Card Serial Number. 

Supported Devices 

The following tables summarize the support for MIFARE, iClass, and DESFire Smart Cards. The printers listed must 
have a Smart Card Encoder option installed in order to encode Smart Cards. 

NOTE 
To perform Smart Card programming and enrollment with a Magicard, Nisca, or Fargo 
printer connected to a C•CURE 9000 Client running either Windows Vista or Windows 
2003 Server, the Operator must be logged on as an Administrator. 
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Table 19: MIFARE Smart Card Support 

Device Enroll Serial Number Enroll Sector Encode Print 

Fargo DTC400, DTC400e. DTC550, DTC4500. HDP600 CI v v v 

Fargo HDP 5000 with OMNIKEYCardMan 5x21-CL 0 Encoder El CI CI v 

Nisca 5350 CI CI CI CI 

Magicard Tango 2E. Rio 2e. RIO Pro CI CI v v 

Software House Wedge CI v v 

ACR 120 USB CI v v 

SCM Wedge CI v v 

Table 20: iClass Smart Card Support 

Device Enroll Serial Number 
Enroll Access 
Control Data Encode Print 

Fargo DTC400. DTC400e. DTC550. DTC4500. HDP600 CI CI 

Fargo HDP 5000 with OMNIKEY CardMan 5x21-CL 0 Encoder v V 

Nisca 5350 CI CI v 

Magicard Tango 2E. Rio 2e. RIO Pro CI v 

Software House Wedge 

ACR 120 USB 

SCM Wedge 

Table 21: DEShre Smart Card Support 

Device Enroll Serial Number Enroll Sector Encode Print 

Fargo DTC400. DTC550. DTC4500. HDP600 CI 

Fargo HDP 5000 with OMNIKEY CardMan 5x21-CL 0 Encoder 

Nisca 5350 CI 
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DESF ire Smart Card Support (continued) 

Device Enroll Serial Number Enroll Sector Encode Print 

Magicard Tango 2E, Rio 2e, RIO Pro ZI El 

Software House Wedge El 

ACR 120 USB El 

SCM Wedge 

The Smart Card Process 

The following is a summary of the steps that you perform to program, enroll, and print Smart Cards with 
&CURE ID. 

1. Set up the devices used for Smart Card programming, enrollment, and printing using C.CURE ID Setup. See 
Smart Card Device Configuration on Page 89. 

2. Define the Smart Card Templates for your Smart Card devices to define the programming and enrollment actions 
for your cards. See Smart Card Templates on Page 98. 

3. If you are using MIFARE cards and you want to use a custom key to secure the cards, you need to create a Smart 
Card custom key using the Card Formats and Keys>Smart Card Key function from the C.CURE 9000 
Administration Client Navigation pane. See the Smart Card Keys on Page 111 for more information. 

4. Use the Enroll/Prog. Smart Card button on the Personnel Badging tab to program and enroll your Smart Cards. 

5. Use the Print Badge button to program/enroll and/or print one or more badges, depending upon the Smart Card 
template you have selected. 
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Smart Card Device Configuration 

Smart Card device configuration is used to define the Smart Card device that is connected to your C•CURE ID 
system, and to associate one or more Smart Card Templates with the device. 

To Configure a Smart Card Device 

1. Identify the device type and the USB or COM port to which it is attached. See Configuring a Smart Card Device 
on Page 91. 

2. Test the connection to the device to make sure C•CURE ID can communicate with the device. See Testing the 
Encoder Connection on Page 95. 

NOTE 
PCSC devices (such as the SCM SDI010 Mifare: USB and Fargo - Mifare: USB do not have a Test 
Encoder button because only devices that are detected by the operating system are visible in the list of 
devices for selection in the Encoder Name field. If your PCSC device is not listed, check its connection. 

3. Assign one or more Smart Card Templates to the device to specify the programming and/or enrollment actions 
that can be performed with each device. See Smart Card Templates on Page 98. 

Smart Card Device Configuration Tasks 

You can perform the following Smart Card Configuration tasks: 

• Accessing the Smart Card Device Configuration Dialog Box on Page 89. 

• Configuring a Smart Card Device on Page 91. 

• Editing a Smart Card Template on Page 101. 

• Creating a New Smart Card Template on Page 100. 

For definitions of the fields and buttons on the Smart Card Device Configuration and Template Configuration dialog 
boxes, see the following topics: 

• Smart Card Device Configuration Definitions on Page 96. 

• iClass Template Configuration Definitions on Page 103. 

• DESFire Template Configuration Definitions on Page 105. 

• MIFARE Template Configuration Definitions on Page 118. 

Accessing the Smart Card Device Configuration Dialog Box 

You can access the Smart Card Device Configuration dialog box from three places, depending upon the type of 
device you want to configure. 

• C•CURE ID Badge Setup - to set up a Smart Card Device (such as an ACR120 Wedge) or Printer. See To Set Up a 
Smart Card Device or Printer on Page 90. 

• C.CURE ID Badge Printer Configuration - to set up a Smart Card Badge Printer. See To Set Up a Smart Card 
Badge Printer on Page 90. 
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• C•CURE ID Batch/Sheet Printer Configuration - to set up a Smart Card Badge Printer for batch printing. See To 
Set Up a Smart Card Badge Printer for Batch Printing on Page 90. 

To Set Up a Smart Card Device or Printer 

1. Choose Options>Badge Setup from the C•CURE Administration Client menus. 

2. Select the Smartcard check box to make the Smartcard Settings button available. 

3. Click Smartcard Settings to open the Smart Card Device Configuration dialog box. 

4. See Configuring a Smart Card Device on Page 91 for more information. 

-a=

To Set Up a Smart Card Badge Printer 

1. Choose Options>Badge Setup from the C•CURE Administration Client menus. 

2. Click Printer Options to open the Badge Printer Configuration dialog box. 

3. Select the Smartcard check box to make the Smartcard Settings button available. 

4. Click Smartcard to open the Smart Card Device Configuration dialog box. 

5. See Configuring a Printer for Smart Card Enrollment and Programming on Page 92 for more information. 

To Set Up a Smart Card Badge Printer for Batch Printing 

1. Choose Options>Badge Setup from the C•CURE Administration Client menus. 

2. Select the Batch printing? check box to make the Batching options button available. 

3. Click Batching Options to open the Batch/Sheet Printer Configuration dialog box. 

4. Select the Smartcard check box to make the Smartcard Settings button available. 

5. Click Smartcard to open the Smart Card Device Configuration dialog box. 

6. See Configuring a Batch Printer for Smart Card Encoding on Page 93 for more information. 

NOTE 
You can only program Smart Cards with patch printing. Enrollment is not supported during batch 
printing. 
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Configuring a Smart Card Device 

There are three different ways to configure a Smart Card Device in C• CURE ID. 

• You can configure a Smart Card Device to program/enroll Smart Cards from the Badge Setup dialog box. This 
device can be a Smart Card programming device or a printer with a Smart Card encoder. See Configuring a 
Device or Printer on Page 91. 

• You can configure a Smart Card printer with a Smart Card encoder from Badge Setup>Printer Options. You can 
configure this device to program/enroll/print Smart Cards. You can also choose to display a prompt to the user 
to choose whether to print only, program/enroll only, or both when they send a badge to print. See Configuring a 
Printer for Smart Card Enrollment and Programming on Page 92. 

• You can configure a Smart Card batch printer with a Smart Card encoder from the Badge Setup>Batching 
Options dialog box. You can configure this device to program and print batches of MIFARE Smart Cards. See 
Configuring a Batch Printer for Smart Card Encoding on Page 93. 

Configuring a Device or Printer 

You can configure a Smart Card Device or a printer with a Smart Card encoder from the Badge Setup dialog box. 

To enroll and program a Smart Card, a user clicks the Enroll/Program Smart Card button. 

The Enroll/Program Smart Card button does not provide a means to print a badge layout on the Smart Card, even if 
you have configured a printer as your Smart Card device. To print a badge layout on the Smart Card, use the Print 
Badge button. 

NOTE 
Currently, the ACR 120, SCM SDI010, and Software House Wedge devices only support 
MIFARE/DESFire card technology. You cannot configure an iCLASS Template on these 
devices. 
You can configure an iClass template on a Fargo, Magicard Tango, or Nisca printer 
equipped with an iClass encoder. 

Configuration Tasks 

You can configure your Smart Card Devices and Printers to perform programming, enrolling, and printing of Smart 
Cards. 

• Configuring a Smart Card Device or Printer on Page 92. 

• Configuring a Printer for Smart Card Enrollment and Programming on Page 92. 

• Configuring a Batch Printer for Smart Card Encoding on Page 93. 

• Testing the Encoder Connection on Page 95. 
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Configuring a Smart Card Device or Printer 

To Configure a Smart Card Device or Printer 

1. Select Options>Badge Setup from the C•CURE 9000 Administration Client Options & Tools pane. 

2. Select the SmartCard check box to enable the SmartCard settings button. 

3. Click SmartCard settings to open the Smart Card Device Configuration dialog box. 

4. Use the Device Name drop-down list to select the device or printer you wish to configure. 

5. If you are configuring a Smart Card device, select the Encoder Port you are using from the drop-down list. 

• For an ACR 120 USB, select the USB port to which the device is connected. 

• For the Software House Wedge, select the Comm Port to which the device is connected. 

6. If you are configuring a printer, three fields appear for you to specify settings: 

• Encoder Port - Choose the COM port to which your printer is connected. 

• Encoder Baud - Choose the Baud Rate for your printer (9600, 19200, 38400, or 57600). 

• Printer Name - Pick the name of your printer from the list of printers defined on your system. 

7. If you are configuring an SCM Wedge - Mifare: USB Smart Card device, select SCM Microsytems Inc. SDI010 
Contactless Reader from the Encoder Name field drop-down list. 

8. Click Test Encoder to test the connection to the Smart Card device or Printer Encoder. See Testing the Encoder 
Connection on Page 95. (Test Encoder is not available for PCSC devices like the SCM SDI010.) 

9. From the Smart Card Templates table, select the template(s) you wish to assign to the device, then click Add to 
move that template to the Selected list. If you choose a template that cannot be used with that device an error 
message appears. You can remove a template from the Selected list by selecting it and clicking Remove. 

10. If you want to create a new template, click New Template. See Creating a New Smart Card Template on Page 
100 for more information. 

11. If you want to modify an existing template, click Edit Template. You cannot edit the default templates (the 
default template names are prefaced with SWH). See Editing a Smart Card Template on Page 101 for more 
information. 

12. If you want to delete an existing template, click Delete Template. You cannot delete the default templates (the 
default template names are prefaced with SWH). 

13. Click OK to save any changes you have made. You can click Cancel instead to discard any changes you have 
made. 

Configuring a Printer for Smart Card Enrollment and Programming 

You can configure a Smart Card printer with a Smart Card encoder from the Badge Printer Configuration dialog box. 

To enroll and program a Smart Card, as well as print a badge layout on the card, a user clicks the Print Badge 
button. 
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To Configure a Printer for Smart Card Enrollment and Programming 

1. Select Options & Tools>Badge Setup from the Administration Client menu. 

2. Click Printer Options. 

3. Select the SmartCard check box to enable the SmartCard settings button. 

4. Click SmartCard settings to open the Smart Card Device Configuration dialog box. 

5. Use the Device Name drop-down list to select the device or printer you wish to configure. 

6. If you are configuring a printer, three fields appear for you to specify settings: 

• Encoder Port - Choose the COM port to which your printer is connected. 

• Encoder Baud - Choose the Baud Rate for your printer (9600, 19200, 38400, or 57600). 

• Printer Name - Pick the name of your printer from the list of printers defined on your system. 

7. Click Test Encoder to test the connection to the Smart Card device or Printer Encoder. See Testing the Encoder 
Connection on Page 95 for more information. (Test Encoder is not available for PCSC devices.) 

8. From the Smart Card Templates table, select the template(s) you wish to assign to the device, then click Add to 
move that template to the Selected list. If you choose a template that cannot be used with that device, an error 
message appears. You can remove a template from the Selected list by selecting it and clicking Remove. 

9. If you want to create a new template, click New Template. See Creating a New Smart Card Template on Page 
100 for more information. 

10. If you want to modify an existing template, click Edit Template. You cannot edit the default templates (the 
default template names are prefaced with SWH). See Editing a Smart Card Template on Page 101 for more 
information. 

11. If you want to delete an existing template, click Delete Template. You cannot delete the default templates (the 
default template names are prefaced with SWH). 

12. Click OK to save any changes you have made. You can click Cancel instead to discard any changes you have 
made. 

Configuring a Batch Printer for Smart Card Encoding 

You can configure a Smart Card batch printer with a Smart Card encoder from the Batch/Sheet Printer 
Configuration dialog box. 

You can assign one Smart Card Template to a Smart Card printer equipped with a Smart Card Encoder, and 
configured for batch printing, so that you can encode and print Smart Cards in batch mode. Batch processing does 
not support enrollment. 

If you select Batch printing on the C•CURE ID Badge Setup dialog box and configure a printer using Batching 
options, these selections supersede any selections you have made in Printer options, and any Smart Card operations 
are performed in batch mode. 

NOTE 
Smartcard programming and Batch Sheet Layout are mutually exclusive for Batch/Sheet 
Printer Configuration. If you select Smartcard, then Use Sheet Layout? is unavailable. 
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To Configure a Batch Printer for Smart Card Encoding 

1. Select Options & Tool>Badge Setup from the C•CURE Administration Client menu. 

2. Click Botching Options. 

3. Select the SmartCard check box to enable the SmartCard settings button. 

4. Click SmartCard settings to open the Smart Card Device Configuration dialog box. 

5. Use the Device Name drop-down list to select the device or printer you wish to configure. 

6. Specify settings for: 

• Encoder Port - Choose the COM port to which your printer is connected. 

• Encoder Baud - Choose the Baud Rate for your printer (9600, 19200, 38400, or 57600). 

• Printer Name - Pick the name of your printer from the list of printers defined on your system. 

7. Click Test Encoder to test the connection to the Smart Card device or Printer Encoder. See Testing the Encoder 
Connection on Page 95 for more information. 

8. From the Smart Card Templates table, select the template you wish to assign to the device, and then click Add to 
move that template to the Selected list. If you choose a template that cannot be used with that device, an error 
message appears. You can only choose one template when configuring a batch badge printer. You can remove a 
template from the Selected list by selecting it and clicking Remove. 

9. If you want to create a new template, click New Template. See Creating a New Smart Card Template on Page 
100 for more information. 

10. If you want to modify an existing template, click Edit Template. You cannot edit the default templates (the 
default template names are prefaced with $SWH). See Editing a Smart Card Template on Page 101 for more 
information. 

11. If you want to delete an existing template, click Delete Template. You cannot delete the default templates (the 
default template names are prefaced with $SWH). 

12. Click OK to save any changes you have made. You can click Cancel instead to discard any changes you have 
made. 
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Testing the Encoder Connection 

The Test Encoder button is used to test the connection between non-PCSC Smart Card devices and the the 
C•CURE ID system, so that you can tell if the device is correctly communicating with C•CURE ID. 

The Test Encoder button is not available for PCSC devices because these devices are detected by Windows. These 
device types instead provide an Encoder Name field that displays all of the PCSC devices detected on the 
C•CURE ID system. If the device you want to configure is not visible in the Encoder Name field drop-down list, you 
should check the devices connection to the system. 

When you click Test Encoder, C•CURE ID attempts to connect to the device, based on the Device configuration. The 
result is displayed in a Message Box. 

• If the connection is successful, the message "Communication with the device Succeeded" is displayed. 

• If the connection is not successful, and the device cannot be contacted, the message "Communication with the 
device failed" is displayed. 
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Smart Card Device Configuration Definitions 

The following fields and buttons appear on the C•CURE ID Smart Card Device Configuration dialog box. 

Table 22 on Page 96 lists definitions for the Device Configuration fields. 

Table 23 on Page 97 lists definitions for the Smart Card Template fields. 

Table 22: Smart Card Device Configuration Definitions 

Field Description 

Device 
Name 

Select the device to conf ig UM from the list of supported devices. The devices are: 

• AC R 120 USB (Smart Card Wedge) 

• Software House Wedge 

• SCM Wedge 

• Fargo - Mifare (printer) 

• Nisca - Ware (printer) 

• Fargo - Ware : USB 

• Fargo - iClass: USB 

• Nisca - iClass (printer) 

• Tango 2E - Mifare (Printer) 

• Tango 2E - iClass (Printer) 

Encoder 
Port 

Select the port to which the device isconnected. 

If a COM port device is chosen in the Device Name field. the drop-down list shows all the COM ports on the system. 

If a USB port device is chosen in the Device Name field. the drop-down list shows all the USB ports on the system. 

Encoder 
Name 

This drop-down list includes all PCSC devices detected by Windows. Only available for the SCM SDI010 - Mifare: USB. Fargo - Mifare 
: USB, and Fargo - Class: USB devices. 

Encoder 
Baud 

The Baud rate of the selected device. Settings are: 

• 9600 (the default and currently the only setting supported). 19200.38400.57600 

If a USB device is selected, this field is unavailable. 

Printer 
Name 

Lists all printers installed on the system. 

If a USB device is selected. this field is unavailable. 

Prompt 
for Print 

This check boxontyappears when you are configuring a badge printer as a Smart Card printer byclicking Printer Options from 
C•CURE ID Badge Setup. (It isnot available if you configure a printer as a Smart Card device by clicking Sma dee rd Settings from 
C•CURE ID Badge Setup, or if you are configuring the printer as a batch printer byclicking Batehing Options from 
C•CURE ID Badge Setup.) 

If you select this option, the Smart Card Print Options dialog box is displayed when a user clicks Print Badge. so that the user can 
choose to print the badge, program the Smart Card, or both. 

Test 
Encoder 

Click this button to attempt to connect to the device selected, based on the configuration settings. 

If a connection is made, the message 'Communication with the device Succeeded• isdisplayed. 

If the connection attempt fails, the message •Communication with the device Failed• is displayed. 

OK When you have completed configuring a device. click OK to save the configuration settings. 

Cancel Click Cancel if you want to discard anychanges that you have made to the Smart Card Device Configuration settings. 
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Table 23: Smart Card Template Configuration Definitions 

Field Description 

Available Lists the Smart Card Templates that are available for use. This list includes templates that you have created, and the following 
templates that come with C•CURE ID: 

SWH Enroll MIFARE with MIFARE Key 

• Use Default MIFARE Key to Read Sector 1. 

• EnrollWiegand26 Card Format from Sector 1, Block 0. 

SWH Enroll MIFARE CSN to Card Number 

• Enrolls Card Serial Number to Card Number 

SWH Program MIFARE with MIFARE Key 

• Use Default MIFARE Key to Program MAD Read and Write Keys. 

• Use Default MIFARE Key for Read and Write Key to Sector 1. 

• Program Read and Write Key to Sector 1. 

• Program Wiegand26 Card Format to Sector 1, Block 0. 

SWH Enroll iClass 

• Enrolls Card Serial Number to Card Number 

SWH Enroll DESF ire 

• Enrolls Card Serial Number to Card Number 

WSH Enroll MIFARE with SWH Key 

• Use Default Software House Key to Read Sector 1. 

• EnrollWiegand26 Card Format from Sector 1. Block O. 

Selected Lists the Smart Card Templates that you have selected for the device you are configuring. You add a template to this t by selecting 
the template name in the Available list and clicking Add. 

Add Add is used to add a template from the Available list to the Selected list for the device you are configuring. ClickAdd after selecting a 
template name in the Available list. 

Remove Remove removes a template from the Selected list and moves it back to the Available list. Select a template in the Selected list. then 
click Remove to remove that template. 

New 
Template 

Click New Template to create a new Smart Card template. Smart Card templates are used to define the data transfer that will occu r 
between the physical card and the Personnel Record. See Smart Card Tem plates on Page 98 for an introduction to Smart Card 
Templates. See Creating a New Smart Card Template on Page 100 for instructions. 

Edit 
Template 

Select a template from either the Available or Selected list and click Edit Template to edit a Smart Card template. See Editing a 
Smart Card Template on Page 101 for instructions. 

Delete 
Template 

Select a template from either the Available or Selected list and click Delete Template to delete a Smart Card template. You cannot 
delete a default template. You cannot delete a template that isconfigured for use by another device. 

Example: 

You created a template called 'Enroll Temporary Cards' and assigned it to a badge printer used for printing Visitor badges. You 
cannot delete this template while you are editing the configuration of a different device. 
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Smart Card Templates 

Smart Card Templates are basically smart card configurations that are used to define the data transfer that occurs 
between the physical card and the Personnel Record. A template defines the card type (MIFARE, iCLASS or DESFire), 
all relevant data (personnel fields, card fields, or card formats), the operations that will be performed (enrollment, 
programming), and if necessary, the Security Keys needed to access the data. 

In C.CURE ID Badge Setup, after you define these Templates, you assign them to smart card devices (Smart Card 
Device or Printer). Once a template is assigned to the device, it becomes part of the device's active configuration. 
This means, in the case of printing, that when the user clicks Print Badge, the selected smart card template will be 
applied. 

When you click New Template on the Smart Card Device Configuration dialog box, the Smart Card Template dialog 
box appears so you can choose the card type for the template you are creating. 

You can choose one of these three card types: 

• iClass - Click this button, then click OK to create an iClass template. See Configuring an iClass Smart Card 
Template on Page 102. 

• DESFire - Click this button, then click OK to create a DESFire template. See Configuring a DESFire Smart Card 
Template on Page 104. 

• MIFARE - Click this button, then click OK to create a MIFARE template. See Configuring a MIFARE Smart Card 
Template on Page 106. 

Sample Descriptions of Smart Card Templates 

• SWH iCLASS Enroll: Read the iCLASS card serial number and enroll to Personnel:CardNumber. 

• SWH DESFire Enroll: Read the DESFire card serial number and enroll to Personnel:CardNumber. 

• SWH MIFARE PROGRAM CardFormat Enroll Serial Number: Use the Card Data Fields, and on Sector 1, Block 0, 
write the WIEGAND 26 card format. Also enroll the Card Serial Number to Personnel:Int1. 

Multiple templates can be assigned to a Smart Card Device or the Individual Badge Printer, and a prompt allows 
you to select which template to use. Batch printing only supports one Smart Card template at a time, and only a 
template for programming actions can be assigned. 

NOTE 
Currently, the wedge devices (ACR120, SDI010, and Software House Wedge) only support 
MIFARE/DESFire card technology, so you cannot set up an iCLASS Template for these devices. 

Typically, a printer has either an iCLASS encoder or a MIFARE encoder installed. However, C.CURE ID cannot 
determine which encoder is installed on the printer. C.CURE ID prevents you from configuring two different Card 
Technology Templates on a single printer. But it is possible to configure the wrong type of template for your printer —
configuring a MIFARE template for a printer whose encoder supports only iCLASS cards. 

To ensure the printer has the proper encoder installed on the printer, you should utilize the test encoder button in 
C•CURE ID Smart Card Setup. If you attempt to use a template (print or smartcard program/enroll) on the wrong 
encoder device (for example, a MIFARE template on an iCLASS printer) the software reports a "Device is missing!" 
message because the card type you configured in the template is not present on the printer. 
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Therefore, you are responsible for determining whether or not the Card Template you use is supported on the printer. 
To ensure the proper encoder is installed, use the Test Connection button in C•CURE ID Setup to verify the proper 
encoder. See Testing the Encoder Connection on Page 95. 

See the following sections or more information: 

• Smart Card Templates on Page 98. 

• Smart Card Programming and Enrollment on Page 250. 

• Using the Enroll/Program Smart Card Button on Page 251. 

• Using Print Badge for Smart Card Enrollment, Programming, and Printing on Page 251. 

• Using Batch Print Badge for Smart Cards on Page 252. 
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Creating a New Smart Card Template 

Follow these steps to create a new basic Smart Card template. 

1. Navigate to the Smart Card Device Configuration dialog box. See Smart Card Device Configuration on Page 89 
for more information. 

2. Click New Template to create a new template. The Smart Card Template dialog box appears. 

3. Choose the type of template you want to create (MIFARE, iCLass, or DESHre) and click OK. The Configuration 
dialog box opens for the card type you chose. 

4. Chose the settings for the specific card type and template operations. 

• See Configuring an iClass Smart Card Template on Page 102 for steps to configure an iClass 
template. 

• See Configuring a DESFire Smart Card Template on Page 104 for steps to configure a DESFire 
template. 

• See Configuring a MIFARE Smart Card Template on Page 106 for steps to configure a 
MIFARE template. 

5. Click OK to save the template. 
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Editing a Smart Card Template 

Follow these steps to edit a Smart Card template. 

NOTE You cannot modify and save a default template, but you can create a copy of it if you 
want to change some of the settings. If you try to edit a default template, you will get a 
message that says: "Can't make changes to a default template." If you click OK, the 
Template Configuration dialog box appears. You can save a copy of the default template 
by changing the name of the template and clicking OK to save it as a new template. You 
can then select it from the list of templates and edit it. 

1. Navigate to the Smart Card Device Configuration dialog box. See Smart Card Device Configuration on Page 89 
for more information. 

2. Select a template from the Available list or the Selected list and click Edit Template to edit an existing template. 
The Configuration dialog box opens for the template you chose. 

3. Chose the settings for the specific card type and template operations. 

• See Configuring an iClass Smart Card Template on Page 102 for steps to configure an iClass 
template. 

• See Configuring a DESFire Smart Card Template on Page 104 for steps to configure a DESFire 
template. 

• See Configuring a MIFARE Smart Card Template on Page 106 for steps to configure a 
MIFARE template. 

4. Click OK to save the template. 
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Configuring an iClass Smart Card Template 

The iClass Configuration dialog box is used to set up a template for enrollment and programming of iClass cards. 
You can define a template and attach it to a Smart Card device configuration so that the enrollment options you set 
up are executed when you send a badge for enrollment by pressing the Enroll/Prog. Smart Card button on the 
Personnel Badging tab. 

See iClass Template Configuration Definitions on Page 103 for more information about the fields and buttons on this 
dialog box. 

To Configure a iClass Smart Card Template 

1. Navigate to the Smart Card Device Configuration dialog box. See Smart Card Device Configuration on Page 89 
for more information. 

2. Click New Template to create a new template, or select an iClass template in the Available or Selected list and 
click Edit Template to edit an existing template (the iClass Configuration dialog box opens). 

3. If you are creating a new template, you need to pick a card type from the SmartCard Template dialog box. Select 
iClass and click OK. The iClass Configuration dialog box opens. 

4. Type in a name for the iClass template in the Name field. Consider including "iClass" in the name to help you 
identify the template later. 

5. Select Confirm Enrollment Data if you want C.CURE ID to display a confirmation message box prior to 
enrolling data from the card to the Personnel database. 

6. Select the field you want to enroll the Card Serial Number (CSN) to by choosing a field from the drop-down list 
in the Enroll CSN to field. 

7. Select the card format for the data on the card from the drop-down list in the Card Format field. 

8. To save the iClass Smart Card Template, click OK. 
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iClass Template Configuration Definitions 

The following fields and buttons appeari on the iClass Configuration dialog box. 

Table 24: ClassConfiguration Dialog Box Definitions 

Field or 
Button 

Description 

Name Enter a valid object name for the iClass template in the Name field. The name of the Smart Card Template must be from 1 - 200 
characters. 

Consider including "iClass" in the name to help you identify the template later. 

Confirm 
Enrollment 
Data 

Select this option if you want C•CURE ID to display a dialog box allowing you to confirm enrollment data before writing it to the 
Personneldatabase. 

Enroll to: Select the Personneldatabase field to which you wish to enroll the Card Serial Number (SC N) from the drop-down list. 

Card 
Format 

Select the card format to use when enrolling sector data from the card to the Personnel database. (Not supported on all devices.) 
The format you use determineswhich fields the sector data is enrolled in. Thisoption isnot supported on all iCiassdevices. 

Example: 

Wiegand 26 format will enroll the facility code and card number from the card into the Personnel record Facility Code and 
Card Number fields. Choose a card format from the drop-down list in the Card Format field. 

OK Click OK to save your changes to the iClass template configuration. 

Cancel Click Cancel to discard anychanges you have made to the iClass template configuration. 
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Configuring a DESFire Smart Card Template 

The DESFire Configuration dialog box is used to set up a template for enrollment of DESFire cards. You can define a 
template and attach it to a Smart Card device configuration so that the enrollment options you set up are executed 
when you send a badge for enrollment/programming by pressing the EnrolVProg. Smart Card button on the 
Personnel Badging tab. 

See DESFire Template Configuration Definitions on Page 105 for more information about the fields and buttons on 
the DESFire Configuration dialog box. 

To Configure a DESFire Smart Card Template 

1. Navigate to the Smart Card Device Configuration dialog box. See Smart Card Device Configuration on Page 89 
for more information. 

2. Click New Template to create a new template, or select a DESFire template in the Available or Selected list and 
click Edit Template to edit an existing template (the DESFire Configuration dialog box opens. 

3. If you are creating a new template, you need to pick a card type from the SmartCard Template dialog box. Select 
DESHre and click OK. The DESFire Configuration dialog box opens. 

4. Type in a name for the DESFire template in the Name field. Consider including "DESFire" in the name to help 
you identify the template later. 

5. Select Confirm Enrollment Data if you want C.CURE ID to display a confirmation message box prior to 
enrolling data from the card to the Personnel database. 

6. Select the field you want to enroll the Card Serial Number (CSN) to by choosing a field from the drop-down list 
in the Enroll CSN to field. 

7. To save the DESFire Smart Card Template, click OK. 
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DESFire Template Configuration Definitions 

The following fields and buttons appear on the DESFire Configuration dialog box. 

Table 25: Class Configuration Dialog Box Definitions 

Field or 
Button 

Description 

Name Enter a valid object name for the DESF ire template in the Name field. The name of the Smart Card Template must be from 1 - 200 
characters. 

Consider including "DESF ire" in the name to help you identify the template later. 

Confirm 
Enrollment 
Data 

Select this option if you want C•CURE ID to display a dialog box allowing you to confirm enrollment data before writing it to the 
Personneldatabase. 

Enroll to: The DESF ire Card Serial Number is enrolled to the Card Number field. You need to enable a 20-digit length for the Card Number 
field using Personnel>CHUID Format. Otherwise the card number from the DESFire card is truncated. See the C•CURE 9000 
Personnel Con figuration Guide for more information on CHUID Formats. 

OK Click OK to save your changes to the DESFire template configuration. 

Cancel Click Cancel to d iscard any cha nges you have made to the DESF ire template configuration. 
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Configuring a MIFARE Smart Card Template 

The MIFARE Configuration dialog box is used to set up a template for enrollment and programming of MIFARE 
cards. You can define a template and attach it to a Smart Card device configuration. The enrollment and 
programming options you set up are executed when you send a badge for enrollment/programming by pressing the 
EmoVProg. Smart Card button on the Personnel Badging tab. 

Figure 22 on Page 106 shows the MIFARE Configuration dialog box. 

Figure 22: MIFARE Configuration Dialog Box 
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Templates for MIFARE cards let you program data to the card from the Personnel database and/or enroll data from 
the card to the Personnel database. 

MIFARE cards contain software keys for reading and writing to and from the card. If the keys you use to read and 
write do not match the keys stored on the card, you will be denied access to the card. This rule applies when you are 
enrolling data from the card, programming data to the card, and when your card readers are reading the card to 
apply access control security (the reader must be programmed to match the keys stored on the Smart Card, or it will 
not be able to read the Smart Card). 

A template allows you to change the keys stored on the card, so that you can customize the level of security enforced 
by the Smart Card. 

There are several default templates available to simplify programming and enrollment for Smart Cards. These 
templates appear in the Available list and have names beginning with "$SWH". 

NOTE You cannot change a default template, but you can create a copy of it if you want to change some of 
the settings. If you try to edit a default template, you will get a message that says: "Can't make 
changes to a default template." If you click OK, the Template Configuration dialog box appears. You 
can save a copy of the default template by changing the name of the template and clicking OK to 
save it as a new template. You can then select it from the list of templates and edit it. 

106 Chapter 4 C•CURE 9000 C•CURE ID User Guide 

EFTA01224983



Configuring a MI FARE Smart Card Template 

If you are programming or enrolling a blank MIFARE card, you are likely to need a template that reads the default 
transport read and write keys that are programmed into blank MIFARE cards. You are also likely to want to 
reprogram the card to use MIFARE read and write keys, either default MIFARE keys or custom MIFARE keys. If you 
choose to use custom keys, you will also need to ensure that your card readers are programmed to use the custom 
keys, or the card readers will be unable to read your Smart Cards. 

See MIFARE Template Configuration Definitions on Page 118 for more information about the fields and buttons on 
the MIFARE Configuration dialog box. 

MIFARE Template Configuration Tasks 

You can perform the following tasks to configure MIFARE Smart Card templates: 

• Create a New MIFARE Template on Page 107. 

• Enroll a Blank MIFARE Smart Card on Page 107. 

• Program a Smart Card Using Default MIFARE Read and Write Keys on Page 108. 

• Enroll a Smart Card Using Default MIFARE Keys on Page 109. 

• Program a Smart Card Using Custom MIFARE Read and Write Keys on Page 110. 

Create a New MIFARE Template 

These steps explain how to create a new basic MIFARE template. These steps are the same for each of the 
MIFARE Template tasks shown later. 

To Create a New MIFARE Template 

1. Navigate to the Smart Card Device Configuration dialog box. 

2. Click New Template to create a new template. The Smart Card Template dialog box appears. 

3. Choose MIFARE and click OK. The MIFARE Configuration dialog box opens. 

4. Enter a descriptive name for the template in the Name field. This name should give enough information about 
the template so that a user can correctly choose the template from a list of templates when programming or 
enrolling a Smart Card. 

5. You can continue to make further changes, or you can click OK to save the template and go back to the Smart 
Card Device Configuration dialog box. 

Enroll a Blank MIFARE Smart Card 

Typically, a blank Smart card uses the default transport key for read and write, and has a Card Serial Number that 
you might want to enroll in the Personnel database. 
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To Configure a Template to Enroll a Blank MIFARE Smart Card 

1. Create a New MIFARE Template on Page 107. 

2. To display a form that allows you to confirm the data when you are programming/enrolling the card, select 
Confirm Programming/Enrollment Data. 

3. Because this is a blank MIFARE card, you should be able to read and write data from/to the card using the 
default transport keys, so you should not need to change the Read Key and Write Key fields from their default 
value ($Default Transport Key). 

4. Choose the field in the Personnel database to which you want to enroll the Card Serial Number from the Enroll 
to field drop-down list. 

5. Click OK to save the template. 

6. Select the template you just created from the Available list and click Add to add the template to the Selected list. 

7. Click OK to save the Smart Card Device Configuration. When you attempt to enroll the Smart Card, use this 
template (if your Smart Card device has more than one template configured, you can choose this template from a 
drop-down list). 

Program a Smart Card Using Default MIFARE Read and Write Keys 

If you are going to program additional data to a smart card, you should consider changing the Smart Card Keys on 
the card from the default transport keys. To implement better card security than that provided by the default 
transport keys, you can program your cards to use the default MIFARE read and write keys. To do this you need to 
set a New Read Key and New Write Key for each sector to which you wish to write data. 

To Configure a Template to Program a Smart Card Using Default MIFARE Read and Write Keys 

1. Create a New MIFARE Template on Page 107. 

2. To change the MIFARE Application Directory from the Default Transport Key to MIFARE Keys, Select Program 
MAD Read and Write Keys. When you select this, the New Read Key and New Write Key fields become 
available. 

3. Change the New Read Key to MIFARE by choosing Default MIFARE Read Key from the drop-down list. 

4. Change the New Write Key to MIFARE by Choosing Default MIFARE Write Key from the drop-down list. 

5. If you wish to program data to a sector on the card, select that sector from the Sectors table by clicking in the 
Enabled check box (a) for that sector's row in the table. 

6. Type in a descriptive name in the Sector Label field in the Details box. That name then appears in the Sector 
Label field for that sector in the Sectors table. 

7. If your application has an AID value, type that number into the AID Value field. 

8. If you want that AID value to be programmed into the MIFARE Application Directory (MAD), select the Program 
AID to MAD check box. 

9. To change the keys for this sector, select the Program Sector Read and Write Keys check box.When you select 
this, the New Read Key and New Write Key fields for this sector become available. 

10. Change the New Read Key to MIFARE by choosing Default MIFARE Read Key from the drop-down list. 
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11. Change the New Write Key to MIFARE by Choosing Default MIFARE Write Key from the drop-down list. 

12. Select the data you wish to write to this Sector by picking a Card Format or a Personnel Database field from the 
Held or Format drop-down list for the block you wish to write to. 

13. For that block, select an Operation from the Operation drop-down list. You can select Program ASCII if you are 
programming a text field or Program Hex if you are programming an integer field. 

14. If needed, repeat Steps 12 and 13 for each block. 

15. If needed, repeat Steps 5 through 14 for each sector you wish to program. 

16. Click OK to save the MIFARE Template. 

Enroll a Smart Card Using Default MIFARE Keys 

If you have purchased or programmed a Smart Card to use default MIFARE Keys, you can create a template that 
will let you enroll data from that card. 

To Configure a Template to Enroll a Smart Card Using default MIFARE Keys 

1. Create a New MIFARE Template on Page 107. 

2. To display a form that allows you to confirm the data when you are programming/enrolling the card, select 
Confirm Programming/Enrollment Data. 

3. If you want to enroll the Card Serial Number to a field in the Personnel database, choose the field in the 
Personnel database to which you want to enroll the Card Serial Number from the Enroll to field drop-down list. 

4. Select $Default MIFARE Read Key from the drop-down list in the Read Key field. 

5. Select $Default MIFARE Write Key from the drop-down list in the Write Key field. 

6. If you want to enroll additional data from the Smart Card to the Personnel database, choose the sector on the 
card that contains the data you want to enroll by selecting (a) the Enabled check box for that sector in the 
Sectors table. 

7. Select the sector you wish to read in the Sectors table, change the values in the Data section for Block 0, Block 1, 
and Block 2 Held or Format to specify the destination for the data you expect to read from the card. 

Example: 

If Block 1 of Sector 2 contains data that you want to enroll in the Text1 field in the Personnel database, choose 
Textl from the drop-down list under Field or Format. 

Example: 

If Block 2 of Sector 2 contains data that you want to enroll in the fields that represent the Wiegand 26 card 
format, choose Wiegand 26 from the drop-down list. 

8. For each Block for which you specified a Field or Format, choose an Operation. If you are enrolling alphanumeric 
data, such as a text field, choose Enroll ASCII. 

9. Change the Read Key field for this sector to $Default MIFARE Read Key and Write Key fields for the Sectors from 
their default value ($Default Transport Key). 

10. Repeat Steps 6 through 9 for each sector from which you wish to enroll data. 

11. Click OK to save the new Smart Card template. 
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12. The template will now be listed in the Available column so that you can select it and click Add to add it to the 
Smart Card device. 

Program a Smart Card Using Custom MIFARE Read and Write Keys 

To implement the highest level of security, you can program your cards to use custom MIFARE read and write keys. 
You create custom keys in the C.CURE 9000 Administration Application using Card Formats and Keys>Smart 
Card Key from the menus. See the Administration Application help for more information. 

 S 
To Configure a Template to Program a Smart Card Using Custom MIFARE Read and Write Keys 

1. Create a New MIFARE Template on Page 107. 

2. To change the MIFARE Application Directory from the Default Transport Key to custom MIFARE Keys, select 
Program MAD Read and Write Keys. When you select this, the New Read Key and New Write Key fields 
become available. 

3. Change the New Read Key to your custom key by choosing your custom key from the drop-down list. 

4. Change the New Write Key to your custom key by choosing your custom key from the drop-down list. 

5. If you wish to program data to a sector on the card, select that sector from the Sectors table by clicking in the 
Enabled check box (2) for that sector's row in the table. 

6. Type in a descriptive name in the Sector Label field in the Details box. That name then appears in the Sector 
Label field for that sector in the Sectors table. 

7. If your application has an AID value, type that number into the AID Value field. (The registered AID for Software 
House is 5120.) 

8. If you want that AID value to be programmed into the MIFARE Application Directory (MAD), select the Program 
AID to MAD check box. 

9. To change the keys for this sector, select the Program Sector Read and Write Keys check box.When you select 
this, the New Read Key and New Write Key fields for this sector become available. 

10. Change the New Read Key to your custom key by choosing your custom key from the drop-down list. 

11. Change the New Write Key to M your custom key by choosing your custom key from the drop-down list. 

12. Select the data you wish to write to this Sector by picking a Card Format or a Personnel Database field from the 
Field or Format drop-down list for the block you wish to write to. 

13. For that block, select an Operation from the Operation drop-down list. You can select either Program ASCII or 
Program Hex, depending on the nature of the data you plan to write to the card. 

14. If needed, repeat Steps 12 and 13 for each block. 

15. If needed, repeat Steps 5 through 14 for each sector you wish to program. 

16. Click OK to save the MIFARE Template. 
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Smart Card Keys 

C•CURE ID provides the ability to define Smart Cart Keys for MIFARE Smart Cards. 

MIFARE Smart Card Keys are six byte (48-Bit) values used to secure sectors on the card. There is one key for reading 
and one key for writing per sector. The keys can be the same value if desired, but for security reasons, they are 
typically assigned different values. 

The Smart Card Keys are used when you are reading data from MIFARE Smart Cards and programming 
MIFARE Smart Cards. 

• To read data from a MIFARE Smart Card, a device must know the Read Key that is on the Smart Card, or the 
read attempt is rejected. 

• To program (write data to) the Smart Card, the device must know the Write Key. 

Each sector on the Smart Card can have a different Read Key and Write Key. 

In addition,you must program your Smart Card readers with the Read key that you used on the cards, so that your 
Smart Card readers can read the data that you program onto the Smart Cards. 

You define Smart Card Keys using the Smart Card Key editor. 

You can access the Smart Card Key editor from the Card Formats and Keys pane in the Administration Client 
application. 

See Smart Card Keys help for more information about Smart Card Keys. 

Smart Card Key Configuration 

Use Card Formats and Keys>Smart Card Key from the C•CURE 9000 Administration Client to create, edit, and 
specify Smart Card keys. A Smart Card key is used to securely read and write data to a Smart Card, and also to 
program Smart Card readers to read cards that are encoded with this Smart Card key. 

Smart Card Key Tasks 

You can perform the following tasks from the Smart Card Key dialog box. 

• Accessing the Smart Card Key Dialog Box on Page 112. 

• Creating a Smart Card Key on Page 112. 

• Editing a Smart Card Key on Page 114. 

For more information on Smart Card Keys, see: 

• Smart Card Keys on Page 111. 

• Smart Card Key Definitions on Page 116. 
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Accessing the Smart Card Key Dialog Box 

To Access the Smart Card Key Dialog Box 

You can access the Smart Card Key Editor from the Card Formats and Keys pane of the C•CURE 9000 
Administration Client. 

1. Choose Card Formats and Keys>Smart Card Key from the Navigation pane, and click Ms. A Dynamic View 
showing a list of existing Smart Card Keys box opens. 

2. Select a Smart Card Key from the selection list, then right-click and choose Edit from the context menu to edit an 
existing Smart Card Key, or click New to create a new Smart Card Key. The Smart Card Key dialog box opens. 

Creating a Smart Card Key 

You can create custom Smart Card Keys that can be used to read and write Smart Card data to MIFARE Smart 
Cards. Custom keys provided additional security over default keys because you can make them unique to your site. 
However, they add complexity because you have to program your Smart Card readers to read your custom keys, and 
if you decide to change custom keys, you will need to re-program your readers and re-issue cards with the new 
custom keys. 

After you create a Smart Card Key file with a custom key, you can add the Smart Card Key file to a template for 
enrolling and programming MIFARE Smart Cards in Options>Badge Setup. 

1. Choose Card Formats and Keys>Smart Card Key from the Administration Application menu. 

2. Click New on the Card Format and Keys pane. The Smart Card Key dialog box opens. 

3. On the Smart Card Key dialog box, type a name for the Smart Card Key in the Name field. 

4. Type a description that describes the Smart Card Key in the Description field. 

5. If you want to use an existing Smart Card Key file (the file that defines the read and write key values) for this 
Smart Card Key, select the file name from the Smart card key file name field and click Edit File. The Smart Card 
Key dialog box opens and you can edit the Smart Card Key. 

6. Alternatively, if you want to create a new Smart Card Key, type a name for the Smart Card Key into the Smart 
card key file name field and click New File. The Smart Card Key file dialog box opens and you can create a new 
Smart Card Key. 

7. On the Smart Card Key dialog box, you can type in a new key value in the Key Value field, then retype it in the 
Confirm Key Value field. 

8. Alternatively, if you want to create a random key, you can click Generate Random Key, and a 12 hex character 
random key is inserted into the Key Value and Confirm Key Value fields. 

9. Whether you type in or generate a random key, you should write this key down and save it in a secure location. 
When you save the key, the key will be encrypted, and you will not be able to read it. 

10. If you want to export the encrypted key to a file for later use (for example, to buy programmed cards from 
Software House), click Export Key. A Save as dialog appears to let you save the encrypted key as a file with a 
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.doc extension. Note that this is not a Word document, and it should not be opened with a word processing 
editor. 

11. Click OK to save the Smart Card Key file. If you have changed the Smart Card Key value, a confirmation dialog 
box appears to confirm the change. 
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If you have modified an existing Key, the system displays the following 
message 

"Are you sure you want to overwrite this key? Loss of a key could result in 
reissuing all of the cards in the system along with programming all of the 
readers." 

This means that if you change the Key value and use it to program one or 
more Smart Cards, your Smart Card readers will need to be re-programmed 
to accept a card with the new key. If you re-program the readers, any cards 
you have issued using the previous key will need to be re-issued as well. 

12. Select Confirm file over write operation and click Continue to save the changes. The key file is encrypted and 
saved, and the Smart Card Key dialog box re-opens. 

13. Click OK to save your Smart Card Key, or Cancel to discard ALL changes (even if you have saved changes to a 
Smart Card Key, clicking Cancel signifies that you want to discard them). 

Editing a Smart Card Key 

You can create custom Smart Card Keys that can be used to read and write Smart Card data to MIFARE Smart 
Cards. Custom keys provided additional security over default keys because you can make them unique to your site. 
However, they add complexity because you have to program your Smart Card readers to read your custom keys, and 
if you decide to change custom keys, you will need to re-program your readers and re-issue cards with the new 
custom keys. 

After you create a Smart Card Key file with a custom key, you can add the Smart Card Key file to a template for 
enrolling and programming MIFARE Smart Cards in Options>Eadge Setup. 

1. Choose Card Formats and Keys>Smart Card Key from the Administration Application menu. 

2. Click New on the Card Format and Keys pane. The Smart Card Key dialog box opens. 

3. On the Smart Card Key dialog box, edit the name for the Smart Card Key in the Name field. 

4. Make any changes needed to the description that describes the Smart Card Key in the Description field. 

5. If you want to use a different Smart Card Key file for this Smart Card Key, select the file name from the Smart 
card key file name field and click Edit File. The Smart Card Key file dialog box opens and you can edit the 
Smart Card Key. 

6. Alternatively, if you want to create a new Smart Card Key file, type a name for the Smart Card Key file into the 
Smart card key file name field and click New File. The Smart Card Key dialog box opens and you can create a 
new Smart Card Key. 

7. On the Smart Card Key dialog box, you can type a new key value into the Key Value field, then retype it in the 
Confirm Key Value field. 

NOTE 
You will not be able to see the existing Key Value. The Key Value is 
represented by asterisks ( ). 

114 Chapter 4 C•CURE 9000 C•CURE ID User Guide 

EFTA01224991



Smart Card Keys 

8. Alternatively, if you want to create a random key, you can click Generate Random Key, and a 12 hex character 
random key is inserted into the Key Value and Confirm Key Value fields. 

9. Whether you type in or generate a random key, you should write this key and save it in a secure location. When 
you save the key, the key will be encrypted, and you will not be able to read it. 

10. If you want to export the encrypted key to a file for later use (for example, to buy programmed cards from 
Software House), click Export Key. A Save as dialog appears to let you save the encrypted key as a file with a 
.doc extension. Note that this is not a Word document, and it should not be opened with a word processing 
editor. 

11. Click OK to save the Smart Card Key file. If you have changed the Smart Card Key value, a confirmation dialog 
box appears to confirm the change. 

If you have modified an existing Key, the system displays the following 
message 
"Are you sure you want to overwrite this key? Loss of a key could result in 
reissuing all of the cards in the system along with programming all of the 
readers." 
This means that if you change the Key value and use it to program one or 
more Smart Cards, your Smart Card readers will need to be re-programmed 
to accept a card with the new key. If you re-program the readers, any cards 
you have issued using the previous key will need to be re-issued as well. 

12. Select Confirm file over write operation and click Continue to save the changes. The key file is encrypted and 
saved, and the Smart Card Key dialog box re-opens. 

13. Click OK to save your Smart Card Key, or Cancel to discard ALL changes (even if you have saved changes to a 
Smart Card Key, clicking Cancel signifies that you want to discard them). 
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Smart Card Key Definitions 

The following fields and buttons appear on the Smart Card Key dialog boxes. 

Smart Card Key Dialog Box 

Table 26 on Page 116 provides definitions for the fields and buttons on the Smart Card Key dialog box. 

Table 26: Smart Card Key Definitions 

Field/Button Description 

Name Enter a name for the Smart Card Key. The name Can be from 1-50 characters, and is validated as a unique name by 
C•CURE 9000. 

Description Enter a textual description of the Smart Card Key. The description can be from *I to 3000 characters. 

Smart card key file 
name 

This drop-down 1St Will be populated with all".SWK' files in the data base. Key files are unique per C•CURE 9000 
System. 

Edit File Click this button to open the Key Configuration dialog box to edit the key file. 

New File Click this button to open the New Key file d ialog box. so that you can create a new key file. 

OK Click OK to save your edits to the Smart Card Key. 

Cancel Click Cancel to d iscard any ed its you have made to the Smart Card Key. 

New Key File Dialog Box 

Table 27 on Page 116 provides definitions for the fields and buttons on the New Key File dialog box. 

Table 27: Smart Card Key Definitions 

Field/Button Description 

New File 
Name 

You can enter a name for the Smart Card Key file. The name must be from 1-50 characters. The name is is validated as a unique 
name by C•CURE 9000. 

OK Click OK to save your edits to the Smart Card Key file. 

Cancel Click Cancel to discard any edits you have made to the Smart Card Key file. 
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Smart Card Key Configuration Dialog Box 

This dialog box displays the following recommendation: 

It is recommended that you save this I IEX key value in an external source. This data is 

not stored in the database, and the loss of this key could result in reissuing all of the 

cards in the system along with reprogramming all of the readers. 

The key value in C•CURE 9000 is encrypted. You should save an unencrypted copy of 

the HEX key value in a secure location so that you can reproduce it if needed, and so that 

you can use it to program Smart Card readers to read the cards you program. 

You can use the Export Key button to save the Key value in a file with the extension .doc 

- this is not a Microsoft Word document file, it is a text file with encrypted data. Do not 

open it with a word processor like Word. This .doc file is used if you order pre-

programmed cards from Software House, or if you order program cards from Software 

House to program your Smart Card readers. 

Table 28 on Page 117 provides definitions for the fields and buttons on the Smart Card Key dialog box. 

Table 28: Smart Card Key Definitions 

Field/Button Description 

Key Value (12 
Hex 
characters) 

This is a 6 Byte Value (12 Hex Digits: Yl-l', AYE) that you can type in to create a new Smart Card Key. When you edit an 
existing Smart Card Key, this field will only show "asterisks" like a password field. 

Confirm Key 
Value 

This is a 6 Byte Value (12 Hex Digits: V-9'. A'-'F'). that must match the key in Key Value. otherwise any changes in the key 
value will not be saved when you click OK. When you click Generate Random Key. matching keys are generated and inserted 
into both the Key Value and Confirm Key Value fields. 

Generate 
Random Key 

Click this button to have the system generate a random number key value. The Random key value isdisplayed in the Key Value 
and Confirm Key Value fields. Click OK to save this random key value. 

Export Key This button will export a key to a ".DOC" format that can be used to order a program card to program smart card readers, or to 
order pre-programmed smart cards from Software House. When you dick Export Key. a prompt appears asking for the path 
where you want to save the key file. type in the path and click OK. 

Destination 
File 

T h is read-onty field displays the location that the export key .doc file will be written to. The file is named by the Smart Card key 
name that you typed in to create the key. 

OK Click OK to accept the Key value. If you have modified an existing Key, the system displays the following message 

"Are you sure you want to overwrite this key? Loss of a key could result in reissuing all of the cards in the system along with 
programming allot the readers.' 

This means that if you change the Key value and use it to program one or more Smart Cards, your Smart Card readers will need 
to be re-programmed to accept a card with the new key. If you re-program the readers, any cards you have issued using the 
previous keywill need to be re-issued aswetl. 

When the Smart Card Keydialog box reappears, you must click OK to save the Smart Card Key File. If you dick Cancel from the 
Smart Card Key dialog box, the changes you made to the Smart Card key file will not be saved. 

Cancel Click Cancel to discard any changes that you have made, or to cancel creating a Key file. 
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MIFARE Template Configuration Definitions 

The following fields and buttons appear on the MIFARE Configuration dialog box. 

Table 29: MIFARE Template Configuration Definitions 

Field or Button Description 

Name Enter a valid object name for the template. The name of the Smart Card Template must be from 1-200 characters. 

Consider induding "MIFARE- in the name to help you identify the template later. 

Confirm 
Programming/Enrolment 
Data 

If this died( box is selected, a prompt is displayed during the Enrollment/Programming to confirm the Data before 
programming or enrolment actually takes place. The user can cancel the programming and enrolment from the 
Data Confirmation Screen. If this box is deared, programming and enrolment happen automatically without 
confirmation. The default setting is deared. 

Enrol to Select a Personnel database field from the drop down list. The Card Serial Number (CSN) is enrolled into the field 
you select when the Program/Enroll button is decked on the Badging tab of a Personnel record. 

MIFARE Application Directory (MAD) Definitions 

The MAD defines the data structures for application identifier entries on the card, allowing a reader to identify the 
card and the correct memory sector within the card without needing to perform a search through the memory of each 
card passed in proximity (if multiple applications are using the same MIFARE card) until the appropriate 
application is found. 

If a person carries a MIFARE smart card for both access control to an office and for public transport fare collection, a 
reader needs to identify which sector is being used for each application. When the cardholder wants to enter the 
office, the reader identifies the office access sector by checking the MAD for the registered Application IDentifier (AID) 
instead of reading the entire card. The AIDs are stored in sector Ox00 (and sector Ox10 if applicable) of the card's 
memory, and enables identification of all registered card applications. The reader can thus use the sector pointers in 
the AID instead of physical sector addresses. 

Table 30: MIFAREApplitadon Directory (MAD) Definitions 

Field or 
Button 

Description 

Read 
Key 

The current key on the card that is needed to read the MIFARE Application Directory (MAD). The drop-down list contains all keys on 
the system and each of the Default Keys. The default value is SDefault Transport Key(value FFFFFFFFFFFF). 

Write 
Key 

The current key on the card that is needed to write to the MIFARE Application Directory (MAD). The drop-down listcontains all keys 
on the system and each of the Default Keys. The default value is SDefault Transport Key(value FFFFFFFFFFFF). 

New 
Read 
Key 

The key that will be programmed to the MAD if the Program MAD Read and Write Keys check box is selected. This key is used to 
change the value of the Read Key on cards that have already been programmed. If the Program MAD Read and Write Key check 
box is deared, this field isunavaiable. The default value is SDefautt Mdare Read Key(value A0A1A2A3AAA5). The MIFARE Default 
Read Key is typically used by ALL Mdare cards. This enables al readers to at least reference the AIDS, even if you are using Custom 
keys. 

New 
Write 
Key 

The key thatwi be programmed to the MAD if the Program MAD Read and Write Keys check box is selected. This key is used to 
change the value of the Write Key on cards that have already been programmed. If the Program MAD Read and Write Key check 
box isdeared, this field isunavaiable. The defaultvalue is SDefautt Mdare Write Key(value BOB1B2B3B4B5). 
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MIFARE Application Directory (MAD) Definitions (continued) 

Field or Description 
Button 

Program If this check box is selected. the Template will program the New Read Key and the New Write Key to the MAD. If the New Read 
MAD Key and the New Write Key are custom keys that you created. rather than default keys. only readers you have programmed with this 
Read read keycan read a card programmed with the custom key. and can prevent others from reading or writing to the MAD. Thischeck 
and box iscleared bydefautt. 
Write 
Keys 

Sectors Definitions 

The following fields appear on the MIFARE. Configuration dialog box in the Sectors area of the dialog box. 

Table 31: Sectors Definitions 

Field Description 

Sector 
Number 
(1 -15) 

This table lists the sectors(1 through 15) that you can program on a card. When you click on a sector name (such as Sector 4) the 
Sector Details, Keys, and Data sections of the dialog box become selected for that sector. If you select the Enabled check box. you can 
modify these values. This table lists the sectors(1 through 15) that you can program on a card. When you click on a sector name (such 
as Sector 4) the Sector Details, Keys, and Data sections of the dialog box become selected for that sector. If you select the Enabled 
check box, you can modify these values. 

Enabled If thischeck box is selected for a sector number, Sector Details. Keys, and Data sections become editable, and you can change the 
settings for these fields. 

Sector 
Label 

This field in the table lists the sector name you have given the sector in the Details section. 

Details Definitions 

The following fields appear on the MIFARE. Configuration dialog box in the Details area of the dialog box. 

Table 32: Details Definitions 

Field Description 

Sector 
Label 

You can create a Sector Label for each sector. If you type in a Sector Label here. it is assigned to the Sector Label in the Sector table. 

AID 
Value 

The Registered Application Identifier (AID) value you want to associate with the Sector. This field isonty needed if Programming AID 
to MAD. The MAD uses registered AlDs in Sector zero of the card's memory to enable identification of all registered card applications. 
The Software House registered AID is 5120. 

Program 
AID to 
MAD 

If this value is checked, the AID Value is written to the MAD during card programming. The template must have the proper Write Key 
value in the MIFARE Application Directory (MAD) or the AID value will not be programmed to the MAD. 
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Keys Definitions 

The following fields appear on the MIFARE. Configuration dialog box in the Keys area of the dialog box. 

Table 33: Keys Definitions 

Field Description 

Read 
Key 

Represents the current read key on the card that is used to read the Sector. You need to set this value to match the read key that is 
currentty on this sector of the card(s) you want to program/enroll, or your device will not be able to read the sector. The default value is 
SDefautt Transport Key. 

Write 
Key 

Represents the current write key on the card that is used to write to the Sector. You need to set this value to match the write key that is 
currenttyon this sector of the card(s) you want to program/enroll, or your device will not be able to write to the sector. The default 
value is SDefautt Transport Key. 

New 
Read 
Key 

The New Key that will be programmed to the Read Block on the sector if the Program Sector Read and Write Keys check box is 
selected. This key is used to change the value of the Read Key on cards that have already been programmed. If the Program Sector 
Read and Write Key check box is cleared, this field is unavailable. The default value is SDefautt Milers Read Key (value 
A0A1A2A3A4A5). 

New 
Write 
Key 

The key that will be programmed to the Write bbck on the sector if the Program Sector Read and Write Keys check box is 
selected. This key is used to change the value of the Write Keyon cards that have already been programmed. If the Program Sector 
Read and Write Kay check box is deared, this field is unavailable. The default value is SDefautt Mifare Write Key (value 
B0B1B2B3B4B5). 

Program 
Sector 
Read 
and 
Write 
Keys 

If th is check box is selected. the Template will program the New Road Key and the New Write Key to the Sector. If the New Read 
Key and the New Write Key are custom keys that you created. rather than default keys. only readers you have programmed with this 
read key can read a card programmed with the custom key, and can prevent others from reading or writing to the Sector. This check 
box iscleared bydefault. 

Data Definitions 

The following fields appear on the MIFARE Configuration dialog box in the Data area of the dialog box. 

Table 34: Data Definitions 

Field Description 

Block 0. 
Block 1, 
Bbck 2 

For each of Block 0. Block 1. and Block 2. you can select a field/format and the operation to be performed. 

Example: 

Select Intl for Bbck 0, and the Operation Program Hex to have a card sector Bbck 0 programmed with the data from the Intl 
field. 
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Data Definitions (continued) 

Field Description 

Field or 
Format 

You can choose a Personnel database field or a card format for the selected block from the drop-down list. your selection w the 
subject of the Operation you select in the Operation field for this sector. You can choose one of the following: 

• none - this is the default selection 

• Personnel Database Fields- you can choose a Personnel database field from the drop-down list. 

• MIFARE Serial Number (32 bits) 

• Smart Card Serial Number (64-bits) 

• SimplexWiegand 36 

• SimplexWiegand 26 

• HID Keypad 

• HID Simplex Grinnel 36 

The drop-down list also includes Card Formats that you have defined. 

Operation You can choose the Operation to perform on the selected block. You can choose one of the following operations: 

none - this is the default selection. No operation to perform. 

Enroll ASCII - Enroll the Data in ASCII from this Block into the Personnel Field\Format. If the Field is a Card Format, the data we 
parsed and put into the fields specified by the Card Format. 

Enroll Hex - Enroll the Data in Hex from this Block into the Personnel Field\Format. If the Field is a Card Format, the data will be 
parsed and put into the fields specified by the Card Format. 

Program ASCII - Program the Field data in ASCII to the specified block. If the field is a Card Format, the card fields will be 
assembled based on the Personnel Card data and written to the block. 

Program Hex - Program the Field data in Hex to the specified block. If the field is a Card Format, the card fieldswillbe assembled 
based on the Personnel Card data and written to the block. 

Smart 
Frame 

If you are using Software House readers. you can select Smart Frame. SmartFrame is a method of encoding the data on the card 
that defines the number of bits to be sent out by the Software House reader. This can be useful in emulating prox card formats (card 
number, facility oode, etc.). It also adds a layer of data integrity by providing checksum information to the reader. It is a proprietary 
technology only supported on the Software House readers. 

If you choose to encode data in SmartFrame, be sure your Software House readers have been programmed to read SmartFrame. 
Contact Software House Applications Engineering for the appropriate program cards for your reader. 

If this box isnot checked, then Passthrough mode is used (the data or bbck will be padded with zeros). 

PIN Select thischeck box if the field you selected for Block 1 contains a PIN value. Formatting is added so that a Software House reader 
can read the PIN. 

OK Click OK to save your changes to the MIFARE Configuration. 

Cancel ClickCancel to discard any cha nges you have made to the MIFARE Configuration. 
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Designing a Badge 

This chapter describes how to design a badge layout with the C•CURE ID Badge Designer. 

In this chapter 

The Badge Designer 124 
Using the Badge Designer 132 
Sample Data  136 
The Badge Layout Panel  138 
Setting Front-to-Back Order for Objects  148 
The Badge Layout Properties Panel  151 
The Image Properties Panel  166 
The Portrait Properties Panel  175 
The Signature Properties Panel  178 
The Text Properties Panel  180 
The Barcode Properties Panel  187 
Barcode Overview 189 
Expression Builder  196 
Sample Expressions  207 
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The Badge Designer 

The C • CURE ID Badge Designer lets you create and edit badge designs. 

The Badge Designer Panels on Page 124 provide the tools that you use to design your badge layout. 

You can add color, images and text to your badge layout, and specify how you want the information on the badge to 
appear. You can also specify the card formats for magnetic stripe encoding, if your badge design includes magnetic 
tracks (see Mag Encoding Tab on Page 154 for more information). 

You can include information that changes for each badge, such as the person's name (see Adding Dynamic Text to a 
Badge on Page 141) and individual portrait (see Adding a Portrait to a Badge on Page 144), or information that 
remains the same for all badges, such as a company name or logo. 

A badge layout has a unique name in Co CURE 9000, and has a badge layout object associated with it. A badge 
layout object contains all the badge design settings, and it can be assigned to multiple badge layouts. 

To create a new Badge Layout using the C•CURE ID Badge Designer, see Creating a Badge Layout on Page 132. 

To edit an existing Badge Layout using the C•CURE ID Badge Designer, see Editing an Existing Badge Layout on 
Page 133. 

Using the Badge Designer on Page 132 provides a list of the tasks you can perform to create badge layouts. 

The Badge Designer Panels 

The Badge Designer is made up of seven panels, two of which are displayed at a time: 

• The Badge Layout panel - This panel, which is always displayed, provides a visual palette for adding and 
arranging objects on the badge, such as images, signatures, text, and barcodes. When a particular type of object is 
selected by clicking it, the appropriate Properties panel becomes active and you can edit the object's properties. 
See The Badge Layout Panel on Page 138. 

• The Badge Layout Properties panel - This panel is displayed when you select the badge background rather than 
an object on the badge layout. It lets you configure the properties of the badge itself. See The Badge Layout 
Properties Panel on Page 151. 

• The Image Properties panel - This panel is displayed when you select an image object on the badge layout. It 
lets you configure the properties of an image or graphic that you placed on the badge. See The Image Properties 
Panel on Page 166. 

• The Portrait Properties panel - This panel is displayed when you select a portrait object on the badge layout. It 
lets you configure the properties of a portrait that you placed on the badge. See The Portrait Properties Panel on 
Page 175. 

• The Signature Properties panel - This panel is displayed when you select a signature object on the badge 
layout. It lets you configure the properties of a signature that you placed on the badge. See The Signature 
Properties Panel on Page 178. 

• The Text Properties panel - This panel is displayed when you select a Text object on the badge layout. It lets 
you configure the properties of a text object that you placed on the badge. See The Text Properties Panel on Page 
180. 
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. The Barcode Properties panel - This panel is displayed when you select a barcode object on the badge layout. It 
lets you configure the properties of a barcode object that you placed on the badge. See The Barcode Properties 
Panel on Page 187. 

Accessing the Badge Designer 

You access the C•CURE ID Badge Designer to create a new badge layout file, or to edit an existing badge layout file. 

To Access the C•CURE ID Badge Designer 

1. Choose Personnel>Badge Layout from the C•CURE 9000 Administration Client Navigation pane. 

• To edit an existing Badge Layout, click to open the Dynamic View listing all Badge Layouts 
and double-click the Badge Layout you wish to edit. 

• To create a new Badge Layout, click New. 

The Badge layout Editor appears. 

Figure 23: Badge Layout Editor 
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2. If you are creating a new badge layout, type a name for the badge layout in the Name field. 

3. dick Launch C•CURE ID Badge Designer. 

The C•CURE ID Badge Designer, shown in Figure 24 on Page 126, appears. 
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F Inure 24: C•CURE ID Badge Designer 
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Badge Designer Menus and Toolbars 

The C•CURE ID Badge Designer includes the following menus and toolbars: 

• Badge Designer Menus on Page 126 

• Context (Right-Click) Menu on Page 128 

• Badge Designer Status Bar on Page 129 

. Badge Designer Toolbar on Page 130 

. Badge Layout Panel Toolbars on Page 139 

Badge Designer Menus 

The functions available from the C•CURE ID Badge Designer menus are listed in Table 35 on Page 126. 

Table 35: Badge Designer Menus 

Menu 
Item 

Description 

File Menu 

Import You can import badge layouts from C•CURE 800/8000 .swb or .bdg Pies, or C•CURE 9000.badge layouts that were exported to 
.swb ties. When you select import, a Windows fie selection dialog box opens and you can select the badge layout file you wish to 
import. Click Open and the badge layout is opened in the Badge Designer. you can then edit the badge layout and save it when you 
close the Badge Designer. See Importing a Badge Layout on Page 133. 
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Badge Designer Menus (continued) 

Menu 
Item 

Description 

Export You can export badge layouts from C•CURE 800/8000 or C•CURE 9000 as .swb files that are suitable for 

importing to another C•CURE 800/8000 or C•CURE 9000 system.. When you select Export, a Windows Save As 

dialog box opens and you can select or type the badge layout filename you wish to export. Click Save and the 

badge layout is saved as a .swb file. See Exporting a Badge Layout on Page 134. 

Exit Closes the C•CURE ID Badge Designer and prompts you save changes if any edits have not been previously saved. See Exiting 
the Badge Designer on Page 135. 

Edit Menu 

Cut Removes the selected item from the layout, keeping a copy of it in paste memory. 

Copy Copies the selected item on the Badge Layout into paste memory. 

Paste Pastes the item in memory onto the current Badge Layout. 

Delete Deletes the selected item on the Badge Layout. Delete does not save the object in paste memory. 

Bring to 
Front 

Moves the selected item from the backof the Badge Layout to the front, placing it above another items except for text. Text fields 
have a order of their own which son top of a Ilother object types. 

Send to 
Back 

Moves the selected item to the back of the Badge Layout, placing it behind another items except text. Text fields have a back-to-
front order of their own which son top of another object types. 

Preferences Launches the Grid Preferencesdialog box. See Grid Preferences Dialog Boxon Page 130. 

Sample 
Data 

Allows you to enter sample values for anyof the fieldsin the Personneldatabase. When you add a field to the badge layout, the 
Sample Data for that field is displayed, to show you that field's appearance. See Sample Data on Page 136. 

Insert Menu 

Barcode Inserts a Barcode object on the Badge Layout Panel and displays the Barcode Properties Panel. See The Barcode Properties 
Panelon Page 187. 

Image Inserts an Image object on the Badge Layout Panel and displays the Image Properties Panel Properties for Images. See The 
Image Properties Panelon Page 166. 

Portrait inserts a Portrait object on the Badge Layout Panel and displays the Image Properties Panel Properties for Portraits. See The 
Portrait Properties Panelon Page 175. 

Signature Inserts a Signature object on the Badge Layout Panel and displays the Image Properties Panel Properties for Signatures. See The 
Signature Properties Panelon Page 178. 

Text Inserts a Text object on the Badge Layout Panel and displays the Text Properties Panel. See The Text Properties Panel on Page 
180. 

Align Menu 
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Badge Designer Menus (continued) 

Menu 
Item 

Description 

Center 
Horizontal 

Centers the currently selected control(s) in the Badge Layout Panel horizontally (left/right) relative to the badge layout. 

Center 
Vertical 

Centers the currently selected controls) in the Badge Layout Panel vertically (up/down) relative to the badge layout. 

Align to Grid Moves the currently selected object in the Badge Layout Panel into alignment with the closest grid coordinates on the Badge 
Layout Panel. The grid must be visible for this function to work. 

Size to Grid Moves the currently selected object in the Badge Layout Panel into alignment with the closest grid points. and changes its size 
horizontally and vertically to align with the closest grid points on the Badge Layout Panel. The grid must be visible for this function to 
work. 

Menu Item Description 

View Menu 

Badge Front For badgeswith two sides. this menu selection. or the key combination CTRL + F. displays the Front of the badge. 

Badge Back For badgeswith two sides, this menu selection, or the keycombination CTRL + B, displays the Backe( the badge. 

Scale -Inches Changes the current scale for the Badge Layout into inches. 

Scale - 
Centimeters 

Changes the current scale for the Badge Layout into centimeters. 

Next Control Selects the next object on the badge. This menu choice is useful if you have overlapping objects and are finding it hard to 
select the one you want to edit. 

Previous Control Selects the previous object on the badge. This menu choice is useful if you have overlapping objects and are finding it hard 
to select the one you want to edit. 

Help Menu 

About C•CURE ID 
Design 

Launches the About C•CURE ID Design Dialog Box that describes the version of the product. 

OK - Closes the About dialog box 

Help Contents Displays the Table of Contents of the onbne Help. 

Context (Right-Click) Menu 

When you click on an object in the Badge Layout panel to select it, you can then Right-click on the object to bring up 

a context menu (Figure 25 on Page 129) that provides the functions listed in Table 36 on Page 129. 
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Figure 25: Context Menu 
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Table 36: Context Menu Functions 

Menu 
Item 

Description 

Focus 
Off 

Removes focus from (de-selects) the currently selected object on the badge layout. 

Bring 
to 
Front 

Moves the selected item to the front of the Badge Design, changing the front-to-backorder, and placing it above all other items, except 
for text. Text fields have a front-to-backorder of their own on top of allother object types. See Setting Front-to-Back Order for Objectson 
Page 148. 

Send 
to 
Back 

Moves the selected item to the back of the Badge Design. changing the front-to-backorder, and placing it behind all other items except 
the badge background. The badge background is behind all other badge elements. See Setting Front-to-Back Order for Objects on 
Page 148. 

Cut Removes the selected item from the Badge Design, keeping a copy of it in paste memory. 

Copy Copies the selected item on the Badge Design into paste memory. 

Paste Pastes the item in memoryonto the current Badge Design. 

Delete Deletes the selected item on the Badge Design. Delete does not save the object in paste memory. 

Badge Designer Status Bar 

The Badge Designer Status Bar is displayed at the bottom of the C•CURE ID Badge Designer, and shows information 

about the badge layout you are editing. 

Table 37: Badge Desgner Status Bar 

Field Description 

Scale Shows the scale currently in use: either Inches or Centimeters. Use theView menu to change the scale. 

x = and y= Shows the exact position of the mouse pointer, according to the scale in use. Red indicator hoes are displayed on the X/ Y rulers to 
help track the exact position of the mouse pointer within the badge layout. 

X = Y =W = 
I-I = 

Shows the pixel address of the object selected. If you move a selected object these values will change. 
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Badge Designer Status Bar (continued) 

Field Description 

Badge 
Layout 
name 

Shows the name of the badge layout currently being edited in the Badge Designer. 

Badge Designer Toolbar 

The Badge Designer Toolbar provides quick access to several functions, such as viewing the back or front of the 

badge, and cycling among the objects on the badge layout. 

Table 38: Badge Designer Toolbar 

Icon Name Description 

el Edit Sample Data Click this button to edit the sample field values in the Sample Data dialog box. See Sample Data on Page 136. 

a
et 

Compose Creates a single composite object from all of the objects on the badge layout. 

Decompose Separates a composite object into separate objects, so that you can modify an individual object on the badge 
layout. 

--I 
Lai 

Switch to Front of 
Badge/Switch to 
Backe( Badge 

This button is available only if you have specified the badge as two-sided. Click to toggle the Badge Layout view 
between the back and front of the badge. 

. Select Badge 
Properties 

Click this button to select the badge background and activate the Badge Properties Panel. This can be useful 
when there are mufti& objects on the badge that substantially cover the background, so that it is difficult to find 
an empty space to click in. 

51. Previous Control Select the next object on the badge. This button is useful if you have overlapping objects and you are finding it 
hard to select the one you want to edit. 

Bt.> Next Control Select the previousobject on the badge. This button is useful if you have overlapping objects and you are finding 
it hard to select the one you want to edit. 

Grid Preferences Dialog Box 

The Grid Preferences dialog box (see Figure 26 on Page 131) lets you set the width and height (in pixels) of the space 

between the dots in the badge layout grid. You can type in a value for the height and width, then click OK to change 

the grid. Your change is only visible if the grid is toggled on using E. 
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Figure 26: Grid Preferences Dialog Box 
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Using the Badge Designer 

You use the C•CURE ID Badge Designer to design a badge layout for your personnel badges. After you initially 
create a badge layout, the steps you take to complete your badge layout design depend upon the badge elements you 
decide to include on the design. The tasks outlined here provide you with instructions for adding these badge 
elements. See the sections listed below for instructions on performing Badge Layout design tasks. 

• Creating a Badge Layout on Page 132 

• Editing an Existing Badge Layout on Page 133 

• Saving Your Badge Layout on Page 135 

• Configuring a Badge Layout on Page 139 

• Importing a Badge Layout on Page 133 

• Exporting a Badge Layout on Page 134 

• Aligning Objects Using the Grid on Page 146 

• Adding Magnetic Tracks to a Badge Layout on Page 161 

• Adding an Image to a Badge on Page 143 

• Adding a Portrait to a Badge on Page 144 

• Adding a Signature to a Badge on Page 144 

• Adding Text to a Badge on Page 141 

• Adding a Barcode to a Badge on Page 142 

• Deleting an Object from a Badge Layout on Page 148 

• Create a Boolean Expression using the Expression Builder on Page 196 

Creating a Badge Layout 

Badge layouts are stored in the C•CURE 9000 database. (A Badge layout can be exported to an .SWB file for use on 
another C•CURE ID system - see Exporting a Badge Layout on Page 134.) 

To Create a New Badge Layout 

1. In the C•CURE 9000 Administration client application Navigation pane, click Personnel. 

2. Choose Badge Layout from the drop-down list and click New. The Badge layout Editor opens. 
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Figure 27: Badge Layout Editor 
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3. Type a name for your new badge layout in the Name field. 

4. Type an optional description for your badge layout in the Description field. 

5. Click Launch C•CURE ID Badge Designer. The C•CURE ID Badge Designer opens, and you can configure the 
new badge layout. 

Editing an Existing Badge Layout 

If you have previously created a badge layout, you can edit it to make changes to the badge design. 

To Edit an Existing Badge Layout 

1. In the Administration application window, choose Personnel>Badge Layout, then click gja. A Dynamic View 
listing the available Badge Layouts opens. 

2. Double click a badge in the list to open the Badge Layout Editor. 

3. Click Launch C•CURE ID Badge Designer. The C•CURE ID Badge Designer opens, and you can edit the badge 
layout. 

Importing a Badge Layout 

If you have previously exported a badge layout from C•CURE 9000 or saved a badge layout from 
C•CURE 800/8000, you can import the badge layout into C•CURE 9000 and edit it to make changes to the badge 
layout. 
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NOTE 
The paths for the Import and Export files must be the same if you are importing or exporting between 
C•CURE systems. 

To Import a Badge Layout 

1. In the C•CURE 9000 Administration client application Navigation pane, click Personnel. 

2. Choose Badge Layout from the drop-down list and click New. The Badge Layout Editor opens. 

3. Type a name and description for the badge layout in the Name field and the Description field. 

4. Click Launch C•CURE ID Badge Designer. The C•CURE ID Badge Designer opens. 

5. Choose File>Import from the Badge Designer menu. 

6. From the Windows File Open dialog box that appears, navigate to the folder where your badge layout files are 
stored. 

7. Choose the type of badge layout file you want to import from the Fields of type: drop-down list (swb or .bdg 
files). 

8. Select a file from the list of badge layout files and click Open. The badge layout file you selected opens in the 
Badge Designer. You can now edit the file. 

9. To save the badge layout to the C•CURE 9000 database when you are done editing, exit the Badge Designer, then 
click Save and Close from the Badge layout Editor. The badge layout is saved to the C•CURE 9000 database 
with the name that you specified in the Badge Layout Editor. 

Exporting a Badge Layout 

You can export a badge layout from C•CURE 9000 so that it can be imported into another C•CURE 9000 or 
C•CURE 800/8000 system. 

NOTE 
The paths for the Import and Export files must be the same if you are importing or exporting between 
C•CURE systems. 

To Export a Badge Layout 

1. In the C•CURE 9000 Administration client application Navigation pane, click Personnel. 

2. Choose Badge Layout from the drop-down list and click Rik A list of the Badge Layouts in your 
C•CURE 9000 database appears. 

3. Double-click on a Badge Layout in the list. The Badge Layout Editor opens. 

4. Click Launch C•CURE ID Badge Designer. The C•CURE ID Badge Designer opens. 

5. Choose Ele>Export from the Badge Designer menu. 

6. From the Windows File Save As dialog box that appears, navigate to the folder where you want to store your 
exported badge layout . 

7. Type a file name for the Badge layout file you wish to save. 

8. Click Save. The Badge layout file is saved to the folder you selected. 
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Saving Your Badge Layout 

When you have created a new badge layout or edited an existing badge layout from the C•CURE H3 Badge Designer, 
you need to save your work. 

NOTE 
Your edits are saved only if you click Save and Close in the Badge Layout dialog box. If 
you made changes to the badge layout file, save them in the Badge Designer, but click 
Cancel in the Badge Layout dialog box, C•CURE 9000 interprets this as your intent to 
discard the changes you made. 

To Save Your Badge Layout 

1. From the C•CURE ID Badge Designer, choose File>Exit from the Badge Designer Toolbar to save your badge 
layout. 

2. The Badge layout Editor appears. You need to click Save and Close to save the changes that you made to the 
badge layout file. 

Exiting the Badge Designer 

When you have completed your edits to the Badge layout, you can save your work and exit from the Badge 
Designer. 

To Exit the Badge Designer 

1. From the C•CURE ID Badge Designer, choose File>Exit from the Badge Designer menus. 

2. The Badge layout Editor appears. You need to click Save and Close to save the changes that you made to the 
badge layout file. 
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Sample Data 

The Sample Data dialog box (Figure 28 on Page 136) lets you simulate personnel data so you can evaluate how text 
data fits your badge layout. You can use Sample Data to see how any field in the Personnel database displays in 
your badge layout. 

Example: 

If you want to include a user-named field (such as Text1) on your badge layout, you can type a sample value for 
Text1 in Sample Data, and then add the Text1 field to the badge layout to see how the field data looks on the 
badge. 

Similarly, if you want to use an expression to concatenate the First_Name, M., and Last_Name fields into a 
dynamic text object, you can type values for these fields in Sample Data and they will be displayed on the badge 
layout by your expression, so that you can check for correct spacing of the data and sizing of the text object. (See 
Using the Expression Builder on Page 197 for more information.) 

Also, if you are using Dynamic filenames with image objects, you can type the name of a value that matches a file 
name in your badging directory into Sample Data. 

Example: 

If you have an image file called Escort.bmp that represents a value of Escort in the Person_Type field in the 
database and you type "Escort" into Sample Data for the Person_Type field and include on the badge layout a 
dynamic filename image object that uses Person_Type to get its value, the Escort.bmp image appears on the 
badge layout as the Dynamic image. 

See Setting a Dynamic Image Source for an Image Object on Page 171. 

Figure 28: Sample Data Dialog Box 
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Sample Data loads all of the fields currently in your Personnel database and lets you assign sample values to them. 
Assigning values to Sample Data fields is optional, and you only need to assign values to those fields you expect to 
use on your badge layout. Table 39 on Page 137 describes the columns and buttons on the Sample Data dialog box. 
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Table 39: Sample Data Columns and Buttons 

Fields/Buttons Description 

Fields T his column lists all the sample data fields. 

Values Provides a text-based field that allows for standard alpha-numeric data entry of sample data to be used by the Badge 
Designer. When you add a field from the database to the badge layout. the Sample Data value isdisplayed to represent that 
field on the badge layout. 

OK Button Saves current changes to sample data and exits the Sample Data editor. 

Cancel Button Discards any current changes to the Sample Data and exits the Sample Data editor. 

Back Button Displays the previous page of sample data values. 

Next Button Displays the next page of sample data values. 

Configuring Sample Data 

You can type values for any Personnel fields into Sample Data, and the values will be displayed on the badge 
layout, so that you can check for correct spacing of the data and sizing of the text object. 

To Configure Sample Data 

1. In the Badge Designer, select Edit>Sample Data from the menus. The Sample Badge Data dialog box opens, 
displaying a list of Personnel fields. 

2. Click Next or Back if needed to find the field you want to modify. 

3. Click in the Value column for the field to which you want to add sample data. 

4. Type the data you want to add into the Value column. 

5. If you want to add data to additional fields, repeat steps 3 and 4. 

6. Click OK to save the Sample Data. 

7. You should see the Sample Data you typed displayed in the Text objects on your badge design. 
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The Badge Layout Panel 

The C•CURE ID Badge Layout Panel let you add objects to the badge layout, and set the properties of the Badge 
layout, such as one-sided or two-sided, and badge orientation. 

The Badge Layout panel on the left side of the Badge Designer lets you design the arrangement of text and graphics 
on your badge, using the graphical tools and buttons on the panel to add and arrange text, images, portraits, 
signatures, and barcodes to the badge design. See Creating a Badge Layout on Page 132 for more information.Figure 
29 on Page 138 shows the Badge Layout Panel. 

Figure 29: Badge Layout Panel 
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The Badge layout Properties panel on the right side of the Badge Designer lets you configure the badge properties, 
Mag Encoding Options, Background Color, and badge borders. See the The Badge layout Properties Panel on Page 
151 for more information. 

The following links provide more information about the C•CURE ID Badge Layout Panel. 

• To Access the C•CURE ID Badge Layout Panel on Page 138. 

• Badge Layout Panel Tasks on Page 140. 

• Badge layout Panel Toolbars on Page 139. 

 S 
To Access the C•CURE ID Badge Layout Panel 

To access the C•CURE ID Badge Layout Panel: 

1. Access the C•CURE ID Badge Designer (see Accessing the Badge Designer on Page 125). 

2. The Badge Layout Panel is always active in the Badge designer. You can drag objects onto the badge layout, or 
use the Badge Layout Panel Toolbars on Page 139 buttons to modify the badge layout. 
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Configuring a Badge Layout 

You use the Badge Layout panel to configure the badge layout by dragging and dropping objects from the Objects 
toolbar onto the badge layout (white space), formatting these objects using the Properties toolbar, and using the other 
panels (such as the Text Properties Panel) to configure these objects. 

See Badge Layout Panel Toolbars on Page 139 for information on the meaning and use of each of the toolbar buttons. 

See Badge Layout Panel Tasks on Page 140 for an outline of the tasks you can perform using the Badge Layout panel. 

Badge Layout Panel Toolbars 

The Badge Layout panel has two toolbars: 

• The Object toolbar to the left of the Badge Layout is used to insert objects onto the badge layout. The Object 
toolbar is described in Table 40 on Page 139. 

• The Properties toolbar to the right of the Badge Layout is used to set properties of the objects on the badge layout, 
such as borders, colors, alignment, and rotation. The Properties toolbar is described in Table 41 on Page 139. 

Table 40: Badge Layout Panel Object Toolbar 

Icon Button Description 

11 II

Text Click and drag the text icon to place a text object on the Badge Layout. You use the Text Properties Panel to 
edit the text object. See The Text Properties Panel on Page 180. 

Barcode Click and drag the barcode icon to place a barcode object on the Badge Layout. You use the Barcode 
Properties Panel to edit the object. See The Barcode Properties Panel on Page 187. IIIIIMIll 

Picture Click and drag the picture icon to place a picture object on the Badge Layout. You use the Image Properties 
Panel to edit the object. See Adding an Image to a Badge on Page 143. 

U. 
Portrait Click and drag the portrait icon to place a portrait object on the Badge Layout. You use the Image Properties 

Panel to edit the object. See Adding a Portrait to a Badge on Page 144. 

Signature Click and drag the signature icon to place a signature object on the Badge Layout. You use the Image 
Properties Panel to edit the object. See Adding a Signature to a Badge on Page 144. 

poiv, 

Table 41: Badge Layout Panel Properties Toolbar 

Icon Button Description 

Toggle 
Grid 

ClickIns icon to turn the Badge Layout grid on and off. 
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Badge Layout Panel Properties Toolbar (continued) 

Icon Button Description 

Align 
Control to 
Grid 

Click this button to snap the selected object to the closest badge design grid coordinates. The grid must be visible for this 
function to work. 

Size to 
Grid 

Click this button to snap the selected object to the closest badge design grid coordinates and change the size of the 
object to align its borders with the nearest grid points. The grid must be visible for this function to work. ;11-.

Center 
Horizontal 

Click this button to center the selected object horizontalty on the badge design. The vertical position of the object 
remains the same. riO

Center 
Vertical 

Click this button to center the selected object verticalty on the badge design. The horizontal position of the object 
remains the same. F 

Bring 
Control to 
Front 

Click this button to move the selected object in front of other objects on the badge design. Text objects and non-text 
objects have separate front to back-orders, so that non-text objects never obscure text on the badge. !a l

Send 
Control to 
Back 

Click this button to move the selected object behind other objects on the badge design. Text objects and non-text 
objects have separate front to back-orders, so that non-text objects never obscure text on the badge. % 

Rotate 0 
degrees 

Rotates the selected object to start at zero degrees (the normal orientation, such as text reading from left to right). 

0 

Rotate 90 
degrees 

Rotates the selected object to start at 90 degrees (for example, text reads from the lower edge of the text box to the 
upper edge). 90 

Rotate 
180 
degrees 

Rotates the selected object to start at 180 degrees (for example, text reads upside down). 
E 

 
Rotate 
270 
degrees 

Rotates the selected object to start at 270 degrees (for example, text reads from the upper edge of the text box to the 
lower edge).El 

Set X, Y, 
Height. 
and Width 
Values 

If you want to precisety set the XIY axis position for a selected object. and also precisety set its height 

button to pop up a Position and Size dialog box that allows you to type in values or use a spinner 

decrease values. The object is repositioned dyne m Ica Ity when you click from one field on the dialog to 
to close the dialog box. 

and width, click this 

increase inease or 

another. Click 21,

is ai 

Mn 

Click this button to delete the currentty selected object from the Badge Layout Panel. 
X

Delete 

Badge Layout Panel Tasks 

You can perform the following tasks from the Badge Layout panel: 
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• Adding Text to a Badge on Page 141 

• Adding a Barcode to a Badge on Page 142 

• Adding an Image to a Badge on Page 143 

. Adding a Portrait to a Badge on Page 144 

• Adding a Signature to a Badge on Page 144 

• Moving and Resizing Objects on a Badge on Page 145 

• Aligning Objects Using the Grid on Page 146 

• Setting Front-to-Back Order for Objects on Page 148 

• Deleting an Object from a Badge Layout on Page 148 

• Adding a Border to an Object on Page 149 

. Adding a Border to the Badge on Page 149 

Adding Text to a Badge 

You can add two kinds of text fields to a badge layout: 

• Dynamic text is used to print text on the badge that is specific to the badge holder. The Dynamic text source is a 
field in the badge holder's Personnel record, such as Last_Name, First_Name, or Card_#. See Adding Dynamic 
Text to a Badge on Page 141. 

You can also use the Expression Builder to add Dynamic Text to a badge. See Defining a Boolean Expression for 
a Text Object on Page 181. 

• Static text does not come from the Personnel record, but is text that appears on every person's badge; for 
example, the static text may be a company name, address, or phone number. See Adding Static Text to a Badge 
on Page 142. 

Adding Dynamic Text to a Badge 

To Add Dynamic Text to a Badge 

When you add Dynamic Text to a badge design, you are choosing a Personnel database field to be the source for the 
text. When the badge is printed, that field's contents appear in the text field on the badge. 

L. In the Badge Layout Panel, drag the text icon ❑T  onto the Badge Layout (or choose Insert>Text from the 
menus). A selected text object appears on the Badge Layout. 

2. Position the text object in the Badge Layout. 

3. To size the text object, use the selection handles (mouse pointer changes to H when you hover over). 
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4. On the Text Properties Panel Text tab, select Dynamic Text, and choose a Personnel Database field from the 
drop-down list to be the source of the dynamic text. 

5. On the Text Properties Panel Font/Color tab, set the font and color properties for the text object. See Setting Color 
and Font Properties for a Text Object on Page 182. 

Adding Static Text to a Badge 

To Add Static Text to a Badge 

In the Badge Layout Panel, drag the text icon ID onto the Badge Layout (or choose Insert>Text from the 
menus). A selected text object appears on the Badge Layout. 

2. Position the text object in the Badge Layout. 

3. To size the text object, use the selection handles (mouse pointer changes to 4-• when you hover over). 

4. On the Text Properties Panel Text tab, select Static Text, and type in the text you wish to appear in this field on 
the badge. 

5. You can apply an Auto Sizing setting to the text: 

• Use Fit Text to Control to adjust the text size. 

• Use Fit Control to Text to change the size of the text object to fit the text. 

• Use Max Font Size to set the current text size as the maximum size, so that the text stays the same 
size if you enlarge the object. 

Example: 

You can use Fit Text to Control to size the text, then use Max Font Size to ensure that the text size does not 
change if you later enlarge the text object. 

6. You can enable or disable text wrapping by clicking one of the buttons under Wrapping. 

7. On the Text Properties Panel Font/Color tab, set the font and color properties for the text object. (See Setting Color 
and Font Propertits for a Text Object on Page 182.) 

Adding a Barcode to a Badge 

Follow these steps to add a barcode to a badge layout. 

To Add a Barcode to a Badge 

1. In the Badge Layout Panel, drag the barcode icon El onto the Badge Layout (or choose Insert>Barcode from the 
menus). A selected barcode object appears on the Badge Layout. 

CLD 
142 Chapter 5 C•CURE 9000 C•CURE ID User Guide 

EFTA01225019



The Badge Layout Panel 

2. Position the barcode object in the Badge Layout, using the mouse to drag the object into position. 

3. Use the selection handles (mouse pointer changes to 4—) when you hover over) to size the barcode object. 

4. In the Barcode Properties Panel, set the barcode properties for the barcode object. See Setting Barcode Properties 
on Page 189. 

5. In the Barcode Properties Panel, on the Barcode Caption tab, set the barcode caption properties for the barcode 
object. See Setting Barcode Caption Properties on Page 190. 

Adding an Image to a Badge 

Follow these steps to add an image to a badge layout. 

To Add an Image to a Badge 

1. In the Badge layout Panel, drag the Image icon onto the Badge layout (or choose Insert>Image from the 
menus). A selected Image object appears on the Badge layout. (When you select a source image for the object, the 
"Missing Object" label is replaced by the image itself, or "Dynamic" if you chose a dynamic image source.) 

2. Position the image object in the Badge layout, using the mouse to drag the object into position. 

3. Select the image formatting options for the image. See Image Source Tab on Page 167 for definitions of these 
settings. 

4. Use the selection handles (mouse pointer changes to 4-4 when you hover over) to size the image object. 

5. In the Image Properties Panel, select the image source (static or dynamic) that you wish to include on the badge. 
See: 

■ Setting a Static Image Source for an Image Object on Page 172 

■ Setting a Dynamic Image Source for an Image Object on Page 171 

6. If you want to use Transparency or Ghosting for the image, set the Rendering options. See Image Source Tab on 
Page 167 for definitions of these fields. 

7. If you want to use Background Detection to replace the image background with a replacement color, click the 
Image Properties Panel Background Detection tab and set the Background Detection properties for the image 
object. See Setting Background Detection Properties on Page 172 for more information. 

8. On the Image Properties panel Background Color tab, you can set a background color and a color gradient. These 
options are available only for images that are set to Maintain Ratio on the Image Source tab. See Setting 
Background Color for an Object on Page 173 for more information. 

9. If you want to add a border to the image, set the border properties on the Borders tab. See Adding a Border to the 
Badge on Page 149 for more information. 

10. On the Image Properties panel Color Management tab, set the color properties for the Signature object. See Setting 
Color Management Properties on Page 174 for more information. 
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Adding a Portrait to a Badge 

You can add Personnel database pictures to badges and use the C•CURE 11.) Graphic File dialog box to specify the 
size of the portrait, the location of the portrait on the badge, and the background color. The image that is printed on 
the badge is taken from the Portrait field in the Personnel database of the badge holder. 

To Add a Portrait to a Badge 

1. In the Badge Layout Panel, drag the Portrait icon jig onto the Badge Layout (or choose Insert>Porirait from the 
menus). A selected Portrait object appears on the Badge Layout. 

IPorIrel9 

2. Position the portrait object in the Badge Layout, using the mouse to drag the object into position. 

3. Use the selection handles (mouse pointer changes to 4-4 when you hover over) to size the portrait object. 

4. In the Image Properties Panel, select the Sample file name that you wish to include on the badge. 

5. On the Portrait Properties panel Image Source tab, set the Formatting and Rendering options for the Signature. 
See Image Source Tab on Page 167 for definitions of these fields. 

6. On the Portrait Properties panel Background Detection tab, choose the settings for Background Detection. See 
Setting Background Detection Properties on Page 172. 

7. On the Portrait Properties panel Background Color tab, you can set a background color and a color gradient. 
These options are available only for signatures that are set to Maintain Ratio on the Image Source tab. See Setting 
Background Color for an Object on Page 173 for more information. 

8. If you want to add a border to the signature, set the border properties on the Borders tab. See Adding a Border to 
an Object on Page 149 for more information. 

9. On the Portrait Properties panel Color Management tab, set the color properties for the Signature object. See 
Setting Color Management Properties on Page 174 for more information. 

Adding a Signature to a Badge 

You can add Personnel signatures to badges and use the C•CURE ID Signature File dialog box to specify the size of 
the signature, the location of the signature on the badge, and the background color. 

To Add a Signature to a Badge 

In the Badge Layout Panel, drag the signature icon onto the Badge Layout (or choose Insert>Signature from 
the menus). A selected signature object appears on the Badge Layout. 

istristimel 
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2. Position the signature object in the Badge Layout, using the mouse to drag the object into position. 

3. Use the selection handles (mouse pointer changes to 4-4 when you hover over) to size the signature object. 

4. On the Signatures Properties panel Image Source tab, select the Sample file name that you wish to include on the 
badge. 

5. On the Signatures Properties panel Image Source tab, set the Formatting and Rendering options for the Signature. 
See Image Source Tab on Page 167 for definitions of these fields. 

6. On the Signatures Properties panel Background Detection tab, choose the settings for Background Detection. See 
Setting Background Detection Properties on Page 172 for more information. 

7. On the Signatures Properties panel Background Color tab, you can set a background color and a color gradient. 
These options are available only for signatures that are set to Maintain Ratio on the Image Source tab. See Setting 
Background Color for an Object on Page 173 for more information. 

8. If you want to add a border to the signature, set the border properties on the Borders tab. See Adding a Border to 
an Object on Page 149 for more information. 

9. On the Signature Properties panel Color Management tab, set the color properties for the Signature object. See 
Setting Color Management Properties on Page 174 for more information. 

Moving and Resizing Objects on a Badge 

After you add text and objects to a badge layout, you can use the mouse or the position and sizing 
to move and resize the objects. 

h.. ft)olbar button 

To Resize an Object with the Mouse 

1. Select the object you wish to resize. A frame with selection handles appears around the object. (The selection 
handles are the solid white boxes you see on the corners of each object.) 

eJ 
2. Hover over a selection handle (the mouse pointer changes to H ), click and hold the Left Mouse Button and 

drag the selection handle to size the object. 

To Move an Object with the Mouse 

1. Select the object you wish to move. A frame with selection handles appears around the object. (The selection 
handles are the solid white boxes you see on the corners of each object.) 

LJ 
2. Click and hold the Left Mouse button, then drag the object to the position you want. 

To Position and Size an Object to Exact Measurements 

The Position and Size dialog box lets you set the position and size of a selected object exactly. 
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1. Select the object you wish to move. A frame with selection handles appears around the object. (The selection 
handles are the solid white boxes you see on the corners of each object.) 

2. Click y and the Position and Size dialog box appears. 

3. To change the X and Y position of the object, type in a new value, or use the spinner control a. 
4. To change the size of the object, type in a new value, or use the spinner controls a to change the Width and 

Height of the object. 

Grid Preferences 

You can change the grid settings for the Badge Designer from the Edit menu. 

You can use the non-printing grid as a guideline for arranging objects on a badge. 

To Modify Grid Settings 

1. From the C•CURE ID Badge Designer menus, choose Edit>Preferences. The C•CURE ID Grid Preferences dialog 
box opens. 

2. Type your preferred grid dimensions in the Width and Height boxes. Note that 1 inch equals 100 pixels. 

Example: Example: 

If you want a 3" x 3" box, type 300 for the width and height. If you want 3mm x 3mm, type 30 for the 
width and height. 

3. Click OK. 

You can use the options on the Align Menu on Page 127 and the Badge Layout Panel Toolbars on Page 139 to align 
objects and text on a badge. 

Aligning Objects Using the Grid 

Use the options on the Align Menu on Page 127 and the Badge Layout Panel Toolbars on Page 139 to align objects 
and text on a badge. You can use the non-printing grid as a guideline for arranging objects on a badge. The grid line 
spacing is set at 1/100th of an inch as a default. 

See Aligning Objects Using the Grid on Page 146 modify the grid line spacing. 

To Center an Object Horizontally 

1. Select the object you wish to center. A frame with selection handles appears around the object. (The selection 
handles are the solid white boxes you see on the corners of each object.) 
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2. Select Align>Center Horizontal from the menus. The object will move to a horizontally-centered position (its top-
to-bottom positioning does not change. 

To Center an Object Vertically 

1. Select the object you wish to center. A frame with selection handles appears around the object. (The selection 
handles are the solid white boxes you see on the corners of each object.) 

2. Select Align>Center Vertical from the menus. The object will move to a vertically-centered position (its left-to-
right positioning does not change. 

To Align an Object to the Grid 

1. To display the grid, click Toggle Grid On/Off ID 
2. In the Badge Layout panel, select the object you want to align and choose Align>Align to Grid from the menu, or 

click Align Control to Grid g. 
To Size an Object to the Grid 

You can move and resize an object to match up with the badge grid so that you can more precisely control how the 
object is placed. The Size to Grid menu selection and toolbar button snap the selected object to the closest badge 
design grid coordinates, and change the size of the object to align its borders with the nearest grid points. 

1. To display the grid, click Toggle Grid On/Off 0. 
2. In the Badge Layout panel, select the object you want to align with the grid. 

3. Choose Align>Size to Grid from the menu, or click Size Control to Grid EL 
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Setting Front-to-Back Order for Objects 

You can change the front-to-back order of badge elements. There are four planes for badge elements: 

Text — The topmost plane. No other elements can be in front of the Text layer. 

Signature - Signatures are behind Text but in front of Images and the Badge Background. 

Image - Images are behind Text and Signatures but in front of the Badge Background. 

Badge Background — The lowest plane. No other elements can be behind the Badge Background. 

Each plane can hold multiple objects with a front-to-back order you can specify. For example, if two images overlap, 
you can determine which image is in front and which is behind the other. But the images can never be behind the 
Badge Background or in front of a Text object. 

To Bring an Object to Front 

I. Select the object you wish to bring to front. A frame with selection handles appears around the object. (I he 
selection handles are the solid white boxes you see on the corners of each object.) 

2. Right-click on the object, and a Right-click menu appears. 

3. Select Bring to Front 

4. Click in another area of the badge to de-select the object (objects always appear on top when selected). The object 
will appear in front of other objects in its plane and in planes behind it. 

 -GM 

To Send an Object to Back 

1. Select the object you wish to send to back. A frame with selection handles appears around the object. (The 
selection handles are the solid white boxes you see on the corners of each object.) 

2. Right-click on the object, and a Right-click menu appears. 

3. Select Send to Back. 

4. Click in another area of the badge to de-select the object (objects always appear on top when selected). The object 
will appear in back of other objects in its plane and in planes in front of it. 

Deleting an Object from a Badge Layout 

Follow these steps to delete an object from a badge layout. 
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To Delete an Object from a Badge Layout 

1. In the Administration application window, choose Configure>Badge Layout. The Badge Layout Selection 
browser opens. 

2. Select a badge to design from the list and click Edit. The Badge Layout Editor opens. 

3. Select the Badge Layout file that you want to edit and click Edit File... 

4. In the C•CURE ID Badge Layout Panel, select the object that you want to delete. 

5. Choose Edit>Delete from the menus, or click Q Delete Object on the Badge Layout Panel Toolbars on Page 
139. 

Adding a Border to an Object 

You can put a colored border on any object in the badge layout, except a barcode. 

To Add a Border to an Object 

1. In the Badge layout panel, click on an object to select it. 

2. Click the Borders tab on the Properties panel. 

3. Choose a Border Type: 

• None is the default, no visible border. 

• Solid adds a single-color border to all four sides of the object. 

• Diagonal adds a border with mitered edges to the object, with up to four colors. 

• Square adds a border with squared edges to the object, with up to four colors. 

4. If you want to draw the border outside of the object (so that the border does not obscure the edges of the object), 
select Draw Around. 

5. Select a Border Width for the border by typing in a number or using the spinner 

6. For Diagonal or Square borders, select a Border Height by typing in a number or using the spinner 

7. Pick a Border Color for the object by clicking on the El in the Border Colors box. 

• If you chose Solid for the Border type you can pick one color for all four sides. 

• If you chose Diagonal or Square, you can pick up to four colors, one for each of the Top, Bottom, 
Left, and Right sides. 

8. Observe the borders that are visible for the object in the Badge Layout, and make any adjustments needed. 

Adding a Border to the Badge 

You can add a colored border on the badge background of the badge layout, so that the entire badge has a border. 
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To Add a Border to the Badge 

1. In the Badge Layout panel, click on 13 to select the badge background. 

2. Click the Borders tab on the Badge Layout Properties panel. 

3. Choose a Border Type: 

• None is the default, no visible border. 

• Solid adds a single-color border to all four sides of the object. 

• Diagonal add a border with mitered edges to the object, with up to four colors. 

• Square adds a border with squared edges to the object, with up to four colors. 

4. Pick a Border Color for the object by clicking on El in the Border tab. 

• If you chose Solid for the Border type you can pick one color for all four sides. 

• If you chose Diagonal or Square, you can pick up to four colors, one for each of the Top, Bottom, 
Left, and Right sides. 

5. Select a Border Width for the border by typing in a number or using the spinner a. 

6. For Diagonal or Square borders, select a Border Height by typing in a number or using the spinner a. 

7. Observe the borders that are visible for the object in the Badge Layout, and make any adjustments needed. 

Badge Layout Properties Panel Tabs 

The Badge Layout Properties Panel has four tabs. The following sections describe the fields and buttons on these 
tabs. 

• Badge Layout Tab on Page 152 describes the Badge layout Tab. 

• Mag Encoding Tab on Page 154 describes the Mag Encoding Options Tab. 

• Properties Panel Background Color Tab on Page 155 describes the Background Color tab. 

• Properties Panel Borders Tab on Page 157 describes the Borders tab. 
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The Badge Layout Properties Panel 

The C•CURE ID Badge Layout Properties Panel has four tabs: 

The Badge Layout Properties Panel has four tabs. The following sections describe the fields and buttons on these 
tabs. 

• Badge Layout Tab on Page 152 describes the Badge layout Tab. 

• Mag Encoding Tab on Page 154 describes the Mag Encoding Options Tab. 

• Properties Panel Background Color Tab on Page 155 describes the Background Color tab. 

• Properties Panel Borders Tab on Page 157 describes the Borders tab. 

The following links provide more information about the Badge layout Properties Panel. 

• to Access the C•CURE ID Badge Layout Properties Panel on Page 151. 

• Badge Properties Panel Tasks on Page 152. 

To Access the C•CURE ID Badge Layout Properties Panel 

To access the C•CURE ID Badge Properties Panel: 

1. Open the C•CURE ID Badge Designer (see Accessing the Badge Designer on Page 125). 

2. The Badge Properties Panel is initially active in the Badge Designer. You can change the settings in the Badge 
Properties Panel to modify layout and Mag Encoding properties of the badge layout. 

Figure 30 on Page 151 shows the Badge layout Properties panel. 

Figure 30: Badge Layout Properties Panel 
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Badge Properties Panel Tasks 

From the C•CURE ID Badge Properties Panel, you can perform the following tasks: 

• Setting the Badge Layout to One-sided or Two-sided on Page 159 

• Setting the Badge Layout to Portrait or Landscape on Page 159 

• Setting the Badge Size on Page 159 

• Setting the Front or Back Image of a Badge on Page 159 

• Setting the Badge Background Color on Page 160 

• Adding Magnetic Tracks to a Badge Layout on Page 161 

• Using a Magnetic Track for Access Control on Page 162 

• Setting Magnetic Stripe Encoding Formats on Page 165 

Badge Layout Tab 

The Badge layout tab lets you set the size and orientation of the badge using the Badge layout tab, and also add a 
background image to the front and/or back of the badge. 

You can perform the following tasks from the Badge layout Tab: 

• Setting the Badge Layout to One-sided or Two-sided on Page 159 

• Setting the Badge Layout to Portrait or landscape on Page 159 

• Setting the Badge Size on Page 159 

• Setting the Front or Back Image of a Badge on Page 159 

• Setting the Badge Background Color on Page 160 

See Badge layout Tab Definitions on Page 152 for descriptions of the fields and buttons on this tab. 

Badge Layout Tab Definitions 

The Badge Properties Panel Badge Layout Tab has the following fields and buttons. 

Table 42: Badge Layout Tab Definitions 

Button/Icon Description 

One-Sided 
Badge 

r _j 

Clickthis button to set the badge design to single-sided. Doing so disables the button on the Badge Layout panel. 
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Badge Layout Tab Definitions (continued) 

Buttortecon Description 

Two-Sided 
Badge 

r DJ 

Click this button to set the badge design to double-sided. Doing so enables the e l l button on the Badge Layout panel, so that you 
can switch the display to the front or back of the badge. 

Landscape 
Badge 

r E) 

Sets the badge design to Landscape, where the badge width is greater than the badge height. 

Portrait 
Badge 

r d 

Sets the badge design to Portrait, where the badge height is greater than the badge width. 

Width Type in the wdth of the badge in inchesor Centimeters (set with Vieve>Scale -inches or Vieve>Scale - Centimeters), then 
click the Resize Badge button. The default settings are: 

Portrait Badge - 2.125 inches 

Landscape Badge - 3.375 inches 

Height Type in the height of the badge in Inchesor Centimeters (set with Vieve>Scale -Inches or Vieve>Scale - Centimeters), then 
click the Resize Badge button. The defautt settings are: 

Portrait Badge - 3.375 inches 

Landscape Badge - 2.125 inches 

Unrtof 
Measure 

Displays the current Scale mode (I nches or Centimeters). set with VievmSca le -Inches or VievmSca le - Centimeters. 

Resize Badge 

a 

if you type in a new badge height and/or width and click this button, the badge design is resized to those dimensions. The 
maximum badge size is 11 x11 inches (27.94 x27.94 centimeters). 

Default 
Badge Size 

Click this button to reset the badge to the default size of 2.125 x 3.375 (CR-80 size). 

• Landscape default size: 3.375 x 2.125 inches or 8.572 x 5.397 centimeters. 

• Portrait default size: 2.125 x 3.375 inches or 5.397 x 8.572 centimeters. 

Apply Image 
(Front) 

Select th is check box to enable the selection of a badge background image for the front side of the badge. You can then click the 

Selection button El to open a Windows file selection dialog box and choose an image file for the badge background. 

F it to Badge 
(Front) 

Select this check box to resize the background image to fit the full size of the badge background for the front side of the badge. 

Ghosting 
Value Slider 
(Front) 

Drag the slider to change the percentage of Ghosting you want to apply to the background image for the front side of the badge. 
Ghosting addswhiteness to the image. but unlike transparency, it does not allow an object behind the image to show through. 
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Badge Layout Tab Definitions (continued) 

Buttonlicon Description 

Print (Front) Select this check box to have the background image print on the front of the badge when the badge is printed. If you do not select 
this check box, the background image is not printed. 

Apply Image 

(Back) 

Select thischeck box to enable the selection of a badge background image for the back side of the badge. You can then click the 

Selection button` l  to open a Windows file selection dialog box and choose an image file for the badge background. 

F it to Badge 
(Back) 

Select thischeck box to resize the background image to fit the full size of the badge background for the back side of the badge. 

Ghosting 
Value Slider 
(Back) 

Drag the slider to change the percentage of Ghosting you want to apply to the background image for the back side of the badge. 
Ghosting adds whiteness to the image, but unlike transparency, it does not allow an object behind the image to show through. 

Print (Back) Select this check box to have the background image print on the back of the badge when the badge is printed. If you do not select 
this check box. the background image is not printed. 

Mag Encoding Tab 

The Mag Encoding tab on the Badge Properties panel lets you add magnetic stripes to your badge design, and then 

configure the magnetic tracks using database fields or the Expression Builder. 

Figure 31 on Page 154 shows the Mag Encoding tab. 

Figure 31: The Mag Encoding Tab 
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See Mag Encoding Tab Definitions on Page 155 for descriptions of the fields and buttons on this tab. 

Mag Encoding Tab Tasks 

You can perform the following tasks from the Mag Encoding tab: 

Encoding Magnetic Tracks on Page 160 

Adding Magnetic Tracks to a Badge Layout on Page 161 

Using a Magnetic Track for Access Control on Page 162 

Setting Magnetic Stripe Encoding Formats on Page 165 

You should also review Important Considerations for Magnetic Encoding on Page 162 to see if these specific issues 
apply to your badges or printers. 

Mag Encoding Tab Definitions 

The Badge Properties Panel Mag Encoding Tab has the following fields and buttons. 

Table 43: Mag Encoding Tab Definitions 

Button/Field Description 

Magnetic Stripe 
check box 

Select this choice to enable magneticstripe encoding for the badge. Thischoice isonty available for two-sided badges. 

Two Magnetic 
Tracks 

Select thischoice to enable Magnetic Tracks 1 and 2.A hvo-stripe magnetic track isdisplayed on the back side of the badge. 

Three Magnetic 
Tracks 

Select this choice to enable Magnetic Tracks 1.2. and 3.A three-stripe magnetic track is d ispLayed on the back side of the 
badge. 

Encode 
Magnetic Track 
1 

Encode 
Magnetic Track 
2 

Encode 
Magnetic Track 
3 

Select a magnetic track, and choose a database field to encode from the drop-down list, or chose' == to create an expression 
using the Expression Bolder. 

MagTrack2 and MagTrack3 can contain only numeric data. Do not assign a database field ()ran expression that 
contains non-numeric characters to MagTrack2 of MagTrack3. 

Exprn Click this button to open the Expression Builder. This button is available onty d you have chosen "=" for the value of Encode 
Magnetic Track. 

Properties Panel Background Color Tab 

The Background Color tab allows you to set the Background color for an object on the badge layout. You can set the 
Background Color for Text, Image, Portraits, Signatures, and the Badge Background. Barcodes do not support 
background colors. 
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NOTE 
On the Image, Portrait, and Signatures Properties panels, the Background Color tab is 

available only if Maintain Ratio is selected. This is because only images that use aspect 

ratio can have a background. 

To set the background color of an object, select the object and click the Background Color tab on the Properties Panel 

for the object. 

For step instructions, see Setting Background Color for an Object on Page 173. 

Table 44 on Page 156 provides definitions of the fields and buttons on the Background Color tab. 

Table 44: Background Color Tab Definitions 

Field/Button 

....m , 

Description 

Background 
Color 

ei 
To set the background color for an object, dick to open a color selection dialog box. 

Clickon thecolor you want to use then dick OK You can click Define Custom Colors to expand thecolor selection dialog box if 
you want to choose precise RGB or Hue/Saturation/Luminosity values for a border. After choosing these values, dick Add to 
Custom Colors, then click on the custom color and dick OK to set the background color. 

Transparent 
To set the transparency of the background color, use the slider 7 or type in a transparency percentage in (no lickt 
and press Enter. Values range from 0% (Opaq ue) to 100% (full transparency). 0% is the default value. 

Gradient 
drop-down 

If you do not want to use a gradient for the background, use the default setting (None). 

If you want to use a gradient for the background, select one of the following gradient types: 

• Horizontal 

• Vertical 

• Forward Diagonal 

• Backward Diagonal 

• Center Diamond 

• Center Square 

• Center horizontal Bell 

• Center Vertical Bell 

• Center Horizontal Narrow 

• Center Vertical Narrow 

Blond Color If a gradient type other than None ischosen, thecolor selected here is blended with thecolor selected for the Background 
Color. 

al 
To set the blend color for an object, click to open a color selection dialog box. 

Click on the color you want to use then click OK. You can dick Det Ins Custom Colors to expand the color selection dialog box if 
you want to choose precise RGB or Hue/Saturation/Luminosity values for a border. After choosing these values, dick Add to 
Custom Colors, then dick on the custom color and dick OK to set the blend color. 

Blending 
Value 

Blending Value lets you set the blending percentage for the object. 

Use the spinner - to increase or decrease the blending value for the object background. You can also type a value into the field 
and press Enter. 

0 value is the default blend value and results in an even blend from the background color to the blend color. 

Values 1-20 result in a percentage blend. A higher the blend value increases the amount of the blend color in the gradient. 
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Properties Panel Borders Tab 

The Borders tab allows you to add borders to an object on the badge layout. You can add borders to Text, Image, 

Portraits, Signatures, and to the Badge Background. Barcodes do not support borders. 

To add borders to an object, select the object and click the Borders tab on the Properties Panel for the object. 

For more detailed instructions, see Adding a Border to an Object on Page 149. 

Borders Tab Definitions 

Table 45 on Page 157 provides definitions of the fields and buttons on the Borders tab. 

Table 45: Borders Tab Definitions 

Field/Button Description 

None This is the default selection indicating an object with no visible borders. Select None to remove an existing border from an object. 

Solid Select Solid to add a single-color border to all four sidesof an object. You willonty be able to pick one color from the border 
colors box. If you have previousty chosen multiple colors, the Top color is the default color for the solid border. 

Diagonal Select Diagonal to add up to four colored beveled borders to the object. The three pictures below show the diagonal edge of the 
borders. 

You can choose up to four colors for the borders, one each for the top, bottom, left, and right sides. You can control the thickness 
of the borders by adjusting the Border Width and Border Height settings. See the examples in Table 46 on Page 158. 

Square Select Square to add up to four colored square borders to the object. The three pictures below show the square edge of the 
borders. 

You can choose up to four colors for the borders, one each for the top, bottom, left, and right sides. You can control the thickness 
of the borders by adjusting the Border Width and Border Height settings. See the examples in Table 46 on Page 158. 

Draw Around This selection determines whether or not the border covers over some of the image or text of the object. 

If you select Draw Around, the border is drawn at the outer edge of the object box, and image or text is placed within the 
remaining region inside the object box. The entire image or text is visible. You can change the size of the object box if the image 
or text is too small after the border is applied. 

If you do not select Draw Around, the border isdrawn at the outer edge of the object box, but over the image or text, possibly 
covering part of the image or text. The entire image or text may not be visible. Any overlap will remain if you change the size of the 
object box. 

Border Width a 
Use the spinner S to increase or decrease the width of the left- and right-side borders on the object. You can also type a value 
into the field and press Enter. 

Border Height Use the spinner S to increase or decrease the Height of the tope and bottom borders on the object. You can also type a value 
into the field and press Enter. 
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Borders Tab Definitions (continued) 

Fieldeutton Description 

Colors Cto Click to open a color selection dialog box to set the color for a border. You can click Define Custom Colors to expand the 
color selection dialog box if you want to choose precise RGB or Hue/Saturation/Luminosity values for a border. After choosing 
these values, click Add to Custom Colors. then clickon the custom color and click OK to set the border color. 

If you select Solid as the border type you can only select one color. If you select None for the border type. these buttons are 
unavailable. 

I:,;.; ai To set the color for the top border. click to open a color selection dialog box. Cuckoo the color you want to use then click OK. 

Bottom (es To set the color for the bottom border, click to open a color selection dialog box. Click on the color you want to use then click 
OK. 

Left es To set the color for the left border, click to open a color selection dialog box. Clickon the color you want to use then click OK. 

Right aTo set the color for the right border, click to open a color selection dialog box. C lick on the color you want to use then click 
OK. 

Table 46: Borders Example 

Example Description 

In this picture. a diagonal red top border and a black bottom border are defined, with no right or left borders. oil 
In this picture. a diagonal colored border isdefined for each of the top. bottom. left. and right sides. The width and height settings 
are not equal, so the border'sdiagonal edges do not meet exactly. a 
In this picture, if diagonal adjacent borders are the same color and set to an equalwidth and height, they will look merged. 

In this picture, a square red top border and a black bottom border are defined, with no right or left borders. 

In this picture. a square colored border is defined for each of the top. bottom. left. and right sides. The width and height settings are 
not equal, but because of the square border edges, the borders meet evenly, even though the width and heights vary. 'P IM

In this picture, if square adjacent borders are the same color and equalwidth and height, they will look merged. 

158 Chapter 5 C•CURE 9000 C•CURE ID User Guide 

EFTA01225035



The Badge Layout Properties Panel 

Setting the Badge Layout to One-sided or Two-sided 

Perform the following steps to set the badge layout to one-sided or Two-sided. 

To Set the Badge Layout to One-Sided or Two-Sided 

In the Badge Properties Panel, chose either One-sided or Two-sided for the badge layout. 

— Click r a to set the badge to One-sided. You can only add layout elements to the front of the badge if 
you choose One-sided. 

— Click r D ❑ to set the badge to Two-sided. Several additional options become available so that you can 
add an image to the back of the badge. 

Setting the Badge Layout to Portrait or Landscape 

Perform the following steps to set the badge layout to Portrait or Landscape orientation. 

To Set the Badge Layout to Portrait or Landscape 

In the Badge Properties Panel, chose either Portrait or Landscape orientation for the badge layout. 

— Click   to set the badge to Landscape. If there are badge elements already on the badge, a dialog box 
appears to inform you that changing the orientation might effect the arrangement of these elements on the 
layout. Click Yes to accept the change, or No to cancel the change. 

— Click r Eli to set the badge to Portrait orientation. If there are badge elements already on the badge, a 
dialog box appears to inform you that changing the orientation might effect the arrangement of these 
elements on the layout. Click Yes to accept the change, or No to cancel the change. 

Setting the Badge Size 

You can set the badge dimensions for your badge layout by performing the following steps. 

To Set the Badge Size 

1. In the Badge Properties Panel, click in the Width Field and type in a setting for the Badge Width. 

2. Click in the Height field and type in a setting for the Badge Height. 

3. Click the Resize Badge button to apply the new settings. 

4. Alternatively, you can click the Default Badge Size button al to change the badge size back to the default size 
p375 x 2.125 for Landscape and 2125 x 3375 for Portrait). 

Setting the Front or Back Image of a Badge 

You can set the background of a badge layout to an image. If you have a Two-sided badge, you can also specify a 
back image for the badge layout 
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To Set the Front Image of a Badge 

The front image on the badge acts as a background for the front of the badge. You can place other badge elements 
over it, and set their background to transparent so that the background image shows through. If you set the 
background of an object to opaque, then the front image of the badge is not visible through that badge element. 

1. In the Badge Properties Panel, click the Apply Image - Front checkbox to enable a badge front image. 

2. Click Select es to select an image for the badge front. A Windows file selection dialog box opens and you can 
navigate to find the image you want to use. Click OK and the background image you chose is displayed on the 
Badge Layout Panel. 

3. If you want to reduce or enlarge the image so that it fits on the badge front, click Fit to Badge. 

4. To make the image darker or lighter, click in the Ghosting Value slider to move the slider bar left or right. The 
box to the right of the slider will display the Ghosting Value as you adjust it. 

5. Click the Print checkbox if you want the image to be printed on the badge when you send the badge to print. 

 a 
To Set the Back Image of a Badge 

1. In the Badge Properties Panel, click the Apply Image - Back checkbox to enable a badge rear image. 

2. Click Select Ej to select an image for the badge back. A Windows file selection dialog box opens and you can 
navigate to find the image you want to use. Click OK and the background image you chose is displayed on the 
Badge layout Panel. 

3. If you want to reduce or enlarge the image so that it fits on the badge rear, click Fit to Badge. 

4. To make the image darker or lighter, click in the Ghosting Value slider to move the slider bar left or right. The 
box to the right of the slider will display the Ghosting Value as you adjust it. 

5. Click the Print checkbox if you want the image to be printed on the badge when you send the badge to print. 

Setting the Badge Background Color 

You can set a background color for the front and/or back of a badge. The background color is not visible if also 
choose a background image. 

To Set the Badge Background to a Color 

1. From the Badge Designer toolbar, click Select Badge Properties to select the badge background. 

2. Click Fill Control Background Color El to open a Windows color selection dialog box. 

3. Click on the background color you want to assign to the badge background and click OK. The badge background 
changes to the selected color. 

Encoding Magnetic Tracks 

You can encode up to three magnetic tracks on a badge layout, if your badge printer supports magnetic track 
encoding. 

180 Chapter 5 C•CURE 9000 C•CURE ID User Guide 

EFTA01225037



The Badge Layout Properties Panel 

You can encode information from a C•CURE 9000 personnel record onto any of the three magnetic tracks available 
with magnetic cards. When a track contains encoded information, such as a card number, a controller interprets the 
information when a user swipes the magnetic card through a card reader. 

Readers supported on C•CURE 9000can only read Track 2 for access control. If you are using the magnetic stripe 
for access control, the information must be encoded on Track 2. 

If you are using the magnetic stripe for access control, refer to Using a Magnetic Track for Access Control on Page 
162 for specific instructions on configuring the magnetic stripe. 

All three magnetic tracks can be encoded for functions other than access control. 

You should review Important Considerations for Magnetic Encoding on Page 162 to see if these specific issues apply 
to your badges or printers. 

Adding Magnetic Tracks to a Badge Layout 

To add magnetic encoded tracks to your badge layout, perform the following steps. 

To Add Magnetic Tracks to a Badge Layout 

1. Open the Badge Designer (see Accessing the Badge Designer on Page 125). 

2. The Badge Properties Panel is initially active in the Badge Designer. In the Badge Properties Panel, click on the 
Mag Encoding tab. 

3. Select Magnetic Stripe. The Number of Tracks and Track Alignment boxes appear. 

4. Select either Two Magnetic Tracks or Three Magnetic Tracks. The Mag Track Data box appears, containing 
fields for either two or three tracks. 

5. To encode one or more of these Mag tracks, select the track to encode (Encode Magnetic Track 1, Encode 
Magnetic Track 2, or Encode Magnetic Track 3). 

6. The drop-down list box for the magnetic track you selected becomes available, with the default MagTrack# field 
selected. 

7. If you want to print the personnel data for the Mag Card format to the track on the badge, use the default 
selection (MagTrackl, MagTrack2, or MagTrack3). See Setting Magnetic Stripe Encoding Formats on Page 165 for 
more information. 

8. If you want to use a different database field for the magnetic track, select a database field from the Mag track 
field name drop-down list. 

9. If you want to use the Expression Builder to create a boolean expression, choose "=" for the Mag Track Held 
Name. The Expr>> button becomes available. Click Expr>> to create a Boolean expression. See Expression 
Builder on Page 196 for more information. 

10. You can choose the track alignment of the magnetic tracks by choosing either Right/Top or Left/Bottom in the 
Track Alignment box. If you are viewing the back of the badge (click El to toggle the front/back view) you can 
see how the magnetic stripes are positioned on the badge when you select either track alignment. 

Note that MagTrack2 and MagTrack3 can contain only numeric data. Do not assign a database field or an 
expression to MagTrack2 or MagTrack3 that contains non-numeric characters. 
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Using a Magnetic Track for Access Control 

If you are using the badges you design with a Mag Reader for access control, you need to make sure that the correct 
card format data is printed to the magnetic stripe. 

Readers supported on C•CURE 800/8000 can only read Track 2 for access control If you are using the magnetic 
stripe for access control, the information must be encoded on Track 2. 

Therefore, when you configure the Mag Encoding Options on the Badge Layout, you need to: 

• Select Encode Magnetic Track 2. 

• Use the default selection (MagTrack2) for the Mag Track Data. 

• Assign the correct Card Format for Magnetic Stripe Encoding to Stripe 2 on the Badge Layout dialog box. 

To Configure Mag Encoding Options for Access Control 

Perform the following steps to configure Mag Encoding Options for C•CURE 800/8000 access control: 

1. Open the C•CURE ID Badge Designer (see Accessing the Badge Designer on Page 125). 

2. The Badge Properties Panel is initially active in the Badge Designer. In the Badge Properties Panel, click on the 
Mag Encoding tab. 

3. Select Magnetic Stripe. The options for Two Magnetic Tracks and Three Magnetic Tracks appear. 

4. Click on Two Magnetic Tracks to enable two magnetic tracks on the badge layout, or on Three Magnetic Tracks 
to enable three magnetic tracks on the badge layout. The fields appear to enable you to encode up to three 
magnetic tracks. 

5. Select Encode Magnetic Track 2. 

6. The Mag Track Held Name drop-down default value is MagTrack2. This is the correct choice for C•CURE 
800/8000 access control. 

7. Exit the C•CURE ID Badge Designer, saving your changes. The Badge layout dialog box appears. 

8. Double-click the Stripe 2 field under Card Formats for Magnetic Stripe Encoding. The Card Format Selection 
dialog box appears. 

9. Select the card format that you want to encode on the badge (this must be a card format supported by your Mag 
Reader. The most commonly used format is Magnetic 14). Click Select 

10. When the Badge layout dialog box appears, the card format you chose appears in the Stripe 2 field. 

11. Click OK to save your changes. 

12. When you configure your Mag Reader, be sure to enable the same Magnetic card format. 

Important Considerations for Magnetic Encoding 

Before designing and printing badges with magnetic strips, you should review the following issues to ensure that 
your badge design works as intended with your badge printer. 

182 Chapter 5 C•CURE 9000 C•CURE ID User Guide 

EFTA01225039



The Badge Layout Properties Panel 

• Uppercase ASCII in Mag Track 1 on Page 163 

• Numeric Fields in Mag Track 2 on Page 163 

• Encoding Magnetic Track 3 on Page 163 

• Two-Sided Badges and the Magnetic Stripe on Page 163 

• Magnetic Encoding with Eltron Printers on Page 164 

• Magnetic Encoding with Nisca Printers on Page 164 

Uppercase ASCII in Mag Track 1 

Because most printers expect MagTrack 1 to be uppercase ASCII characters, C•CURE ID converts all MagTrack 1 
characters to uppercase ASCII. 

Numeric Fields in Mag Track 2 

When encoding MagTrack 2 data, C CURE ID appends zeroes to fill numeric fields. 

Example: 

The Card_# database field has a maximum length of 10 numeric characters. If you use only four characters for 
your Card_#'s, C•CURE ID appends six zeroes to fill this 10-character field prior to encoding MagTrack 2. 

Encoding Magnetic Track 3 

If you need to encode Magnetic Track 3, note that this track supports numeric data only, and will not encode space 
characters. Therefore, you must ensure that any data you encode-whether you use a card format, a database field, or 
an expression-contains only numeric data with no spaces, or the printer will not encode the magnetic stripe. 

Example: 

The Card_# database field has a maximum length of 10 numeric characters. If your Card_#'s are only four 
characters long, encoding will fail. 

To avoid this problem, you can use the Expression Builder LEN() function to specify the length of the data you want 
to encode. 

Example: 

The expression LEN(Kard_#I)+","+Kard_#1 tells the printer to encode exactly the number of characters that exist 
in the Card_# database field. 

Two-Sided Badges and the Magnetic Stripe 

When you design a two-sided badge with a magnetic stripe on the reverse side, you need to make sure that your 
badge design does not include objects that will overprint the magnetic stripe. Therefore, you must be aware of the 
orientation your badge printer uses for the magnetic stripe. 

If your printer orients the magnetic stripe at the bottom of the badge, your badge design should not contain any 
design elements (text, images, pictures) that print on the badge in that area. 

If you printer orients the magnetic stripe at the top of the badge, your badge design should not contain any design 
elements (text, images, pictures) that print on the badge in that area. 
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Magnetic Encoding with Eltron Printers 

If you are using an Eltron printer, make sure before you attempt to print cards with magnetic encoding that the Mag 
Encoding printer property is set to On. This property is Off by default. To view this setting, right click on the printer 
icon in Windows, select Properties, then click on the Device Settings tab and make sure that With magnetic encoding 
is set to Yes. 

Magnetic Encoding with Nisca Printers 

The Nisca printer default Encoder text string prefix and suffix configured on the C•CURE ID Magnetic Encoding 
dialog (See Setting Magnetic Encoding Options on Page 65) includes the default data length for the Mag14 card 
format. If the data you wish to encode uses a different card format, or has a different length than the default, you 
need to adjust the prefix for your Nisca printer. 

If the length of the data is fixed, you can change the default data length in the prefix: 

1. From the ID Setup dialog box, click Mag Encoding. 

2. Select Nisca from the Select Encoder Device list. The Encoder text string prefix and suffix for each track then fills 
automatically. 

3. Change the data length parameter in the prefix to the correct value for your data. 

Example: 

If you are encoding 15 characters on Track 1, change the prefix from: 

"-O1,0,0" to "-O1,0,15". 

4. Click OK. 

If the length of the data is variable, you need to use the Expression Builder to create an expression that includes the 
printer prefix code, instead of using the default printer prefix: 

1. From the ID Setup dialog box, click Mag Encoding. 

2. Select Nisca from the Select Encoder Device list. The Encoder text string prefix and suffix for each track then fills 
automatically. 

3. Clear the default text string prefix by clicking in the Prefix field, highlighting the text, and pressing Delete. 

4. Click OK. 

5. Use the Expression Builder to create an expression that includes the printer prefix code, and calculates the length 
of the variable data you wish to encode. 

Example: 

To encode the database field Card_# on Mag Track 3, use an expression such as: 

"-441,3," + LEN(Kard_C)+","+[Card_#1 

where "-61,3," represents the prefix for Mag Track 3, LEN([Card_#D calculates the length of the Card_# field, 
and [Card_#1 is the actual data from the Card_# field. 
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Setting Magnetic Stripe Encoding Formats 

In the C•CURE ID Badge Design Editor, you can specify the card formats for magnetic stripe encoding for a badge 
layout file. You can encode up to three magnetic stripes on a card. However, these three fields are initially grayed 
out, and only become active after you have inserted a Magnetic Stripe while editing the badge layout file using the 
C•CURE ID Design Editor. 

To Specify the Card Format for Magnetic Stripe Encoding 

1. Follow the steps for Adding Magnetic Tracks to a Badge Layout on Page 161, using the default selection 
(MagTrack1, MagTrack2, or MagTrack3) for each track you have enabled. 

2. Click Save and Exit El to close the Badge Designer. 

3. The Badge layout Dialog Box opens. For each Magnetic Track you enabled and assigned a MagTrack# to, you 
can select a Card format by double-clicking on the appropriate field: Stripe 1, Stripe 2 or Stripe 3 (if these fields 
are unavailable, you need to go back to the Badge designer and assign MagTrackl, Magtrack 2, or MagTrack 3 to 
the corresponding magnetic stripe). 

4. The Card Format Selection dialog opens. Select a Card Format from the list and click Select (Typically, Magnetic 
14 is used for access control magnetic stripe cards.) 

5. Click OK in the Badge Layout dialog box. 
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The Image Properties Panel 

The C•CURE ID Image Properties Panel lets you configure an image object that you have added to the badge layout. 
Figure 32 on Page 166 shows the Image Properties panel with the Image Source tab active. 

Figure 32: Image Properties Panel 
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The following sections provide more information about the C•CURE ID Image Properties Panel. 

• Accessing the Image Properties Panel on Page 166 

• Image Properties Panel Tasks on Page 167 

• Image Properties Panel Tabs on Page 167 

Accessing the Image Properties Panel 

Perform the following steps to access the C•CURE ID Image Properties Panel: 

To Access the Image Properties Panel 

1. Open the C•CURE ID Badge Designer. 

2. Drag an image object icon from the from the Badge Layout Toolbar onto the Badge Layout, or select 
Insert>Imagefrom the menus, or select an existing image object on the Badge Layout, and the Image Properties 
Panel becomes active. See Figure 33 on Page 167. 
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Figure 33: Click and Drag Icon to Create Image Object 
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Image Properties Panel Tabs 

The Image Properties Panel has the following tabs. 

• Image Source Tab on Page 167 describes the Image Source Tab. 

• Background Detection Tab on Page 169 describes the Background Detection Tab. 

• Properties Panel Background Color Tab on Page 155 describes the Background Color tab. 

• Properties Panel Borders Tab on Page 157 describes the Borders tab. 

• Color Management Tab on Page 170 describes the Color Management tab. 

You can click kMj to scroll these tabs to the left or right. 

Image Properties Panel Tasks 

From the C•CURE ID Image Properties Panel, you can perform the following tasks: 

• Accessing the Image Properties Panel on Page 166 

• Setting a Static Image Source for an Image Object on Page 172. 

• Setting a Dynamic Image Source for an Image Object on Page 171. 

• Setting Background Detection Properties on Page 172. 

. Setting Background Color for an Object on Page 173 

. Setting Color Management Properties on Page 174. 

Image Source Tab 

The Image Source tab lets you specify a static or dynamic filename for an image object. 

A static filename is used to identify a picture that is displayed on all badges using this layout. 

C•CURE 9000 C•CURE ID User Guide Chapter 5 187 

EFTA01225044



The Image Properties Panel 

A dynamic filename is used to identify a field in the Personnel database that contains a filepath identifying a picture 
file. Using a dynamic filename allows you to display a variety of images on the badges using this badge layout. For 
example, if you have several image files that represent employee levels (manager, associate, assistant, supervisor, 
etc) you can use a field in the database to store the name of the file that matches each person's level. Their badge will 
display the appropriate graphic. 

For Portrait and Signature objects, this tab includes a Sample FileName field that can be used to display a graphic 
file in badge previews (see ) to verify the position and appearance of the signature or portrait on the badge. When the 
badge is printed, the actual Signature or Portrait associated with the Personnel record will be printed on the badge. 

The Image Source tab also provides fields that let you position the image, and adjust the transparency and ghosting 
effects. 

Image Source Tab Definitions 

Table 47 on Page 168 provides definitions for the Image Source Tab fields and buttons. 

Table 47: Image Source Tab Definitions 

Button/Field Description 

Sample Filename Select 

U 

Available only when you add a Portrait or Signature to the Badge Layout. Cliddhe Select button 
to open a Windows Open Fie dialog box to select a Me to be used as the sample 
Portrait/Signature image. 

Static Filename Click this checkbox to enable the Static Filename Select button. A static image is an image that 
appears on every badge to the badge layout. 

Static Filename Select 

LJ 

Click this button and an Open file dialog box appears so that you can choose an rage that MI 
appear on every badge. Alternatively, you can manually path enter a  and fie name in the field. 

Dynamic Filename Cliddhisdnackbox to enable the Dynamic Filename Select button, so that you can add a 
database field whose value is an image filename. 

Dynamic Filename Select 
ii

Click this button to select any database field from the drop-down list. C•CURE ID will take the 
value of the database field and use it as the filename for en image at print time. T his method 
suppons any of the following file types: .BMP, .EXF, .GIF, .JPG, .PNG, .TIF..WNIF. 

F it to Control Stretches the selected image to fit the full sae of the control. Alignment buttons are not available 
with this option. 

Proportional stretch Forces a graphic to retain its original proportions when you (rasa° the graphic along with the size 
of the control. Alignment buttons are not avaiable with this option. 

On badge designs upgraded from a prior release, you wil need to select proportional stretch per 
object if you wish to resole objects proportionally. 

Maintain Ratio Maintains the ratio of the original image Sae within the Sae of the control but allows the control to 
have space around the image. Alignment buttons are enabled and avaiable with this option. 
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Image Source Tab Definitions (continued) 

Button/Field Description 

Alignment (vertical) Top - The text is anchored to the top of the text box. 

Middle - The text is anchored in the middle of the text box. 

Bottom- The text is anchored to the bottom of the text box. 
In  via l 

Alignment (Horizontal) 

It :x],
Left- The text is anchored to the left of the text box. 

Center - The text is anchored to the center of the text box. 

Right - The text is anchored to the right of the text box. 

Transparency Enables the Transparency slider that sets a percentage for transparency from 0-100%. 
Transparency a lbws objects behind the image to show though the selected image. This option 
must be selected for Transparent Replacement Mode in Background Detection to work. 

Ghosting Enables the Ghosting slider that sets a percentage for ghosting from 0 -100%. Ghosting adds 
whiteness to the image but does not allow object behind the image to show through the selected 
image. 

Background Detection Tab 

The background Detection tab lets you control whether or not background detection is used to modify the 

background or an image, signature, or portrait object on the badge layout. 

The Background Detection Tab has the following fields and buttons. 

Table 48: Background Detection Tab Definitions 

ButtonlField Description 

Enable 
Background 
Color 
Detection 

Select this check box to enable the Background Detection fields. 

Colored Selects Color Replacement Mode. enabling the Replacement Color Button. 

Transparent Selects Transparent Replacement Mode, disabling the Replacement Color Button. The selected color is treated as 
transparent, so that objects behind the image on the badge layout can show through. 

Color To 
Detect 

Select the color to use for background detection from the drop-down list. The Automatic selection uses an algorithm that takes 
a sample of the background from the upper right and left oornersof the images and then calculates the average color to use for 
background detections. The Select Color choice enables the Eyedropper button. 

Eyedropper Click to change the cursor to an eyedropper. You can click on a pixel in the image displayed on the badge layout to select the 
color to be used for background detection. 

This button is visible onty if Select Color is chosen from the Color to Detect drop-down list. 

Tolerance 
level 

Use the slider to select from 0-100% tolerance from the selected color to replace or make transparent. Alternatively you can type 
in the tolerance value ma n ualty in the (bid. Transparency from the Image Source tab must be enabled for th is option to work. 
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Background Detection Tab Definitions (continued) 

Button/Field Description 

Replacement 
Color 

Click to open a Color Selection dialog box, so that you can select a color to replace the background detected color. 

eti 

Color Management Tab 

Color Management adjusts the way colors are used in the badge layout graphical elements you have defined. 

Example: 

If all the employee portraits you have taken have a yellow tint because of lighting conditions, you can 

use Color Management to adjust the contrast and brightness levels to compensate. 

The Image Properties Panel Color Management Tab has the following fields and buttons. 

Table 49: Color Management Tab Definitions 

Button/Field Description 

Brightness 
slider 

Adjusts the brightness of the image from -100 to 100. Alternatively you can type in the value manually in the value field. The 
default value is O. 

-100 isoompletety black, 100 isoompletety white, if &lather values are left at default settings. 

Contrast slider Adjusts the contrast of the image from 0 to 100. Alternatively you can type the value manually in the field. The default value is 25. 
A higher contrast value makes the image lighter, while a lower value darkens the image. 

Saturation 
Slider 

Adjusts the level of saturation from 0 - 100. Alternatively you can type the value manually in the field. The default value is 20. 
Reducing saturation makes an image look grayer. Increasing saturation adds brilliance but can distort skin tones. 

Hue Slider Adjusts the level of hue from 0 - 360. Alternatively you can type the value manually in the field. The default value is O. 

Red slider Adjusts the level of red from 0 - 255. Alternatively you can type the value manually in the field. The default value is O. 

Green slider Adjusts the levelergreen from 0 - 255. Alternatively you can type the value manually in the field. Thedefault value is O. 

Blue Slider Adjusts the leveler blue from 0 - 255. Alternatively you can type the value manually in the field. Thedefault value is O. 

Sharpness 
Radius Slider 

Sets the amount of sharpness modification to apply to the image object. Increasing the Radius compensates for blurry edges. 

Sharpness 
Depth Slider 

Sets the amount of sharpness modification to apply to the image object. Increasing the Depth of field can decrease blurring of 
out-of-focus areas of the image. 

Grayscale Select this check box to convert the image to GrayScale (shades of white, black, and gray) and enable the GrayScale slider and 
field. Use the slider to select a GrayScale value from 0-255. Alternatively you can type the value manually in the field. The default 
value is 127. 

Reset Click this button to reset all color management tools back to default settings: Brightness = 0. Contrast = 25, Saturation = 20, 
GrayScale =cleared, All color and Sharpness sliders = 0 
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Setting a Dynamic Image Source for an Image Object 

When you place an Image Object on the badge layout, the image source must be specified. You can configure a 
Dynamic image that can be different on each badge. You select Dynamic Filename if you want to use a database field 
to determine which image appears on each badge. You set up the database field you chose to contain the file name of 
the image you want to place on the badge. 

When the badge is printed, C•CURE ID looks for an image object in the database that has the same name as the 
field's value in the database. 

For example, for a field value of "SafetyTeam" C•CURE ID looks for an image object named "SafetyTeam" to print on 
the badge. You can also use a User-named field such as Text]. to link to dynamic image objects for a badge. 

Example: 

If you want to print a graphic on specific badges to identify members of the corporate Safety Team: 

1. For each person that you want to have this graphic printed on their badge, assign "SafetyTeam" to 
the Text]. field. 

2. Import an image into the database to add to these badges, and name it "SafetyTeam". See the 
C•CURE 9000 Personnel Configuration Guide for instructions on importing an image. 

3. Add an image to the badge layout, and assign it a Dynamic Filename of Text1. 

4. When printing a badge, if the value of Text]. for a Personnel record is "SafetyTeam" C•CURE ID 
looks for an image object in the database of that name. 

To Set a Dynamic Image Source for an Image Object 

1. Access the Image Properties panel by creating a new image object (see Accessing the Image Properties Panel on 
Page 166 or selecting an existing image object. 

2. On the Image Properties Panel Image Source tab, select Dynamic Filename to select an image that will be keyed 
to a C•CURE Database value. 

3. Select a text database field from the drop-down list. The database field you choose is used to determine what 
image should be placed on the badge. 

4. Import an image into the database to add to these badges, and name the image. See the C•CURE 9000 Personnel 
Configuration Guide for instructions on importing an image. 

5. For each Person's badge that you want the image to appear on, use the Personnel Editor (see the C•CURE 9000 
Personnel Configuration Guide) to edit that text field and type the name of the imported image object that you 
saved. 

6. On the Personnel Editor Badging tab, click Preview Badge to view a preview of the badge to make sure the 
dynamic image called "Badge Image" appears correctly. 
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Setting a Static Image Source for an Image Object 

When you place an Image Object on the badge layout, the image source must be specified. It can be a Static image 
that is identical on every badge. This is useful for company logos, building pictures, or similar images you want 
repeated on all badges. 

To Set a Static Image Source for an Image Object 

1. Access the Image Properties panel by creating a new image object (see Accessing the Image Properties Panel on 
Page 166 or selecting an existing image object. 

2. On the Image Properties Panel Image Source tab, select Static Filename to select an image that will appear on 
every badge. 

3. Click E to choose a image file to display as a placeholder in the Badge Designer. A Windows File Selection 
dialog box appears. You can navigate to the folder your images reside in, and you can change the Files of type 
drop-down to All files to see file types other than the default .JPG files. 

4. Choose a image file from the dialog box, then click Open. 

5. The image you chose is added to the badge layout as a static image. 

Setting Background Detection Properties 

Use the Background Detection tab if you want to remove the background of an image, or if you want the background 
of the image to be transparent or have a specified color. 

To Set Background Detection Properties for an Image Object 

1. Select the image object you want to configure. 

2. On the Properties Panel Background Detection tab, click on Enable Background Detection to make the 
Background Detection fields available for configuration. The Background Detection fields appear. 

3. Choose a Replacement Mode: 

Colored — You can specify a color on the image that you want to replace with another color using the Color 
to Detect and Replacement Color fields. 

Transparent — You can specify a color on the image that you want to be treated as transparent so that the 
background color from the badge will be visible,. using the Color to Detect field. 

4. If you want to isolate the the main object in the image from color replacement and fill the rest of the image with 
the background color, Select Edge Detection. (This is most useful in portrait images, so that any color in the 
person's picture that coincidently matches the background color is not replaced.) You can select and clear this 
check box after you have chosen a replacement color to see how edge detection affects the image. 
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5. Use the Color To Detect drop-down list to pick a specific color to be replaced (Colored mode) or be rendered as 
transparent (Transparent mode). 

6. Alternatively, you can chose a specific pixel color from the image to be replaced or rendered transparent. (This is 
useful if you have an area on the image whose color is not included in the drop-down list.) 

a. Choose Select Color from the Color To Detect drop-down list and the  dl button appears. 

b. Click  then move the cursor to a pixel in the image that you want to chose as the Replacement Color. The 
replacement color is used to fill in all pixels that are replaced. 

7. Use the Tolerance Level slider to choose how closely a color on the image must match the color you selected for 
replacement to occur. The higher the tolerance level, the more shades of the color you chose are replaced. A 
Tolerance Level of 0 means that only the color you specified is replaced. You can try different settings of the 
Tolerance Level, observing the result on the Badge Layout Panel, until you achieve the desired result. 

8. If you chose Colored as a Replacement Mode, you can click El to choose the Replacement Color. The 
replacement color is used to fill in all pixels that are replaced. For example, if you choose white, every pixel in 
the image that is replaced will be colored white. (If you chose Edge Detection, the color replacement does not 
occur within the portion of the image inside the edge.) 

Setting Background Color for an Object 

You can set the background color for an object such as a portrait, signature, image, or text, or for the badge 
background itself. You cannot set the background color for a barcode object. 

You use the settings on the Background Color tab of the Properties panel for your object to control the background 
color of an object. 

For image, portrait, and signature objects, the Maintain Ratio setting on the Image Source tab of the Properties panel 
must be selected for the settings on the Background Color tab to be available. 

To Set the Background Color for an Object 

1. Select the object for which you want to set the background color in the Badge layout panel. To select the badge 
background, click El to de-select all other objects. 

2. For an image, portrait, or signature, make sure that Maintain Ratio is selected on the Image Source tab. 

3. Click the Background Color tab. 

4. Click El to open a Windows color selection dialog box. Select a color from the dialog box and click OK. 

5. Use the Transparency slider to adjust the level of transparency for the background color. 

6. If you want to add a Gradient effect using a second color, select a Gradient pattern from the drop-down list. 

7. Click the Blend Color El to open a Windows color selection dialog box. Select a Blend Color from the dialog box 
and click OK. 

8. Use the gi to set the Blending Value between 0 and 20 (the default value of 0 displays a 50% blend. A value of 
20 shows the maximum amount of the Background Color. A value of 1 show the maximum amount of the Blend 
Color. 
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Setting Color Management Properties 

(For a Portrait, Image, or Signature) 

Color Management adjusts the way colors are used in the badge layout graphical elements you have defined. 

Example: 

If all of the employee portraits you have taken have a yellow tint because of lighting conditions, you can use this 
tool to adjust the contrast and brightness levels to compensate. 

To Set Color Management Properties for an Object 

1. Select the image object you want to configure. 

2. On the Properties Panel Color Management tab, click on the Brightness slider to set the amount of Brightness 
modification to apply to the image object. 

3. Click on the Sharpness Radius and Depth sliders to set the amount of sharpness modification to apply to the 
image object. Increasing the Radius compensates for blurry edges. Increasing the Depth of field can decrease 
blurring of out of focus areas of the image. 

4. Use the color sliders (Red, Blue, Green, Hue, and Saturation) to adjust the values of these color settings. 

5. Alternatively, click GrayScale if you want the image to be converted to a non-color image. 

6. Adjust the GrayScale level using the slider, or type in a number from 0 to 255 in the GrayScale setting box. (You 
can click Reset to return the GrayScale setting to the default value of 127.) 
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The Portrait Properties Panel 

The C•CURE ID Portrait Properties Panel lets you configure a portrait object that you have added to the badge 
layout. Figure 34 on Page 175 shows the Portrait Properties panel with the Image Source tab active. 

Figure 34: Portrait Properties Panel 
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The following sections provide more information about the C•CURE ID Portrait Properties Panel. 

• Accessing the C•CURE ID Portrait Properties Panel on Page 175. 

• Portrait Properties Panel Tasks on Page 176. 

• Portrait Properties Panel Tabs on Page 176. 

Accessing the C•CURE ID Portrait Properties Panel 

I't•rform the following steps to access the C•CURE ID Portrait Properties Panel: 

To Access the C•CURE ID Portrait Properties Panel 

1. Open the C•CURE ID Badge Designer (see Accessing the Badge Designer on Page 125). 

2. Do one of the following: 

• Select an existing portrait object on the Badge Layout. 

• Drag a Portrait Object icon onto the Badge Layout to insert a new Portrait object. 

• Select Insert,Portrait from the menus to insert a new Portrait object. 

3. The Portrait Properties Panel becomes active on the right side of the Badge Designer. 
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Figure 35: Click and Drag Icon to Create Portrait Object 

Ell

Portrait Properties Panel Tabs 

The Portrait Properties Panel has the following tabs. 

• Image Source Tab on Page 167 describes the Image Source Tab. 

• Background Detection Tab on Page 169 describes the Background Detection Tab. 

• Properties Panel Background Color Tab on Page 155 describes the Background Color tab. 

• Properties Panel Borders Tab on Page 157 describes the Borders tab. 

• Color Management Tab on Page 170 describes the Color Management tab. 

You can click 4 °. 1 to scroll these tabs to the left or right. 

Portrait Properties Panel Tasks 

From the C•CURE ID Portrait Properties Panel, you can perform the following tasks: 

• Accessing the C•CURE ID Portrait Properties Panel on Page 175 

• Adding a Portrait to a Badge on Page 144. 

• Setting a Sample Filename on Page 177 

• Setting Background Detection Properties on Page 172. 

• Setting Background Color for an Object on Page 173. 

• Adding a Border to an Object on Page 149. 

• Setting Color Management Properties on Page 174. 
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Setting a Sample Filename 

When you place a Portrait or Signature on the badge layout, your image source is the Portrait or Signature associated 
with the badge holder in the C•CURE Personnel database. The image you choose here acts as a placeholder in the 
design. 

To Set a Sample File Name for a Portrait or Signature Object 

1. Select the Portrait or Signature object you want to configure. 

I'~~rir~~il]

or 

iSignaturej 

2. On the Image Properties Panel Image Source tab, click E to choose a sample image file to display as a 
placeholder in the Badge Designer. A Windows File Selection dialog box appears. 

3. Choose an image file from the dialog box, then click Open. 

4. The image you chose is added to the badge layout as a sample image. 
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The Signature Properties Panel 

The C•CURE ID Signature Properties Panel lets you configure a signature object that you have added to the badge 
layout.Figure 36 on Page 178 shows the Signature Properties panel with the Image Source tab active. 

Figure 38: Signature Properties Panel 
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The following sections provide more information about the C•CURE ID Signature Properties Panel. 

• Accessing the C•CURE ID Signature Properties Panel on Page 178. 

• Signature Properties Panel Tasks on Page 179. 

Signature Properties Panel Tabs on Page 179. 

Accessing the C•CURE ID Signature Properties Panel 

Pertorin the following steps to access the C•CURE ID Signature Properties Panel. 

To Access the C•CURE ID Signature Properties Panel 

1. Open the C•CURE ID Badge Designer. 

2. Drag a Signature Object onto the Badge Layout using the Signature icon El, or select Insert>Signature from the 
menus, or select an existing signature object on the Badge Layout, and the Signature Properties Panel becomes 
active. 
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Figure 37: Click and Drag Icon to Create Signature Object 

Signature Properties Panel Tabs 

The Signature Properties Panel has the following tabs. 

• Image Source Tab on Page 167 describes the Image Source Tab. 

• Background Detection Tab on Page 169 describes the Background Detection Tab. 

• Properties Panel Background Color Tab on Page 155 describes the Background Color tab. 

• Properties Panel Borders Tab on Page 157 describes the Borders tab. 

• Color Management Tab on Page 170 describes the Color Management tab. 

You can click to scroll these tabs to the left or right. 

Signature Properties Panel Tasks 

From the C•CURE ID Signature Properties Panel, you can perform the following tasks: 

• Adding a Signature to a Badge on Page 144. 

• Setting Background Detection Properties on Page 172. 

• Setting Background Color for an Object on Page 173. 

• Adding a Border to an Object on Page 149. 

• Setting Color Management Properties on Page 174. 
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The Text Properties Panel 

The C•CURE ID Text Properties Panel lets you configure a text object that you have added to the badge layout. 

The panel has four tabs: 

• Text Properties Text Tab on Page 184 - lets you specify the text you want to display on the badge design, 
whether it is static text you type in, Dynamic Text from the personnel database, or the result of an expression you 
put together using the Expression builder. This tab also lets you determine the way the text is positioned. 

• Text Properties Font/Color Tab on Page 185 - lets you set the font for the text, and the foreground and 
background colors for the text. 

• Properties Panel Background Color Tab on Page 155 - lets you set the background color for the text object. 

• Properties Panel Borders Tab on Page 157 - lets you set the borders for the text object. 

Figure 38 on Page 180 shows the Text Properties panel. 

Figure 38: Text Properties Panel 

See Text Properties Panel Tasks on Page 180 for tasks you can perform using the Text Properties Panel. 

See Text Properties Text Tab on Page 184 for more information about the fields and buttons on the Text Properties 
panel. 

To Access the C•CURE ID Text Properties Panel 

1. Open the C•CURE ID Badge Designer (see Creating a Badge Layout on Page 132). 

2. Drag a Text Object onto the Badge Layout using the Text icon EL or select Insert>Text from the menus. 

The Text Properties Panel becomes active on the right side of the Badge Designer. 

Text Properties Panel Tasks 

You can perform the following tasks from the Text Properties panel. 
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• Adding Text to a Badge on Page 141. 

• Defining a Boolean Expression for a Text Object on Page 181. 

• Adding a Border to an Object on Page 149. 

• Setting Color and Font Properties for a Text Object on Page 182. 

• Setting the Text Background to Opaque or Transparent on Page 182. 

• Setting the Background Color of a Text Object on Page 183. 

• Rotating a Text Object on Page 183 

• Setting Justification for a Text Object on Page 184 

Defining a Boolean Expression for a Text Object 

The Expression Builder lets you combine one or more personnel database fields, functions, Boolean operators, and/or 
text strings so that you can control the text that is dynamically printed on each badge. The expression is evaluated at 
print time to determine what is printed or encoded on each badge. 

Example: 

You could create an expression that would print "Home Office" or Branch Office" on the badge, depending on 
the value of a database field, such as Facility Code. The expression could use an "Ur function to test the value 
of Facility Code, and print the appropriate text depending upon the value returned by the "IlF" function. 

See Using the Expression Builder on Page 197 for more information about adding expressions to a badge layout. 

To use the Expression Builder, you set the Dynamic Text field to "=" rather than an actual field name. This enables 
the Expr>> button so that you can open the Expression Builder to create an expression . 

To Define a Boolean Expression for a Text Object 

1. From the Text Properties panel Text tab, select Dynamic Text. 

2. Select "=" from the Dynamic Text drop-down list. 

3. Click Expr>>. 

The C•CURE ID Expression builder opens. 

4. Use the following functions to create an expression: 

• Database Fields to add a personnel database field to your expression. 

• Functions to add a function to your expression. 

• Operators to add an operator to your expression. 

• Text to add a text string to your expression. 

5. Click OK to add the expression to the Dynamic Text field, or select one of the following options: 

• Erase: to erase the expression you have built. 

• Undo: to remove the last value you have added to your expression. 
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. Test to validate the expression. 

• Cancel: to return to the C•CURE ID Text Properties panel without building an expression. 

Setting Color and Font Properties for a Text Object 

You can use the Font/Color tab of the Text Properties tab of the Badge Designer to change the appearance of a text 
object you have added to your badge design. 

To Set Font and Color Properties for a Text Object 

1. Select the text object in the Badge Layout panel you want to configure. 

2. On the Text Properties Panel, click the Font/Color tab. 

3. Use the Font drop-down list to select the font for your text. 

4. Use the Font Size drop-down to select the point size for your text. 

5. Click any of the following buttons to apply an attribute to the text: 

El Bold the text. 

Z Italicize the text. 

Underline the text. 

6. Set the color of the text by clicking the text color button A Windows color selection dialog box appears to let 

you select a color for the text. Pick a color and click OK. The color you selected is shown by the text color box • 
to the right of the text color button. 

7. If you want to change the vertical positioning of the text, click on Top a Middle 2, or Bottom E. 

8. If you want to change the horizontal positioning of the text, click on Left EL Center or Right E. 

9. If you want to change the angle that a text object is displayed, click on the Rotation spinner Click the up 
arrow to angle the text in a clockwise rotation, or click the down arrow to angle the text in a counterclockwise 
rotation. 

Setting the Text Background to Opaque or Transparent 

Perform the following steps to set the background of a text object to opaque (solid color, 0% transparency) or a 
percentage of transparency (objects and background beneath the text object on the badge are visible). 
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To Set the Text Background to Opaque or Transparent 

1. On the Text Properties Panel, click the Background Color tab. 

2. Use the slider e  in the Transparent field to change the degree of transparency for the text 
background, or type in a transparency percentage into the field. The higher you set the transparency percentage, 
the more the background color of the badge, or other objects on the badge, are visible behind the text object. 

Setting the Background Color of a Text Object 

Perform the following steps to set the background color of a text object. 

Note that if the text objects background (see Setting the Text Background to Opaque or Transparent on Page 182) is 
set to 100% Transparent, the background color will not be visible. To see the background color, choose a lower 
percentage of transparency for the text background. 

To Set the Background Color of a Text Object 

1. In the Badge Layout Panel, click on a Text Object to select it. 

2. Click the Background Color tab on the Text Properties Panel. 

3. Click the Background Color button El and a color selection dialog box appears. 

4. Click on the color you want to use and click OK. The Text Object background color is changed to the color you 
selected. 

5. You can use the Transparent field to set the percentage of transparency for the Text Object background color. 0% 
is opaque, while 100% is full transparency. 

6. You can also use a Gradient to blend two colors in the Text Object background. Pick a Gradient pattern from the 
Gradient drop-down list. 

7. If you want to blend a second color into the gradient (other than the default color white) , click the Blend Color 
button El and a color selection dialog box appears. 

8. Click on the color you want to use and click OK. The Gradient blend color is changed to the color you selected. 

9. Use the Blending Value spinner to change the amount of each color in the gradient. The default setting of 0 
results in a 50% blend of both colors. 

See the Properties Panel Background Color Tab on Page 155 for more information about using Background colors. 

Rotating a Text Object 

Perform the following steps to rotate a text object. 

NOTE 
You can rotate an object using the 0, 90,180, and 270 buttons on the Badge Layout Panel Toolbars on 
Page 139. 
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To Rotate a Text Object 

You can rotate the text within a Text Object (the object itself does not rotate). 

I . In the Badge Layout Panel, click on a Text Object to select it. 

2. In the Text Properties Font/Color tab, in the Rotation box, type in the angle of rotation you want for your text (or 
use the up and down buttons to set the angle). 

3. To reset the rotation angle to a previous setting, retype that setting. 

Setting Justification for a Text Object 

Perform the following steps to set the text justification for a text object. 

To Set Justification for a Text Object 

1. Select the text object you want to configure. 

2. On the Text Properties Panel, click the Font/Color tab. 

3. To set Vertical positioning of text within the text object, click one of the following: 

Fi  Text starts at the top of the text object. 

H Text starts at the middle of the text object. 

▪ Text starts at the bottom of the text object. 

4. To set horizontal positioning of the text within the text object, click one of the following: 

Text is aligned to the left border of the text object. 

IN Text is aligned in the center of the text object. 

  ▪ Text is aligned to the right border of the text object. 

Text Properties Text Tab 

The Text Properties Text tab lets you define static or 

dynamic text for a text object, and adjust settings for the text size and text wrapping. 
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■ Text Tab Definitions are provided in Table 50 on Page 185. 

■ Font/Color Tab Definitions are provided in Table 51 on Page 186. 

Text Tab Definitions 

The Text Properties Panel Text Tab has the following fields and buttons. 

Table 50: Text Properties Panel Text Tab Definitions 

Button/Field Description 

Static Text Select the Static Text button if you want to type in the text that appears in the text object. The text you type in appears on all 
badges printed using th is desig n. 

Dynamic Text Select the Dynamic Text button if you want to use a database field for the text object.You select a database field from the drop-
down list. You can choose"=' if you want to use the Expression Builder to create an expression to be evaluated. 

Exp» Button Click this button to open the Expression Builder. This button is available onty if you have chosen "=" from the Dynamic Text drop-
down list. 

Create Text 
as Graphic 

If selected, this choice causes the text object to be sent to the printer as a graphic image. This can produce a lower quality text 
image, but it may be necessary if the font for the text isnot supported by the badge printer. This setting can be changed 
individualty for all text objectson a badge design. 

Auto Sizing Auto Sizing provides four options for adjusting the size of the text. 

None - Text is not auto-sized. 

Flt Text to Control - Increasesor decreases the size of the text to the maximum size that can fit within the bordersof the text 
control. 

Fit Control to Text - Increasesor decreases the size of the control to match the current size of the text in the text object. 

Max Font Size -Allows the text to decrease in size to fit within the borders of the control, but does not allow the text size to 
increase larger than the current text size. 

Wrapping Wrapping provides two options for adjusting the appearance of the text. 

Disable Wrapping - Does not wrap text within the object. Text that is too long for the size of the text object is cropped unless 
you resize the text object. 

Enable Wrapping -Alows text to wrap at the border of the object, to better fit the text within the text object. If the text object is 
too small to fit the text even with wrapping on, the text iscropped unless you resize the text object. 

Text Properties Font/Color Tab 

The Text Properties Font/Color tab lets you set the font for the text, and the foreground and background colors for the 

text. You can also set the percentage of transparency for text, the justification (such as left-right and top-bottom) for 

text, and the degree of rotation for the text box. 

Font/Color Tab Definitions are provided in Table 51 on Page 186. 

Font/Color Tab Definitions 

The Text Properties Panel Font/Color Tab has the following fields and buttons. 
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Table 51: Text Properties Panel Font/Color Tab Fields and Buttons 

Button/Field Description 

Foreground These settings allow you to specify the style for the text: 

Font - Choose the font for the text object from the drop-down list of available fonts. 

Font Size - Choose the font size for the text object from the drop-down list. 

Bold - Toggle the bold attribute for the entire text object. 

Italic - Toggle the italic attribute for the entire text object. 

Underline - Toggle the underline attribute for the entire text object. 

Color- Click this button to pick the text color for the test object. When you select a color, it willbe visible in the color box to t•,: 
right of the Color button. 

Background These settings allow you to specify: 

Opaque - The text box has a colored background, with a default color of white. You can click the toolbar Fill Control 
Background Color button to change the color. 

Transparent - The text box is transparent: the background color for the badge shows through. 

Justification These settings allow you to specify justification for the text (positioning of the text within the text object). You can C1100 SC arty al 

the three vertical justdication settings: 

Top -Align the text to the top of the text object. 

Middle -Align the text to the middle of the text object. 

Bottom-Align the text to the bottom of the text object. 

You can choose of the three horizontal justification settings: 

Lett -Align the text to the left edge of the text object. 

Center -Align the text to the center of the text object. 

Right -Align the text to the right edge of the text object. 

Rotation You can set the degree of rotation for the text in the text object byclicking the spinner controlor typing in a number from 0 to 360 
degrees. This rotates the text itself. not the text box. 
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The Barcode Properties Panel 

The C•CURE ID Barcode Properties Panel lets you configure a barcode object that you have added to the badge 
layout. 

The Barcode Properties Panel, as shown in Figure 39 on Page 187 has two tabs: 

• Barcode Properties tab - used to add barcodes, which correspond to text fields, to a badge layout. See Barcode 
Properties Tab Definitions on Page 193. 

• Barcode Captions tab - used to add barcode captions, which provide readable text that can be placed above or 
below the barcode. See Barcode Captions Tab Definitions on Page 194. 

Figure 39: Barcode Properties Panel 
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The following sections provide more information about the C•CURE ID Barcode Properties Panel. 

• Barcode Overview on Page 189. 

• Accessing the Barcode Properties Panel on Page 187. 

• Setting Barcode Properties on Page 189. 

• Setting Barcode Caption Properties on Page 190. 

• Adding Static Text to a Barcode Caption on Page 191. 

• Adding Dynamic Text to a Barcode Caption on Page 191. 

• Barcode Properties Tab Definitions on Page 193. 

• Barcode Formats on Page 192. 

• Barcode Captions Tab Definitions on Page 194. 

Accessing the Barcode Properties Panel 

You use the Barcode Properties panel to configure barcode objects on you badge layout. You access the panel by 
selecting an existing barcode object, or by adding a new one. 
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To Access the Barcode Properties Panel: 

1. Open the C•CURE ID Badge Designer. See Creating a Badge Layout on Page 132. 

2. Select an existing barcode object on the badge layout, or drag a barcode object onto the Badge layout using the 

Barcode icon n, or select Insert>Barcode from the menus. The Barcode Properties Panel becomes active. 
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Barcode Overview 

You can add barcodes, which correspond to text fields, to a badge layout from the Insert menu (see Badge Designer 
Menus and Toolbars on Page 126) or from the Badge Layout Panel Toolbars on Page 139. Barcodes are like text 
fields, but require encoding (error correction, encryption). See Barcode Properties Tab Definitions on Page 193 for 
more information about Barcode fields. 

You can also add a barcode caption to the barcode, to provide readable text that can be placed above or below the 
barcode. The caption can be taken from any field in the personnel database, or it can be user-typed text. See Barcode 
Captions Tab Definitions on Page 194 for more information about Barcode caption fields. 

NOTE If the barcode caption is wider than the barcode itself, due to the length of the caption text or 
the size of the caption font, the caption may be clipped (not all text is visible). 

You can use the Wasp family of bar codes that are available as part of the C•CURE ID product. See Barcode Formats 
on Page 192 for more information about the barcode settings you can choose. 

Barcodes require the use of special readers; select the barcode font required by the reader you are using. Barcode 
readers look for encoded characters embedded within the text. They require these characters to know when to start 
and stop encoding and to provide additional encryption instructions. 

Check with bar code reader manufacturers to see which models are suitable for your application. Ensure that the 
application supports your barcode reader and printer before inserting barcodes on badges. 

Setting Barcode Properties 

From the C•CURE ID Barcode Properties Panel Barcode Properties tab, you can set the encoding method, data source, 
and appearance of barcodes on your badge layout. 

To Set Barcode Properties for a Barcode Object 

1. Select the barcode object you want to configure. 

2. Select the encoding method that you are using from the Symbology drop-down list. 

3. Select a data source from the Data Source drop-down List. 

C•CURE Personnel database field - If you want the contents of a database field to be printed on the badge as a 
barcode, select that field from the list. 

"=" - If you want to use the Expression Builder to create a boolean expression, chose "=" from the drop down 
list, and click Expr>> to open the Expression Builder. (See Expression Builder on Page 196 for more 
information.) 

5. Choose either Fit control to barcode or Position barcode within control. 

Fit control to barcode sizes the barcode background slightly larger than the barcode itself. You cannot change 
the size of the barcode background. 
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Position barcode within control lets you specify the position of the barcode within the background. You can 
change the size of the background by dragging the selection handles of the barcode object. You can use the 
buttons under this choice to position the barcode within the barcode object. 

6. Click IT to pick the color for the barcode. A color selection dialog box appears so that you can pick a color and 
click OK. 

7. Click El on the Badge Layout toolbar to pick the color for the barcode background. A color selection dialog box 
appears so that you can pick a color and click OK. If you chose Transparent as the background, the color you 
pick will not be visible. 

8. Configure the Bar Parameters by setting the Height of the barcode. Type in the number or use the up/down 
arrows to set the Height. 

9. Use the Magnification % drop-down list to pick a barcode magnification percentage, increasing or decreasing 
the size of the barcode on the badge. 

To Set Barcode Data Source Using the Expression Builder 

1. Add a barcode object to the badge design. 

2. Select the barcode object. 

3. In the Barcode Properties Panel, on the Barcode Properties tab, click in the Barcode Field drop-down. 

4. Select "=" from the drop-down to serve as the Data Source for the barcode object. This enables the Exp button. 

5. Click the Exp button to open the Expression Builder. 

6. Create an expression using the buttons on the Expression Builder. See Using the Expression Builder on Page 197 
for more information. 

Setting Barcode Caption Properties 

From the C•CURE ID Barcode Properties Panel Barcode Captions tab, you can set the data source and appearance for 
barcode captions on your badge layout. 

To Set Barcode Caption Properties for a Barcode Object 

I. Select the barcode object you want to configure. 

2. Click the Barcode Captions tab. 

3. Select Show Caption. The Barcode Caption fields appear. 

4. To add static text, select Static Text and type in the text you want to appear as the barcode for each badge. 

5. To add a personnel database field, select Dynamic Text and choose a database field from the drop-down list. 

6. Select a value for location of the barcode caption within the barcode object from the Placement drop-down list. 

NOTE 
If the barcode caption is wider than the barcode itself, due to the length of the caption text or 
the size of the caption font, the caption may be clipped (not all text is visible). 
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7. Choose the Font attributes for the barcode caption. Select the font from the Font drop-down list. Select the font 
size from Font Size drop-down list. Click the Bold, Italic, or Underlined buttons to apply that style to the caption 
text. 

8. Click Aki to choose a color for the barcode caption text. A color selection dialog box appears. Click on a color and 
click OK. 

Adding Static Text to a Barcode Caption 

You can add static text (text that is the same on each badge, such as a company name or a facility location) to a 
barcode caption. 

To Add Static Text to a Barcode Caption 

1. From the C•CURE ID Badge Designer, drag the Barcode icon onto the badge design area of the Badge Layout 
Panel, and drop it to create a Barcode object. 

2. Drag the barcode object with the mouse into position on the badge design, and use the sizing handles on the 
object to adjust its size. 

3. In the Barcode Properties Panel, on the Barcode Caption tab, select Show Caption. 

4. Click the Static Text radio button to select static text, and type in the text you want to appear in the barcode 
caption. 

5. Choose a position for the Barcode Caption from the Placement drop-down list. 

6. You can select Font Attributes for the caption by choosing from the Font drop-down list and the font size drop-
down list. You can also choose to add Bold, Italic, and underline attributes to the barcode caption by using the 
buttons for these attributes. 

7. You can use the Color selector to choose a color for the barcode caption. 

8. You can click the Save icon to save your changes, or continue editing the badge design and save your changes 
later. 

Adding Dynamic Text to a Barcode Caption 

You can add dynamic text (text that is contained in a database field in C•CURE ID, and is specific to each badge 
holder record; for example, Last_Name or Person_ID). C•CURE ID gets the data from the Personnel Database when 
you send a specific badge to print. 

To Add Dynamic Text to a Barcode Caption 

1. From the C•CURE ID Badge Designer, drag the Barcode icon onto the badge design area of the Badge layout 
Panel, and drop it to create a barcode object. 

2. Drag the barcode object with the mouse into position on the badge design, and use the sizing handles on the 
object to adjust its size. 

3. In the Barcode Properties Panel, on the Barcode Caption tab, click the Dynamic Text radio button to select 
dynamic text. 

C•CURE 9000 C•CURE ID User Guide Chapter 5 191 

EFTA01225068



Barcode Overview 

4. Chose a database field from the drop-down list. With each badge you print, the value of that field appears as the 
barcode caption. 

5. Choose a position for the Barcode Caption from the Placement drop-down list. 

6. You can select Font Attributes for the caption by choosing from the Font drop-down list and the font size drop-
down list. You can also choose to add Bold, Italic. and underline attributes to the barcode caption by using the 
buttons for these attributes. 

7. You can use the Color selector to choose a color for the barcode caption. 

8. You can click the Save icon to save your change, or continue editing the badge deign and save your change 
later. 

Barcode Formats 

This table outline the barcode options selectable in the Symbology field on the Barcode Properties Panel in C•CURE 
ID, describing the format and requirements of each format. If a barcode is listed as numeric only, you will get an 
error message if you use it with an alphanumeric database field or text string. 

Table 52: Barcode Formats 

Barcode Data Format/Comments 

Alphanumeric. 

Provides Code 39 with extended 128 character symbology (ful ASC II) by combining one of the special characters (adreiff, 
/A, •) with a letter (A•Z) to form the characters that are not present ri the standard Code 39. 

Example: 

In standard Code 39 a lowercase "am cannot be represented. In Code 39 FuNASCII, however," a" is represented as 
"W. 

Wasp 3 of 9/Check Alphanumeric. 

Provides Code 39 with extended 128 character symbology (ful ASC I l), including a calculated checksum to increase data 
integrity. 

Wasp Code128 Alphanumeric. 

Code 128 isa high-density alphanumeric bar code. It has 106 different diaracters. You can encode the entre ASCII 
character set, induding controlcharacters. 

Wasp 
Code128/Check 

Alphanumeric. 

Provides Code128 with a calculated cheasum to increase data integrity. 

Wasp 
Code128C/Ched< 

Numericonty. 

Provides Code128 subset C with a calculated checksum to increase data integrity. 

Wasp Code93 Alphanumeric 

Code93 isa more compact version of Code39. It encodes the same charactersasCode39, but uses9 barcode elements 
per character instead of 15. 

Wasp 12of5 Numericonty. 

Interleaved 2 of 5 isa numeric-only barcode. Adjacent charaders are interleaved, alternating the spaces from one character 
with the bars of the other. Interleaved 2 of 5 REQUIRES an EVEN number of digits, because digits are paired. 
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Barcode Formats (continued) 

Barcode Data Format/Comments 

Wasp12of5/Check Numericonty. 

Provides Interleaved 2 of 5 with a calculated checksum to increase data integrity. 

Wasp Codabar Numericonty. 

Codabar can encode thedigits° through 9. six symbols (-:fid4e79/+), and the start/stop charactersA. B. C. D. E.'. N, or T. 
The start/stop characters must be used in matching pairs and may not appear elsewhere in the barcode. 

Wasp 
Codabar/Check 

Numericonty. 

Provides Codabar encoding with a calculated checksum to increase data integrity. 

PDF417 PDF417 is a very high-density 2D barcode format that can encode both text and numbers. 

Barcode Properties Tab Definitions 

The Barcode Properties Panel Barcode Properties Tab has the following fields and buttons. 

Table 53: Barcode Properties Tab Definitions 

Name Description 

Symbology This drop-down list lets you pick the Symbology to be used when generating the barcode. C•CURE ID onty su pports WASP 
Baroodes and the PDF 417 2D barcode. The available choices are: 

Wasp 3019 

Wasp 30(9/Check 

Wasp Code128 

Wasp Code128/Check 

Wasp Code128C 

Wasp Code128C/Check 

Wasp Code93 

Wasp '2015 

Wasp '2015/Check 

Wasp Codabar 

Wasp Codabar/Check 

PDF417 

See Table 52 on Page 192 for more information about the available barcode formats. 

Data Source This drop-down list lets you select the personnel field to be used when generating the barcode.Alternativety. you can select 
the "=" value to enable the Expression Builder (Exp») button. 

Exp Click this button to use the Expression builder dialog box to create a boolean expression for the barcode contents. This is 
useful for concatenating multiple database fields into one. 

Fit control to 
barcode 

Click to size the barcode background sbghtty larger than the barcode itself. You cannot change the size of the barcode 
background. 

C•CURE 9000 C•CURE ID User Guide Chapter 5 193 

EFTA01225070



Barcode Overview 

Barcode Properties Tab Definitions (continued) 

Name Description 

Position barcode 
within control 

Lets you specify the position of the barcode within the background. You can change the size of the background bydragging 
the selection handles of the barcode object. 

You can use the alignment buttons under thischoice to position the barcode within the barcode object. 

.. ...1 .., 
,.. 

. 

..... a., 
These barcode alignment buttons albw you to position the barcode within the barcode background. You can choose Top. 
Middle or Bottom vertical positioning. and Left. Right. and Center horizontal positioning. 

Barcode Color Click to open a Color Selection dialog box to select the color to be applied to the Barcode. The Default Value is Black. 

Height Set the height of the barcode, from 0- 200. The Default value is 30. 

Magnification% Select a magnification level for the barcode. Select from the following magnifications: 

10%. 20%. 25%. 50%. 75%.100% (Default Value). 150%. 200%. 400%. 

Barcode Captions Tab Definitions 

The Barcode Caption tab is used to add barcode captions, which provide readable text that can be placed above or 

below the barcode. 

The Barcode Properties Panel Barcode Captions Tab has the following fields and buttons. 

Table 54: Barcode Captions Tab Definitions 

Name Description 

Show 
Caption 

Select the Show Caption checkbox to enable all properties on the Barcode Caption Tab. The caption is a usually a text d splay of 
the same field as the barcode. but you canals° use another field or an expression. 

Static Text Enables the Static Text Edit Box, which allows you to type in alpha-numericcharactersasa baroode caption.The text you type in 
will appear on all badges printed using this design. 

Dynamic 
Text 

Enables the Dynamic Text drop-down List that provides a list of database fields. Typically you would choose the same database 
field that is being used for the barcode. 

You can choose"=" to define a boolean expression using the Expression Builder. 

Expr» Launches the Expression builder dialog box if the Dynamic Text drop-down list is equal to"=". 

Placement Allows you to select the following placement settings for the barcode caption relative to the barcode: Off. Below Left, Below Center, 
Below Right, Above left. Above Center, Above Right. 

Color Click to select the color for the barcode caption font. Opens a standard Windows Color Selection Dialog box.The color you select is 
displayed in the box to the right of the Color button. 

Font Provides a drop-down list of available fonts from Windows and allows you to assign a font to the barcode caption for display/print. 

Font Size Allows you to select the Font size to be used for the barcode caption from a drop-down list. 
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Barcode Captions Tab Definitions (continued) 

Name Description 

Bold Allows you to toggle the Bold attribute on and off for the barcode caption. 

Italic Albws you to toggle the Italicattribute on and off for the barcode caption. 

Underline Allows you to toggle the Underline attribute on and off for the barcode caption. 
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Expression Builder 

The Expression Builder lets you create a statement that combines one or more personnel database fields, functions, 
Boolean operators, and/or text strings. This statement is then evaluated at print time to determine what is printed or 
encoded on a badge. 

Example: 

If you want to print the first name, middle initial, and last name of personnel on each badge, rather than setting 
up three separate text fields on the badge, you can create one text field and define an expression that combines 
the three fields, with spacing that adjusts to the length of each field (so the space between a short first name and 
the middle initial would be the same as the space between a long first name and the middle initial, for example). 

For more information about expressions, see: 

• What is an Expression? on Page 197. 

• Using the Expression Builder on Page 197. 

You can use the Expression Builder from the following panels when: 

• Adding Text to a Badge on Page 141 using the C•CURE ID Text Properties Panel. 

• Adding a Barcode to a Badge on Page 142 using the C•CURE ID Barcode Properties Panel (Barcode Captions 
tab). 

• Adding Magnetic Tracks to a Badge Layout on Page 161 using the C•CURE ID Badge Properties Panel (Mag 
Encoding Options tab). 

To use the Expression Builder, you set the Dynamic Text field to "=" rather than an actual field name. This enables 
the Expr button so that you can open the Expression Builder, shown in Figure 40 on Page 196. 

Figure 40: Expression Builder Dialog Box 
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■ For definitions of the fields and buttons on the Expression Builder, see Expression Builder Definitions on Page 
199. 

■ Expression Builder Functions on Page 200 defines the Expression Builder functions. 

■ Expression Builder Operators on Page 204 defines the Expression Builder operators. 
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• Sample Expressions on Page 207 provides examples of using the Expression Builder to construct some useful 
expressions. 

What is an Expression? 

An expression is a combination of personnel database fields, functions, Boolean operators, and/or text strings that 
C•CURE ID can resolve to a text value that can be placed on a badge when it is printed. Fields and text string define 
the text element, and functions and operators evaluate and modify the text to achieve a result. 

Example: 

[First Namel&" "&[Middle Namel&". "&[Last Name] 

[First Name],[Middle Name], and [Last Name] are database fields. Database fields must be enclosed in square 
brackets. When C•CURE ID resolves this expression, it gets the values for these fields from the Personnel record 
of the badge that was sent to print. 

& is an operator that is used to concatenate text and database fields. 

represents a space between fields. Typed text such as spaces are enclosed in double quotes. 

". " represents a period and a space. 

You can test an expression like this by clicking the Expression Builder Test button. This expression would 
evaluate to the cardholder's name, for example: 

Tommy T. Thomas 

NOTE 
Double quotes are used to delineate text in expressions. You cannot include a double-
quote character within an expression as a printable character. Use two single quote 
characters (") if you want your expression to print a double quote on the badge. 

Using the Expression Builder 

You can perform the following tasks with the Expression Builder. 

• Adding a Database Field on Page 198. 

• Adding a Function on Page 198. 

• Adding an Operator on Page 198. 

• Adding Text on Page 198. 

• Testing the Expression on Page 199. 

• Erasing the Expression on Page 199. 

• Undoing an Entry on Page 199. 

• Redoing the Most Recent Entry on Page 199. 
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Adding a Database Field 

To Add a Database Field 

1. Position the cursor in the Developed Expression field at the place where you want to add a database field. 

2. Click Database Fields. 

3. Select a database field from the Database Fields drop-down list. 

4. Click Add to add the field to the expression. 

Adding a Function 

To Add a Function 

1. Position the cursor in the Developed Expression field at the place where you want to add a function. 

2. Click Functions. 

3. Select the function you wish to add from the Functions drop-down list. 

4. Click Add to add the function to the expression. 

5. Most functions have parameters that you need to fill in. Fill in the parameters for the functions between the 
"("and ")". See Expression Builder Functions on Page 201 for a list of the functions and their parameters. 

Adding an Operator 

To Add an Operator 

1. Position the cursor in the Developed Expression field at the place where you want to add an operator. 

2. Click Operators. 

3. Select the operator you wish to add from the Operators drop-down list. 

4. Click Add to add the operator to the expression. 

5. See Expression Builder Operators on Page 204 for a list of the operators and their functions. 

Adding Text 

To Add Text 

L Position the cursor in the Developed Expression field at the place where you want to add text. 

2. Click Text. 

3. Type the text you wish to add into the Additional Text field. 

4. Click Add to add the text to the expression. 
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Testing the Expression 

To Test the Expression 

1. Click Test. 

2. A dialog box appears displaying the results of the expression as it would be printed on the badge, using the 
values in Sample Data. (See Badge Layout Panel Toolbars on Page 139 for more information.) 

3. If the expression is invalid, a dialog box appears to explain why the expression is invalid. 

Erasing the Expression 

To Erase the Expression 

1. Click Erase. 

2. The entire expression is deleted. This function can be used on subsequent edits of the expression. 

Undoing an Entry 

To Undo an Entry 

1. Click Undo. 

2. The most recent addition to the expression is deleted. 

3. You can click Undo multiple times to undo entries. 

Redoing the Most Recent Entry 

To Redo the Most Recent Entry 

1. Click Redo to recover an entry lost because you clicked Undo. (Redo is only available after you have clicked 
Undo one or more times.) 

2. You can click Redo multiple times to recover entries that were erased by Undo. 

Expression Builder Definitions 

The Expression Builder dialog box (see Figure 40 on Page 196) contains the following fields and buttons. 

Table SS: Expression Builder Fieldsand Buttons 

Button/Field Description 

Developed 
Lxpression 

You can create an expression for C•CURE ID to evaluate when putting together a badge. You can use a developed expression 
in place of a database field with baroodes, text, and magnetic tracks. 
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Button/Field Description 

Database 
Fields 

Allows you to add database fields to the Expression. 

Erase Erases the currently displayed Developed Expression. 

Functions Allows you to add functions to the expression. 

Undo Use this button to undo, in reverse order, changes made to the developed expression. If you add an operator and a database 
field, clicking Undo twice would delete the database field fit then the operator. 

Operators Allows you to add Boolean and mathematical operators to the expression. 

Redo Click this button to restore expression elements that you deleted using Undo. 

Text Lets you add static text to the expression. 

Test Lets you test the expression. A dialog box appears displaying the text resulting from the expression, as rt would appear on the 
badge. If the expression is invalid, a dialog box appears to describe the problem. 

Help Launches online help for the Expression Builder. 

OK Validates the developed expression, assigns the expression to the appropriate field in the panel that opened the Expression 
Builder, and closes the Expression Builder. 

Cancel Cancels any changes to the developed expression and closes the Expression Builder. 

Expression Builder Functions 

Expression Builder functions provide commands that can filter, format, and change text to achieve a result. You can 
use these functions whenever static text or field values direct from the Personnel database do not meet the need. 

You can also perform binary (BF) tests on database field values and print differing text on the badge as a result. 

For example, you can use IT to test whether a field (such as [Middle NameD is blank or not, and print the field plus 
a space if a middle initial is present, or print just a single blank space if the field is empty. 

See Expression Builder Functions on Page 201 for a list of the functions and their definitions. 

For examples of the use of these Functions, see Sample Expressions on Page 207. 

To Add a Function 

Perform the following steps to add a function to an expression in the Expression Builder. 

1. Position the cursor in the Developed Expression field at the place where you want to add a Function. 

2. Click Add Function. in the Expression Builder dialog box. 

3. Select a function from the Add Expression drop-down list. See Expression Builder Functions on Page 201 for 
more information about the functions you can choose. 

4. Click Add to add the function to the expression. 
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Expression Builder Functions 

Expression Builder functions provide commands that can filter, format, and change text to achieve a result. You can 

use these functions whenever static text or field values direct from the Personnel database do not meet your need. 

You can also perform binary (119 tests on database field values and print differing text on the badge as a result. 

Table 56: Expression Builder Functions 

Function Example Result Description 

FORMATL FORMATL ((Card #1. 
0000000000) 

If Card It = 
'12345' 

Result 
=1234500000 

This argument "pads" the specified database field with the 
'mask' supplied after the comma. 

In this example, 10 zeros is the"mask," meaning the Card # 
field must have 10 characters. If the Card # field contains less 
than 10 characters, zeros will be added to the right of the 
data until there are a total of 10 characters. If the Card # is 
or iginalty"12345," the example above would result in: 
"1234500000" 12345=actualdata 0000000000=mask" 
1234500000=final result. 

FORMATR FORMATR ((Card #I, 
0000000000) 

If Card 0 = 
'12345' 

Result 
3000012345 

This arg ument" pads" the specified database field with the 
"mask" supplied after the comma. 

In this example, 10 zeros is the"mask," meaning the Card # 
field must have 10 characters; if the Card # field contains less 
than 10 characters, zeros wifi be added to the left of the data 
until there are a total of 10 characters. If the Card # is 
originalty"12345," the example above would result in: 
"0000012345" 12345=actual data 0000000000=mask" 
0000012345=final result. 

III IIF ((Middle Namel=". 
IF irst_Namel  B"8 (Last_ 
Name], IF irst_Namel 8- '8 
(Middle Name I 8' "8 (Last_ 
Name]) 

(Middle 
Named="". 
(FirstNamel 
="Jones", 
IF irst_Namel 
="Homer" 

Result= 
"Homer 
Jones" 

This"4" statement reads: IF the field "(Middle Namer is 
empty. THEN insert the contents of the IF irst_Namel field 
PLUS a blank space PLUS thecontentsof the (Last_Namel 
field, OTHERWISE insert the contents of the IF irst_Namel 
field PLUS a blank space PLUS the contents of the (Middle 
Name] field PLUS a blank space PLUS the contents of the 
(Last_Namel field. 

LCASE LCASE (ILast_Namel) (Last Named 
= Jones 

Result = jones 

This argument reads: Convert thecontentsof the (Last_ 
Name] field to lower case letters. If the last name isJones, 
the result is: Jones. 

LEFT LEFT ((Last_Na me]. 2) ILast_Namel 
=Jones 

Result =Jo 

This argument reads: Get the first two letters from the left 
side of the contents of the (Last_Namel field. If the last name 
isJones, the result is: Jo. 

LEN LEN ((Last_Namel) (Last_Named 
=Johnson 

Result = 7 

This argument reads: Return the length of the (Last_Name] 
field. If the last name isJohnson, the result is: 7 
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Expression Builder F unctions (continued) 

Function Example Result Description 

MID MID ((Last_Namel, 2,3) (Last_Name] 
=Johnson 

Result = hns 

This argument reads: Beginning after the second letter, get 
the next three lettersfrom the contents of the (Last_Name] 
field. If the last name isJohnson, the result is: has 

REVERSE Reverse (ILast_Namel) (Last_Name] 
= Johnson 

Result= 
noshnsoJ 

This argument reads: Reverse the contents of the (Last_ 
Name] field. If the last name isJohnson, the result is: 
nosnhoJ. 

RIGHT Example: RIGHT ((Last_ 
Name], 2) 

(Last_Name] 
=Johnson 

Result =on 

This argument reads: Get the last two letters from the right 
side of the contents of the (Last_Name] field. If the last name 
isJohnson, the result is: on. 

RIGHT Example; RIGHT ((Last_ 
Name], 2) 

(Last_Name] 
=Johnson 

Result = no 

This argument reads: Get the last two letters from the right 
side of the contents of the (Last_Name] field. If the last name 
isJohnson, the result is: on. 

TRIM Example; TRIM ((Last_ 
Name]) 

(Last_Name] 
="Johnson " 

Result= 
"Johnson" 

This argument reads: Remove all leading and trailing non-
printing characters from the contents of the (Last_Name] 
field (spaces, tabs, returns, etc.). If a database editor 
inadvertentty entered a 'carriage return' after the last name. 
the TRIM command would remove it. 

UCASE Example; UCASE ((Last_ 
Name]) 

(Last Name] 
=Jones 

Result= 
JONES 

This argument reads as folows: Convert the contents of the 
II-ast_Namel field to upper case letters. If the last name is 
Jones, the result is: JONES. 

GETMONTHNAME GETMONTHNAME 
((Integer]) 

December This argument outputs the month name that corresponds to 
the integer that you input. Months are numbered from 1-12 
(January- December). Input numbers less than 1 and 
greater than 12 result in an empty string. For example, if you 
input 12, the output is December. 

GETMONTHNAME GETMONTHNAME 
((Integer]) 

December This argument outputs the month name that corresponds to 
the integer that you input. Months are numbered from 1-12 
(January- December). Input numbers less than 1 and 
greater than 12 result in an empty string. For example, if you 
input 12. the output is December. 

GETMONTHNAMEABBREV GETMONTHNAMEABBREV 
((Integer]) 

Dee This argument outputs the month name abbreviation that 
corresponds to the integer that you input. Months are 
numbered from 1-12 (Jan - Dec). Input numbers less than 1 
and greater than 12 result in an empty string. For example, if 
you input 12, the output is Dec. 

YEAR YEAR() 2007 This argument returns the current year in four digit format, 
based on the system date for today. If the current year is 
2007, the result is 2007. 
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Expression Builder F unctions (continued) 

Function Example Result Description 

YEARTWODIGIT YEARTWODIGIT () 07 This argument returns the current year in two digit format, 
based on the system date for today. If the current year is 
2007, the result is 07. 

MONTHNAME MONTHNAME () September This argument returns the name of the current month, 
based on the system date for today. If the current month is 
September. the result isSeptember. 

MONTHNAMEABBREV MONTHNAMEABBREV() Sep This argument returns the abbreviated name of the current 
month, based on the system date for today. If the current 
month is September, the result is Sep. 

MONTHNUMERIC MONTHNUMERIC() 9 This argument returns the number of the current month, 
based on the system date for today. Months are numbered 
from 1-12 (January- December). If the current month is 
September, the result is 9. 

DAY DAY() 13 This argument returns the number of the current day, based 
on the system date for today. Days are numbered from 1-31. 
If the current day is September 13. the result is 13. 

WEEKDAY WEEKDAY() Wednesday This argument returns the weekday name of the current 
day, based on the system date for today. If the current day is 
Wednesday, the result is Wednesday. 

WEEKDAYABBREV WEEKDAYABBREV() Wed This argument returns the abbreviation for the weekday 
name of the current day, based on the system date for today. 
If the current day is Wednesday, the result is Wed. 

HOUR HOUR() 9 This argument returns the number of the current hour. 
based on the system time. The hours are numbered from 1 -
12. If the current time is 9:30 AM. the result is 9. 

HOURTWENTYFOUR HOURTWENTYFOUR() This argument returns the number of the current hour, 
based on the system time, using a twenty-four hour time. 
The hours are numbered from 0 - 23. If the current time is 
9:30 PM, the result is 21. 

MINUTE MINUTED This argument returns the number of the current minute, 
based on the system time, The minutes are numbered from 
0 - 59. If the current time is 9:30:01 , the result is 30. 

SECOND SECOND() This argument returns the number of the current second, 
based on the system time, The seconds are numbered from 
0 - 59. If the current time is 9:30:17, the result is 17. 
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Expression Builder Functions (continued) 

Function Example Result Description 

GET_ASCII_CHAR GET_ASCII_CHAR(value) Takes a hex or decimal number input and returns the raw 
ASCII character for that value. Can be used to embed 
ASCII characters in a llamado expression. 

Example: 

GET_ASCII_CHAR(0x01 ) &GET_ASCII_CHAR(0x7f ) 
& [Cardin &GET_ASCII_CHAR(0x0D ) & GET_ 
ASCII_CHAR(0x0A ) 

Returns: 

CtrIA DEL <Card t! data> Carriage Return LineFeed 

Expression Builder Operators 

Expression Builder operators provide mathematical and boolean calculations that can concatenate and evaluate text 
and numbers in database fields to achieve a result. 

You can use these operators whenever static text or field values direct from the Personnel database do not meet the 
need. 

Example: 

You can use AND in conjunction with an BF function to test whether the values of two fields are (or are not) 
specific values, and use the result to determine what to print on the badge. 

For examples of the use of these operators, see Sample Expressions on Page 207. 

To Add an Operator 

Perform the following steps to add an operator to an expression in the Expression Builder. 

1. Position the cursor in the Developed Expression field at the place where you want to add an Operator. 

2. Click Add Operator. 

3. Select a function from the Add Expression drop-down list. See Expression Builder Operators on Page 205 for 
more information about the operators you can choose. 

4. Click Add to add the operator to the expression. 
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Expression Builder Operators 

Table 57: Expression Builder Operators 

Operator Description 

% The mod operator returns the remainder of a division operation. 

25%2 results in: 1 

10%3 results in: 1 

8 The ampersand operator is used to concatenate values. 

llastnamel 8'. ' 8 Ifirstnamel results in: Smith. John 

The equals operator mea ns"eq ual to". [Personnel Type] = "Contractor" Use this in an 'IIF' statement. 

Example: 

IIF ((Personnel Type] = 'Contractor ", " Contract', ") 

This example says, "If the employee type field contains the text "Contractor," then insert the word "Contract" on the badge. 
Otherwise, dont do anything. 

The plus sign operator adds numbers. 

10 +5 results in: 15 

/ The forward slash operator divides numbers. 

10/2 results in: 5 

The minus sign operator subtracts number. 

10 - 5 results in: 5 

• The asterisk sign operator multiplies numbers 

10'5 results in: 50 

The comma operator separates statements. Note the commas in the following expression: 

IIF (argument. do if true. do if false) 

< The less than" sign is a Boolean function returning a lrue (1 )* or 'false (0)* value. WackyCode} <•4" results in a True or "1" if the 
record's badge site code was less than four. Use this in an "IlF" statement. 

Example: 

IIF ((Facility Code] < "4", ",'Off Campus.") 

This example would do nothing if the badge site code was less than four; otherwise, the text 'Off Campus.' would be displayed on 
the badge. 

<, This means 'not equal tom and is a Boolean function returning a 'true (1)' or 'false (Or value. 

Example: 

[Middle Name] 0" IIF (Middle] 0 ", (First Name] 8"  81Middle Name] 8 ' '8 [Last Name], [First Name] 8 ' '8 [Last Name]) 

Use this in an 'IIF' statement. 

This example says, "If the middle name does not equal nothing «two quotes with nothing between them represents 'nothing"», 
that is. if the middle name field contains something. then add the first name, middle name and last name. Otherwise, if the middle 
name field is empty. use the first name with last name only. 
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Expression Builder Operators (continued) 

Operator Description 

The 'greater than' sign is a Boolean function returning a 'true (1 r or 'false (Or value. ISite_Codel >'4' results in a True or '1 ' if the 
record's badge site code was more than four Use this in an NIP statement. 

Example: 

IIF (IF acikty Code) >'4', •', 'On Site:) 

This example would do nothing if the badge site code was less than four; otherwise, the text •On Site.• would be displayed on the 
badge 

AND Use AND when you want a query to satisfy more than one argument. Individual arguments must be enclosed within parentheses. 
The AND operator is used with IIF statements. 

Example: 

IIF (Facility Code) ='5' AND [Personnel Type] = 'Contractor, 'Building 5 Contractor, —) 

This states, 'tithe individual has a site code of '5 and also is an employee type of the 'Contractor, then print the words" Building 5 
Contractor on the badge. Otherwise, don't print anything 

OR Use OR when you want a query to satisfy onty one part of an argument. Individual arguments must be enclosed within parentheses. 
The OR operator is used with IIF statements. 

Example: 

IIF (Facility Code) ='5' OR [Personnel Type] = 'Contractor, 'Access Limited', —) 

This states, 'if the individual has a site code of •5 or is an employee type of •Contractor', then print the words 'Access Limited' on the 
badge. Otherwise, don't print anything. 
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Sample Expressions 

This topic shows some examples of how the Expression Builder can be used to customize data that you want to 
appear on the badge layout. This can be useful if you want to use encode data, but the database does not store the 
data in a way that is compatible with the encoding. For example, some barcode formats can not encode dates 
formatted with delineating characters such as "I" or "-". Or you may want to display a first initial in the 
cardholder's name, but there is no First Initial field in the database. 

• Concatenating Fields on Page 207 

• Proper Case Name on Page 207 

• Proper Case Name with Optional Middle Initial on Page 208 

• Date Formatting with 4-Number Year on Page 208 

• Date Formatting with 2-Number Year on Page 208 

• Date Formatting with MM/DD/YY Format on Page 208 

• Date Formatting with MM/DD/YYYY Format on Page 209 

Concatenating Fields 

One of the most common uses of the Expression Builder is to concatenate database fields so that they can be 
displayed on a badge as a single entity. Displaying the fields separately on the badge can result in uneven spacing, 
for example, in a person's name (three separate fields for first, middle, and last name, often with a short first name 
and a large blank space). 

Combining the fields with Expression Builder produces a more professional result. This example outputs a person's 
first name, middle initial followed by a period, and last name as if they were a single database field, also simplifying 
the badge layout. 

Example: 

[First Name] 8r " "& [Middle Name] & ". "& [Last Name] 

Proper Case Name 

Sometimes a large Personnel database can have inconsistently entered data. Some name fields might be all 
uppercase, others may be proper case, and others may be lowercase. Finding and normalizing the name entries in a 
database can be costly and time consuming. You can use the Expression Builder to ensure that the names on your 
badges are consistently capitalized. 

In this example, the UCASE function is used to capitalize the first letter of the first and last names, using MID to 
select just the first character. The rest of the name is rendered in lowercase by LCASE, using MID to select all but the 
first character (starting at position 1, with a LEN -1). 

This expression would render BILL SMITH, bill smith, Bill smith, or BiLl SMitH as "Bill Smith". 

Example: 

UCASE(MID([First Name],0,1)) & LCASE(MID ([First Name],1,(LEN([First Name])-1))) & " " & UCASE(MID([Last 
Name],0,1)) & LCASE(MID ([Last Name],1,(LEN([Last Name])-1))) 
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Proper Case Name with Optional Middle Initial 

The middle initial can also cause problems with Badge appearance. Not all people have a middle initial, or that data 
might be missing from the database. The expression below checks for the existence of a middle initial, and spaces the 
name properly if the middle initial is present (or not). 

In this expression, the names are rendered in proper case as in the previous example, but an IIF function is used to 
determine how to handle the middle initial. If the Middle Name field is not blank, it is rendered in uppercase with a 
leading and following space, with a period if present (i.e., " T. "), but if it is empty, only one space is used to separate 
the first and last names. 

Example: 

UCASE(MID([First Name],0,1)) & LCASE(MID ([First Name],1,(LEN([First Name])-1))) & IlF([Middle Name]="", ," 
" Sr UCASE([Middle NameD) & IIF([Middle Name]=""," ",I1F(RIGHT([Middle Name],1)=".", " ", ". ")) & UCASE 
(MID([Last Name],0,1)) & LCASE(MID ([Last Name],1,(LEN([Last NameD-1))) 

Date Formatting with 4-Number Year 

The Expression Builder can also be used to customize the way dates are presented on the badge layout. This 
example formats a date as eight characters with no delineating characters. This can be useful for encoding a date in 
a barcode format that does not allow non-alphanumeric characters. This example outputs the Expiration date as 
either mmddyyyy or ddmmyyyy, depending on how your date format is configured. 

In this example, MID is used to extract the date numbers (starting at position 0 for 2 numbers, position 3 for 2 
numbers, and position 6 for 4 numbers), while discarding the separators. "01/01/2006" is thus rendered as 
"0101200W. 

Example: 

MID( [Expiration Date Time] ,0 ,2 ) & MID( [Expiration Date Time] ,2 ) & MID( [Expiration Date Time] ,6 ,4 ) 

Date Formatting with 2-Number Year 

This example outputs the Expiration date as either mmddyy or ddmmyy, depending on how your date format is 
configured. 

In this example, MID is used to extract the date numbers (starting at position 0 for 2 numbers, position 3 for 2 
numbers, and position 8 for 2 numbers), while discarding the separators. "01/01/2006" is thus rendered as "010106". 

Example: 

MID( [Expiration Date Time] ,0 ,2) Sr MID( [Expiration Date Time] ,3 ,2) Sr MID( [Expiration Date Time] ,8 ,2) 

Date Formatting with MM/DDNY Format 

This example outputs the Expiration date as either mm/dd/yy or dd/mm/yy, depending on how your date format 
is configured. 
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In this example, MID is used to extract the date numbers (starting at position 0 for 2 numbers, position 3 for 2 
numbers, and position 8 for 2 numbers), while discarding the separators. The character "I" is used as the date 
separator, so "01/01/2006" is thus rendered as "01/01/06". If "-" were used, "01-01-06" would be the result. 

Example: 

MID( [Expiration Date Time] ,0 ,2) & "I" & MID( [Expiration Date Time] ,3 ,2) & & MID( [Expiration Date 
Time] ,8 ,2) 

Date Formatting with MM/DDNYYY Format 

This example outputs the Expiration date as either mm/dd/yyyy or dd/mm/yyyy, depending on how your date 
format is configured. 

In this example, MID is used to extract the date numbers (starting at position 0 for 2 numbers, position 3 for 2 
numbers, and position 6 for 4 numbers), while discarding the separators. The character "I" is used as the date 
separator, so "01/01/2006" is thus rendered as "01/01/200W. If "-" were used, "01-01-2006" would be the result. 

Example: 

MID( [Expiration Date Time] ,0 ,2) & "I" & MID( [Expiration Date Time] A ,2) & "/" & MID( [Expiration Date 
Time] ,6 A) 
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6 

Creating Badges for Personnel 

This chapter describes the way Personnel records are used with the badging functions of the Badging Station. For 
information on creating and editing a personnel record, see the C•CURE 9000Personnel Cori figuration Guide. 

When you are working with personnel records, you can assign a badge layout to a personnel record, take a picture, 
signature, or biometric reading and associate it with a personnel record, display the image associated with a 
personnel record, and print a badge. 

In this chapter 

Personnel Badging 212 
Accessing Personnel Badging 213 
Taking Portrait Pictures  218 
Taking Pictures with a TWAIN Device 219 
Taking Signatures Using Signature Devices  223 
Importing Existing Portraits or Signatures  225 
Enrolling Fingerprints  227 
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Personnel Badging 

After you have designed a badge layout, you can create badges for personnel in your C•CURE personnel database 
from the Personnel Record Badging tab. 

Badging (and Imaging) functions for a Personnel record consist of specifying a Badge Layout for a Credential, 
configuring badge images, optionally enrolling fingerprints, and configuring, previewing, and printing the badge(s). 

From the Badging tab of the Personnel record, you can: 

• Access Personnel Badging functions - see Accessing Personnel Badging on Page 213. 

• Specify a Badge Layout for this Personnel record - see Assigning a Badge Layout on Page 217. 

• Take a Picture - see Taking Portrait Pictures on Page 218. 

• Take a Signature - see Taking Signatures Using Signature Devices on Page 223 

• Take (Encode) a Fingerprint - see Enrolling Fingerprints on Page 227. 

• Preview the badge - see Previewing a Badge on Page 235. 

• Print the Badge - see Printing a Badge on Page 236. 

• Enroll/Program a Smart Card (if you have configured Smart Card settings; refer to The Smart Card Petxess on 
Page 88) - see Using the Enroll/Program Smart Card Button on Page 251. 
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Accessing Personnel Badging 

To access Personnel badging, you can use either Personnel, Quick Search, or Advanced Search from the C•CURE 
9000 Administration application Personnel Pane, or Query from the Configuration Pane. 

The Personnel Dynamic View displays a list of all Personnel records. If you have a large database, you can usually 
get quicker results by using Quick Search to filter the database to show just the records you want to view. 

You can also use Advanced Search to create a Query if you need to do a complex search, or if you expect to want to 
repeat the search more than occasionally. 

Once you have created a Query using Advanced Search, you can access it from Advanced Search or from Query in 
the Configuration Pane. 

• Accessing Badging from the Personnel Dynamic View on Page 213. 

• Using Quick Search to Access Badging Functions on Page 214. 

• Using Advanced Search to Access Badging Functions on Page 215. 

• Using a Query to Access Badging Functions on Page 216. 

Accessing Badging from the Personnel Dynamic View 

The Personnel Dynamic View by default lists all of the Personnel records in your C•CURE 9000 database. You can 
view this list of records and access specific records to perform badging functions. 

To Access Badging Functions from the Personnel Dynamic View 

1. In the Co CURE 9000 Administration application, click Personnel in the Navigation Pane. 

2. Choose Personnel from the drop-down list in the Personnel pane and click MS to view the default Personnel 
Dynamic View listing all Personnel records. See Figure 41 on Page 213. 

Figure 41: Personnel Dynamic View 
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• You can scroll through the list by clicking the scroll bar. 

• You can sort the list by clicking a column head. 

• You can filter the list using the Filter button. 

See Dynamic Views in the 0 CURE 9000 Data Views Guide for more information. 
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3. Double-click on the person in the list whose record you want to edit. The Personnel Editor opens. See Figure 42 
on Page 214. 

Figure 42: Personnel Editor 
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4. Click the Images tab to access Image and Signature capture functions. Taking Portrait Pictures on Page 218 
provides instructions for using the Images tab. 

5. Click the Badging tab to access Badging and Fingerprint functions. 

6. See the following topics for instructions for using the Badging tab. 

• Previewing a Badge on Page 235 

• Printing a Badge on Page 236 

• Enrolling Fingerprints on Page 227 

Using Quick Search to Access Badging Functions 

If you have a large database and you need to narrow your search results, you can use Quick Search to look for a 
Personnel record by name. Quick Search performs a "Starts with" search that looks for people whose name starts 
with the letters you typed. 

To Use Quick Search to Access Badging Functions 

1. In the Co CURE 9000 Administration application, click Personnel in the Navigation Pane. 

2. Choose Personnel from the drop-down list in the Personnel pane. 
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3. Click the Quick button. The Quick Search panel is displayed. 
See Figure 43 on Page 215. 

Figure 43: Quick Search Panel 
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4. Type the first characters of the name that you want to search for and click p is. The Personnel Dynamic View 
listing the Personnel records you searched for opens. 

5. Double-click the person in the list whose record you want to edit. The Personnel Editor opens. 

6. Click the Images tab to access Image and Signature capture functions. Taking Portrait Pictures on Page 218 
provides instructions for using the Images tab. 

7. Click the Badging tab to access Badging and Fingerprint functions. See the following topics for instructions for 
using the Badging tab: 

■ Previewing a Badge on Page 235 

■ Printing a Badge on Page 236 

■ Enrolling Fingerprints on Page 227 

Using Advanced Search to Access Badging Functions 

You can create an Advanced Search and save it as a Query to use for subsequent searches. 

To Use Advanced Search to Access Badging Functions 

1. In the C•CURE 9000 Administration application, click Personnel in the Navigation Pane. 

2. Choose Personnel from the drop-down list in the Personnel pane. 

3. Click the Advanced button. The Query panel is displayed, listing Queries that you have saved. 

4. Click New Query. The Query Editor opens so that you can define and save your Advanced Search settings. 

5. Type in a Name and Description for your Query. The Query target type is already pre-set to Personnel. 
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6. Click Add to add a row to the Query Criteria table. You can then add the field and filter values you want to 
search for. See the C•CURE 9000 Data Views Guide for more information on configuring Queries. 

7. You can add more rows to the table, depending on the type of search you wish to make. 

8. Click Save and Close to save the Query. The Query is added to the list of Personnel Queries in the Query pane. 

9. Double-click the Query you just saved to run the Query. A Dynamic View displaying the Query results is 
displayed. 

10. Double-click the person in the list whose record you want to edit. The Personnel Editor opens. 

11. Click the Images tab to access Image and Signature capture functions. Taking Portrait Pictures on Page 218 
provides instructions for using the Images tab. 

12. Click the Badging tab to access Badging and Fingerprint functions. See the following topics for instructions for 
using the Badging Tab: 

■ Previewing a Badge on Page 235 

■ Printing a Badge on Page 236 

■ Enrolling Fingerprints on Page 227 

Using a Query to Access Badging Functions 

Once you have saved a Personnel Quay, you can access it either from the Personnel Advanced Search panel or the 
list of saved Queries. 

To Use a Query to Access Badging Functions 

1. In the C•CURE 9000 Administration application, click Data Views in the Navigation Pane. 

2. Choose Query from the drop-down list in the Data Views pane. 

3. Click ea. The Dynamic List of all queries opens. 

4. Double-click the Personnel Query you want to use to run the Query. A Dynamic View displaying the Query 
results is displayed. 

5. Double-click the person in the list whose record you want to edit. The Personnel Editor opens. 

6. Click the Images tab to access Image and Signature capture functions. Taking Portrait Pictures on Page 218 
provides instructions for using the Images tab. 

7. Click the Badging tab to access Badging and Fingerprint functions. See the following topics for instructions for 
using the Badging Tab. 

■ Previewing a Badge on Page 235 

■ Printing a Badge on Page 236 

■ Enrolling Fingerprints on Page 227 
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Assigning a Badge Layout 

You create badge layouts using the C•CURE IL) Badge Designer. Once you have created these layouts and saved 
them, they appear in the Badge Layout list on the Credential tab in the Personnel Editor so that you can assign a 
badge layout to the cardholder's credentials. 

To Assign a Badge Layout 

1. Open the Personnel record to which you wish to assign a badge layout. 

2. Click the Credentials tab. 

3. Select the Credential you wish to edit, or click Add to create a new Credential. 

4. Select a badge layout from the available layouts on the Badge Layout list on the Personnel Credentials tab. 

5. Click Save and Close to save your Badge layout choice. 
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Taking Portrait Pictures 

You can add a portrait to a personnel record. You open the personnel record of the person for whom you want to 
take a picture, and go to the Images tab to access the portrait capture function. 

You can add multiple portraits to a Personnel record, then choose on the Badging tab the portrait you want to use for 
each badge. 

To Add a Portrait 

1. Open the Personnel Editor for the person and click the Images tab. See Figure 44 on Page 218. 

Figure 44: Personnel Images Tab 
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2. Click Add to add a portrait to the Personnel record, then click Capture to capture or import an image f n- the 
portrait. 

• If you are using a capture device to add portraits, the Video Capture dialog box opens to let you 
freeze and save a picture. See Using the Video Capture Dialog Box on Page 219. 

• If you are importing existing images, the Import Image dialog box opens to let you import the 
portrait. See Importing Existing Portraits or Signatures on Page 225. 
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Taking Pictures with a TWAIN Device 
Portrait capture using a third party TWAIN device can vary depending upon the TWAIN device being used. The 
following procedure is a general example of how portrait capture with TWAIN would work. 

To Take a Picture with a TWAIN Device 

1. Click Capture on the Images tab of the Personnel Editor. C•CURE launches the appropriate TWAIN window, 
with the image of the person in the left side and the camera controls on the right side and the bottom of the 
window. 

NOTE 
The Video Capture dialog box appears only if you have configured a camera or TWAIN source with 
C•CURE ID Badge Setup. If you have configured C•CURE ID to Always Ask for an image capture 
source, the TWAIN Source dialog box appears, listing the available image capture sources. See Setting 
Up a TWAIN Device for Portrait or Signature Capture on Page 71 for more information. 

2. To edit capture settings, click Settings (when available): 

• Specify the Flash options. 

• Specify Composite as the Input Type. 

• Specify if video is NTSC or PAL. 

• Specify the Capture width and height and ratio. 

• Center the image on its x-axis and y-axis. 

• Click Save Settings to save the capture settings and use it every time you capture a portrait. 

3. Click: 

• Cancel: to exit the Setup window without capturing the portrait 

• Capture: to capture the portrait. The Video Capture dialog box opens. 

4. See Using the Video Capture Dialog Box on Page 219 to adjust the image. 

Using the Video Capture Dialog Box 

The Video Capture dialog box (shown in Figure 45 on Page 220) is used to display a video image from your camera, 
and allow you to capture it, and then adjust and save it using the Save Image dialog box (shown in Figure 46 on 
Page 220). 

NOTE 
The Video Capture dialog box appears only if you have configured a camera or TWAIN source with 
C•CURE ID Badge Setup. If you have configured C•CURE ID to Always Ask for an image capture 
source, the TWAIN Source dialog box appears, listing the available image capture sources. See Setting 
Up a TWAIN Device for Portrait or Signature Capture on Page 71 for more information. 

To Use the Video Capture Dialog Box 

I . Click Capture from the Personnel Imaging tab capture a portrait. The Video Capture dialog box opens to let you 
freeze and save a picture. 

C•CURE 9000 C•CURE ID User Guide Chapter 6 219 

EFTA01225096



Taking Pictures with a TWAIN Device 

Figure 45: Portrait Capture Dialog Box 

1. Frame your subject in the Video Capture dialog box by moving the camera or by using the cursor. 

2. Make any adjustments using the controls on the dialog box, and click Accept to capture the image. 

3. The Save Image dialog box (see Figure 46 on Page 220) opens so that you can make adjustments to the captured 
image. 

Figure 46: Save Image Dialog Box 
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4. A bounding box is present within the image window to indicate the region of the image that will be saved as the 
portrait. You can use the mouse (click and drag) to move this box anywhere on the captured image. In addition, 
the bounding box comes with sizing handles, which gives you the option to change the dimensions of the image 
as required. 

5. The window provides brightness and contrast controls by default. If Software Controlled Camera is selected, 
other camera features may appear, such as Backlighting, Zoom In/Out, or Flash On/Off. These controls are 
described in Table 59 on Page 222 

6. When you have selected the portion of the image you want to save, and you have performed all adjustments, 
click Save to save the image. 

7. The system stores each image using the Person_ID field (PID) for each personnel record. 
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Example: 

If you choose the JPEG graphics format, an image for a person with an ID number of 1234 is saved as the 
file 1234.JPG. The graphics format you specify on the C•CURE ID Portrait Configuration editor determines 
the file extension. See Choosing a Graphic Format on Page 69 for more information. 

8. The Edit Personnel Record Badging tab appears with your captured image in the Portrait box. 

9. Click Preview Badge to see how the badge layout appears; a sample preview is shown below. 

F gure 47: Example of a Badge Preview 

10. Click OK to save your changes to the Personnel Record. 

Capture Dialog Box Definitions 

Table 58 on Page 221 summarizes the fields and buttons on the Video Capture dialog box. 

Table 58: Video Capture Dialog Box Definitions 

Fiekl/Button Description 

a Choi( to zoom out so that the image appears farther away. 

Click to zoom in so that the image appears closer. 

Setup Click to open the setup dialog box to adjust the camera and capture board controls. 

Capture Click to capture the current image. 

Live Click to discard the current capture and return to the We camera to recapture an image. 

Backlight Use the backlight control to adjust the image background lighter or darker. 

Help Click to get online help for this dialog box. 

Accept ClickAccept to open the Save Image dialog box, so you can make adjustments and save the portrait. 

Cancel Click Cancel to cancel the portrait capture. 

Save Image Dialog Box Definitions 

Table 59 on Page 222 summarizes the fields and buttons on the Save Image dialog box. 
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Table 59: Save Image Dialog Box Definitions 

Fiekleutton Description 

Brightness Adjusts the brightness of the image. The default value is 0 and the range is from -1 to 1. 

Contrast Adjusts the contrast of the image. The default value is 1 and the range is from 0.2 to 4. 

Saturation Adjusts the Saturation (color intensity) of the image. The default value is 1 and the range is from 0 to 3. 

Hue Adjusts the Hue (color) of the image. The default value is 0 and the range is from -180 to 180. 

Sharpness 
Radius 

Adjusts the Sharpness Radius of the image. The Radius controls the size of edges to be sharpened to remove blurring. The 
higher the value, the more bssof smalldetails mayoccur. The default value is .7 and the range is from 0 to 8. 

Sharpness 
Depth 

Adjusts the Sharpness Depth of the image. The Depth controls the focus d ista nce: higher Depth values can increase the 
sharpnessof the image. The defautt value is .8 and the range is from 0 to 4. 

Reset Click to reset the image adjustment controls to their default values. 

Cancel Click to ca ncel saving the image and return to theVideo Capture window. 

Save Click to save the portrait to the Personnel record. 
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Taking Signatures Using Signature Devices 

When you select Penware Sig Tablet or Topaz Sig Tablet as the capture device for signatures, you can use the 
signature tablet to take badge signatures. The capture screens for the two tablets are slightly different as explained in 
the following sections. You can also use a camera to take signatures by photographing signatures written on paper. 

NOTE The Penware Signature Tablet is not supported on a Vista client or on Windows Server 2008, and can 
only be used on Windows 2003 Server by a user logged on as an administrator. 

See Portrait Configuration Tasks on Page 69 for information about selecting a capture device. 

NOTE When a record is open, you can take pictures and signatures for the record, one image at a time. You 
must finish capturing an image before you capture another image for the record. 

To Take a Signature Using a Penware Sig Tablet Signature Device 

Open the Personnel Record for the person and click Badging tab. The Personnel Badging tab opens. 

2. t. lick Take Signature to capture a signature. The Penware Signature Capture dialog box opens. 

Figure 48: PanwareSignatureWindow 
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3. Have the person sign on the signature tablet. The Signature window displays the signature. 

4. Click: 

• OK to save the signature. 

• Clear to erase the signature 

• Cancel to close the window without saving the signature 

If you saved the signature, the Save Image dialog box opens. 
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Figure 49: Save Image Dialog Box 

5. Use the bounding box to mark the required boundary around the captured signature. Again, use the brightness 
and contrast sliders to adjust the image as required. Click Save to save the signature, or click Cancel to close the 
window without saving the signature. 

 a 
To Take a Signature using a Topaz Sig Tablet Signature Device 

I . Open the Personnel Record for the person and click the Badging tab. 

2. ( lick Take Signature to capture a signature. The Topaz Signature window opens. 

Figure 50: Topaz Signature Window 
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3. Have the person sign on the signature tablet. The Signature window displays the signature. 

4. Click: 

• OK to save the signature 

• Clear to erase the signature 

• Cancel to close the window without saving the signature 

If you saved the signature, the Save Image dialog box opens. 

5. Use the bounding box to mark the required boundary around the captured signature. Again use the brightness 
and contrast sliders to adjust the image as required. Click Save to save the signature, or click Cancel to close the 
window without saving the signature. 
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Importing Existing Portraits or Signatures 

If you already have portraits or signatures in a compatible file format, you can import them into personnel records. 

To Import an Existing Portrait or Signature 

Make sure that the Capture Device is set to Import from File in the C•CURE ID Setup Portraits Configuration dialog 
or Signature Configuration dialog. See: 

■ Setting Up Import from File for Portrait Capture on Page 72 

■ Signature Configuration Tasks on Page 74 

1. Navigate to a personnel record by clicking Personnel from the Administration Client application Personnel Pane, 
then clicking Qs to display a list of Personnel records. 

2. Select the Personnel record to which you want to import an image, and double-click on the Personnel record. 

3. Click the Images tab of the Personnel Editor. 

4. Click: 

■ Capture to import a portrait file 

■ Capture Signature: to import a signature file. 

The Import Image dialog box opens.: 

5. Navigate to the appropriate directory in your C•CURE ID installation containing the picture you want to import.: 

6. Select the image file from the list. The image appears in the preview window on the bottom right of the screen. 

7. Click Rotate if you want to rotate the image through 90 degree increments. 

8. Click Load Image to proceed, or Cancel to cancel the operation. 
The image appears in a preview window, and if the image is larger than the allotted size, a dotted rectangle 
appears that you can position with the mouse pointer to crop the image to the correct size. 

9. If you have enabled Brightness/Contrast Adjustment in C•CURE ID Setup Portrait Configuration Dialog Box 
Definitions on Page 72, you can use the Image adjustment sliders to adjust Brightness, Contrast, Saturation, Hue, 
and Sharpness. 

10. Click Save to import the image. 

11. Click Save and Close in the Personnel Editor to save the Personnel record with the new image. 

Displaying Personnel or Signature Images 

You can retrieve and display the portrait or signature image associated with a particular record in the database. 

To Display an Image 

Retrieve the record you want by choosing Personnel from the drop-down list in the Personnel pane, then click 

jk  • to display the list of Personnel records. 

2. Select the desired record in the list and right-click to choose Edit from the context menu. The Personnel Editor 
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opens. 

3. From the Personnel Editor, click the Images tab. 

The Images tab opens, showing the portraits and/or signatures associated with the Personnel record. 
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Enrolling Fingerprints 

Fingerprints are captured in a manner similar to Portraits or Signatures, but they are encoded to a chip within the 
badge instead of being printed onto one. 

Fingerprint enrollment consists of capturing two fingerprints and encoding the resultant data onto a card or token. 
You enroll two different fingers to allow alternatives in case the employee forgets, or is injured and cannot use the 
usual finger for verification. 

An enrollee's finger or thumb should: 

• Lie flat on the sensor 

• Cover the entire sensor area (touching the edges of the sensor area.) Individuals with small fingers should use 
thumbs if possible 

• Be parallel to the sensor's sides 

• Positioned with the cuticle in the center of the sensor 

• Be dry 

• Not move during scanning 

Once a fingerprint is captured, a copy of the captured image is displayed on the screen, with a message reporting the 
number of Minutiae calculated from the scan. Quality prints are those with the whorls of the fingerprint in the center 
of the image area with at least 20 minutiae. However, the displayed image should also be inspected for clarity. 

The fingerprint is displayed only if Display Fingerprint Image is selected in the C•CURE ID Biometric 
Configuration dialog box. 
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The following screen shots show examples of good and bad quality captures. 

Good Fingerprint Capture Poor Fingerprint Capture 
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Figure 51: Finger Pressure 

Bioscrypt Fingerprint Enrollment 

If you have a Bioscrypt enrollment center, follow this procedure to enroll a fingerprint: 

1. Click Take Fingerprint. The Bioscrypt Fingerprint Capture dialog box opens (see Figure 52 on Page 229). 
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Figure 52: Bascrypt Fingerprint Capture Dialog Box 
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2. Select the fingerprint to capture by clicking on the appropriate number 
0-9 above the left and right hand graphic. 

3. If this finger will be used for Duress entry, click the Duress Finger checkbox. 

4. Click Capture, then have the employee place a finger on the enrollment center. 

5. Repeat steps 2 through 4 for each required fingerprint. 

6. When you have captured all the required fingerprints, click Accept to store the fingerprints. 

7. The Present Card dialog box shown in Figure 53 on Page 229 appears to prompt you to present the card to the 
reader to encode the fingerprints on the card. 

Figure 53: Present Smart Card Dialog Box 
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8. When the encoding process is successfully completed, the Please Remove Card dialog box shown in Figure 54 on 
Page 230 appears. Click Quit to finish. 

Figure 54: Please Remove Card Dialog Box 

r Card p.1. 

a 
Cal Snai cpatfO,1111i2O 

Cal Till• 

fin wow wan. n2.

Ca. II Man. M•n• r4O41, Ass a... 

nnalnierseat 0..1 

Monti. f......•••1 nra 

Please Remove Card 

201

9. If the card presented already has fingerprint data encoded on it, the Erase Encoded Data dialog box appears. You 
can click one of these buttons: 

• Erase Only - to delete the encoded data. When the data is erased, click Quit to return to the 
Bioscrypt Fingerprint Capture dialog box. 

• Erase AND Continue - to delete the encoded data and encode new data. 

• Quit - to exit the encoding process and retain the fingerprint data encoded on the card. 

Figure SS: Erase Encoded Data on Card 
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10. If you click Erase AND Continue, the Enter Facility Code dialog box appears so that you can enter the correct 
Facility Code for this card. 
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F igu re 56: Enter Facility Code Dialog Box 
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11. When encoding is completed, the Please Remove Card dialog box (Figure 54 on Page 230) appears. 

12. When all the required fingerprints have been encoded, click Close to close the Bioscrypt Fingerprint Capture 
dialog box. 

Bioscrypt Fingerprint Capture Dialog Box Definitions 

See Table 60 on Page 231 for definitions of the fields and buttons that appear on the Bioscrypt Fingerprint Capture 
dialog box (see Figure 52 on Page 229). 

Table 60: Bicisaypt Fingerprint Capture Dialog Box Definitions 

Field Description 

Enrollment 

Capture Click this button to capture a fingerprint. 

Verify Click this button tocompare the captured fingerprint with the presented fingerprint. You can see the captured fingerprint only d you 
have selected Display Fingerprint in the C•CURE ID Blometric Configuration dialog box. 

Accept Clid< this button to prompt the employee to place the badge on the reader and store the captured fingerprint data on it. 

Quality Displays the percentage of the captured fingerprint quality. A percentage over 40 isacceptable. 

Content Displays the percentage of the captured fingerprint content. A content of over 25 isacceptable. 

Card 
Holder 

This field displays the name of the employee that you are enrolling 

Card 
Number 

Displayscard number of the current empbyee. 

Fingerprints 
Required 

Displays the total amou nt of fingerprints you need to enroll for this empbyee. 

Fingerprints 
Captured 

Displays the number of fingerprints already captured for this empbyee. 

Current Template 

Finger 
selection 

Select the finger that you wish to enrol by decking in a finger number field (0-9). 

This should be the same finger you asked the employee to place on the enrolment center. 
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Bioscrypt Fingerprint Capture Dialog Box Definitions (continued) 

Field Description 

Duress 
Finger 

Select this option to identify the fingerprint currently being captured as the fingerprint for duress entry. 

Template 
Name 

This field displaysthe name of the employee that you are enrolling 

Template 
ID 

Displays the fingerprint template ID for the current employee. 

Stored Templates 

Template 
list 

This drop-down list contains the templates(fingerprints) that you have captured for this employee. 

Used Lists the number of fingerprints captured for this employee. 

Out of Lists the number of fingerprints remaining to be captured. 

Delete 
Finger 

Select an already captured fingerprint template from the Template list and click Delete to delete this fingerprint from the Bioscrypt 
unit. 

Delete All Click this button to delete all stored fingerprint templates for this employee from the Bioscrypt unit. 

Status 
Display 

This line displays any messages or errors from the Bioscrypt enrollment center. 

Close Click this button to close the Fingerprint Capture dialog box. 
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7 

Printing Badges 

This chapter provides information about printing badges with C•CURE ID. You can choose to print badges 
automatically, queue all badges, or print badges from a Personnel Query. 

In this chapter 

Previewing and Printing a Badge 234 
Previewing a Badge 235 
Printing a Badge .236 
Printing Queued Badges  .237 
Batch Printing Badges  238 
Queuing a Badge for Batch Printing 239 
Batch Print Badges from a Query 241 
Batch Print Badges from a Dynamic View 243 
Batch Print Manager 244 
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Previewing and Printing a Badge 

The C•CURE 9000 Administration Client application lets you print badges from a Personnel Query and from the 
Badging tab of a Personnel Record. 

From a Personnel Dynamic View or Quay result, you can batch print badges from a list of Personnel using Batch 
Printing Badges on Page 238. 

From a Personnel Record, you can: 

• Preview a Badge - see Previewing a Badge on Page 235. 

• Print a badge to the specified badge printer - see Printing a Badge on Page 236. 

• Queue a badge for batch printing - see Queuing a Badge for Batch Printing on Page 239. 

• Print queued badges to the specified badge printer - see Printing Queued Badges on Page 237. 
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Previewing a Badge 

You can preview a badge for a Personnel Record from the Personnel Badging tab. 

Before you can preview a badge, a badge layout must be assigned to the badge on the Cards tab of the Personnel 
Record. See the Administration Client Help for instructions on assigning a badge layout. 

To Preview a Badge 

1. Access Personnel from the Administration Client. See Accessing Personnel Badging on Page 213. 

2. Select the Personnel Record that you want to preview from the list and click Edit 

3. Click on the Badging tab in the Personnel Record. 

4. Select a badge from the list of badges. 

5. Click Preview Badge to display the badge layout. The system displays a picture of the badge as it would be 
printed. 

6. Click Side 2 to show the back side of a two-sided badge. 

7. Click ag to close the Preview dialog. 
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Printing a Badge 

You can print a badge from the Personnel Badging Tab. The print settings you have chosen when setting up the 
printer determine how and when the badge is printed (for example, whether the badge is queued or printed 
immediately). 

If you have configured Batch Printing, the setting you chose in C•CURE ID Badge Setup determines your options 
now. 

When you queue one or more badges to print, the Batch Print Manager on Page 244 is available (minimized on the 
Windows task bar) giving you the status of the batch printing queue, and allowing you to change print options. 

If you configured: 

Always ask - the Batch Print Manager dialog box appears, with this badge selected V). You can click Print 
Selected Badges to print the badge. 

Always Queue - the badge is automatically added to the batch print queue . 

Autoprint without badge sheet layout - the badge is printed immediately. 

Autoprint with badge sheet layout - the badge is automatically added to the batch print queue. 

• If adding this badge to the batch print queue completes a badge layout sheet, all the badges on that layout page 
are printed. 

• If adding the badge to the batch print queue does not complete a badge layout sheet, the badge remains in the 
queue until a full sheet of badges is queued, then that sheet of badges is printed. 

NOTE 
You need to set up a printer for printing badges to be able to print a badge (see Setting 
Printer Options on Page 62). 

To Print a Badge 

1. Choose Personnel>Browse from the Administration client menus. 

2. From the browse list, select the Personnel Record that you want to print and click Edit 

3. Click on the Badging tab in the Personnel Record. 

4. Select a badge from the list of badges. 

5. Click Print Badge on the Badging tab. 

6. If you have not configured Batch Printing, the badge is printed at the badge printer you configured during set up. 
A progress indicator appears to show you if the badge is processed correctly. 

7. If you have configured Batch Printing, the setting you chose previously determines your options now. 
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Printing Queued Badges 

From the Personnel Badging tab, you can print the badges that are currently in the Badge Batch Print Queue. 

 a 
To Print Queued Badges 

1. Click Print Badge on the Badging tab. The Print Badges Now? dialog box opens. 

2. Select Print Entire Queue, then click Print to print all badges in the queue. 

3. Alternatively, right-click on the C•CURE ID Batch Print Manager icon S in the Windows System Tray. You can 
select a printing action from the context menu that appears. (The current selection is shown grayed out.) See 
Batch Print Manager Context Menu on Page 245 for more information. 

• Auto Print 

• Always Queue 

• Suspend All 

• Print Selected Badges 

• Delete Entire Queue 

• Exit 

1. Click Print Badge on the Badging tab. The C•CURE ID Batch Print Manager dialog box opens. 

2. To print all badges in the queue, clickSelect All, then click Print Selected Badges to print all badges in the 
queue. 

3. Alternatively, use the buttons on the Batch Print Manager toolbar to manage the Batch Print Queue. See Batch 
Print Manager Toolbar Definitions on Page 246. 
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Batch Printing Badges 

You can queue badges to print in a "batch" - multiple badges queued to print as a single print job. 

You can queue badges to batch print in three ways: 

■ Individually Add Badges to the Batch Print Queue on Page 239 

■ Batch Print Badges from a Query on Page 241 

■ Batch Print Badges from a Dynamic View on Page 243 
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Queuing a Badge for Batch Printing 

You can place a badge in the batch printing queue from the Personnel Badging Tab. The print settings you have 
chosen when setting up the printer determine how and when the badge is printed (for example, whether the badge is 
queued or printed immediately. 

To Queue a Badge for Batch Printing 

NOTE You should have selected the batch printing option to be able to queue badges to print 
together. See Setting Batch Printing Options on Page 50. 

1. Click Print Badge on the Badging tab. 

2. If you have configured Batch Printing, the setting you chose then determines your options now. If you 
configured: 

• Always ask - the Print Badges Now dialog box opens. Click Queue to add this badge to the batch print 
queue. 

• Always Queue - the badge is automatically added to the batch print queue. 

• Autoprint without badge sheet layout - the badge is printed immediately. 

• Autoprint with badge sheet layout - the badge is automatically added to the batch print queue. 

• If adding this badge to the batch print queue completes a badge layout sheet, all the badges on that 
layout page are printed. 

• If adding the badge to the batch print queue does not complete a badge layout sheet, the badge remains 
in the queue until a full sheet of badges is queued, then that sheet of badges is printed. 

3. If you added the badge to the batch print queue, you can use the Batch Print Manager on Page 244 (minimized 
on the Windows task bar) to view the details of the printing job, send queued badges to print, and change print 
options. 

Individually Add Badges to the Batch Print Queue 

You can set up Batch Printing options to specify how badges are added to the batch print queue, as an alternative to 
being printed immediately at your badge printer. You can choose: 

• Always Queue - adding badges automatically to the queue when a badge print request occurs. 

• Always Ask - displaying a prompt that lets the user choose between printing the badge or queueing the badge. 

• Auto Print - send the badge directly to print. 

In addition, if you have enabled Use Sheet Layout? when you set up batch printing, queued badges are only printed 
when a full sheet of badges is queued. 

Example: 

The Autoprint setting with sheet layout enabled only prints badges when a full sheet of badges is queued, based 
on the badge sheet layout defined in C•CURE ID Setup. 
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NOTE 
When you send badges to batch print, C•CURE ID blocks you from queuing more badges 
while a print job is running, to ensure the integrity of the queue. If you try to add badges 
to the queue, C•CURE ID displays a notification that you cannot queue additional badges 
until the current batch print is completed. 

For more information on these options, see Setting Batch Printing Options on Page 50. 
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Batch Print Badges from a Query 

You can batch print badges using the result list from a Personnel Query (or a Personnel Dynamic View). This 
capability lets you query your personnel record database to find the badges you want to print, and then send them to 
print using the context menu selection Batch Print Badges. 

To Batch Print Badges from a Personnel Query 

1. Define a Query to display the Personnel Records that contain the badges you wish to print. For example, define a 
query that returns only personnel records for cards that were activated today. See the C•CURE 9000 Data Views 
Guide for more information about defining a Query. 

2. Run the query by: 

a. Clicking Personnel from the C•CURE 9000 Administration Client Application 

b. Selecting Personnel from the drop-down list. 

c. Clicking Advanced to show the list of saved Personnel Queries. 

d. Double-click the Query in the list that you want to run. 

3. The Personnel Query result appears as a Dynamic View, listing the records your query returned. 

4. Select one or more of the Personnel records in the list (using standard Windows multiple selection shortcuts such 
as SHIFT+Left-click) for the badges that you want to print. 

5. Right-click selected row(s) to display the context menu. 

6. Select Batch Print Badges from the menu. The selected badges are then queued to print based on the Batch 
Printing options you have chosen during C•CURE ID Badge Setup. 

7. C•CURE ID displays a log window to show the progress of your queuing request, and the status of the badges 
you queued (see Figure 57 on Page 242 for an example). Click OK to close the log window. (The Print button on 
the log window prints out the log window, not the badges themselves.) See Batch Print Badges Log Window on 
Page 241 for more information. 

Batch Print Badges Log Window 

When you send badges to print using Batch Print Badges, C•CURE ID displays a log window that shows the status 
of each badge you sent to print. See Figure 57 on Page 242. 

You can click Print to print the message box or click Email to email the message box to the recipient who was 
configured in the System Variable Email Address under Customer Support (The Email function is intended to 
provide a way to email information to Customer Support for your site. See the C•CURE 9000 System Maintenance 
Guide for more information.) 
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Figure 57: Batch Print Badges Log Window 

If C•CURE ID is unable to prepare a badge for printing, that badge is skipped. C•CURE 
ID displays a message box to inform you of this. You can view and print this message to 
determine why a badge was skipped. 
Badges are skipped when: 

• There is no Badge Layout assigned to the card. See Assigning a Badge Layout on 
Page 217 

• The Personnel record is invalid (for example, the badge was queued but the 
Personnel Record was deleted after the badge was queued to print). 

• The card in the Personnel record is marked as Disabled, Expired, Lost, or Stolen. 

• No cards (credentials) are found for the person. 
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Batch Print Badges from a Dynamic View 

When you view a list of Personnel in a Dynamic View, you have the option to use the context menu selection Batch 
Print Badges to print some or all of the badges in the list as a batch print job. 

Perform the following steps to batch print badges from the list of Personnel. 

To Batch Print Badges from a Dynamic View 

1. From a Dynamic View of Personnel, select the Badges you want to print: 

• Click on a row in the list to select a single badge. 

• Use CTRL + left mouse click to select multiple badges. 

• Use SHIFT + left mouse click to select a range of badges. 

2. Right-click to open the context menu, then click Batch Print Badges. 

3. The Batch Print Badges dialog box appears listing the badges that you sent to the Batch Print Queue. You can 
print this list by clicking on the Print button, or email this list to the email address specified in System 
Variables>Customer Support>Email Address by clicking the Email button. 

3. The personnel records you selected are processed in accordance with the Batch Print settings you chose when 
you configured batch printing (see Setting Batch Printing Options on Page 50). 

4. If you chose the Always Ask option for batch printing, the Print Badges Now? dialog box opens. From this 
dialog you can: 

• Print Entire Queue - Select this option to specify that you want all the badges in the queue 
printed when you click the Print button. 

• Print This Badge - Select this option to specify that you want to print the badge(s) from your 
query result list when you click the Print button. 

• Print - Click this button when you are ready to print badges. 

• Queue - Click this button if you want to add the badges to the Batch Printing Queue rather than 
print them right now. You can subsequently print the queued badges using the C•CURE ID Batch 
Printing Dialog in the Windows Task Bar (see Batch Print Manager on Page 244). 

5. If you chose the Always Queue (Manual Print in Badge Setup) option for batch printing, the badge is 
automatically placed in the batch printing queue for later printing. 

6. If you chose the Auto Print option for batch printing, the badge is printed automatically if Use Sheet Layout? 
is not enabled. If Use Sheet Layout? is enabled, the badge is automatically added to the batch print queue. 

• If adding this badge to the batch print queue completes a badge layout sheet, all the badges on 
that layout page are printed. 

• If adding the badge to the batch print queue does not complete a badge layout sheet, the badge 
remains in the queue until a full sheet of badges is queued, then that sheet of badges is printed. 
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Batch Print Manager 

When you send a badge to the badge print queue by clicking Print Badge from the Personnel Badging tab or Batch 
Print Badges, the Co CURE ID Batch Print Manager opens. See Figure 58 on Page 244. 

Figure 58: Print Oueue Manager 
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The Batch Print Manager displays important information about badges queued to print, the batch printing options 
you have chosen, and includes a toolbar with commands that you can use to print badges, change options, and 
modify the queue. 

The Batch Print Manager displays two tabs: 

• Queue tab - This tab shows the badges currently in the queue, and provides a Tool Bar that you can use to 
manage the queue. See for definitions of the fields and buttons on the Batch Print Manager Queue tab. See Batch 
Print Manager Definitions on Page 246 for definitions of the buttons on the Tool Bar. 

• Status tab - This tab shows the settings for badge printing and Sheet printing. Click Status to view the Status 
tab. See Batch Print Manager Status Tab Definitions on Page 247. 
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Figure 59: Batch Print Manager Status tab. 

The C•CURE ID Batch Print Manager also has a System Tray Icon with a context menu that you can access by 
right-clicking the icon in the System Tray. If you minimize the C•CURE ID Batch Print Manager dialog box, you can 
open it again by clicking the System Tray icon. See Batch Print Manager Context Menu on Page 245 for more 
information. 

Exiting the Batch Print Manager 

Click the Exit du, button on the Window title bar to close the C•CURE ID Batch Printing dialog. 

A confirmation dialog box appears, asking "Do you really want to stop the Batch badge queue processing?" Click Yes 
to close the Batch Print Manager dialog box, or click No to cancel closing the Batch Print Manager dialog box. 

Closing the Batch Print Manager dialog box does not delete badges from the print queue. You can re-open the dialog 
by adding another badge to the print queue (click Print Badge from the Edit Personnel Record screen) if Batch 
Printing is enabled in C•CURE ID Setup. 

Batch Print Manager Context Menu 

You can right-click the Batch Print Manager System Tray icon to display the Batch Print Manager context menu. 
The context menu for the Batch Print Manager dialog box offers choices for printing your badges from the queue. 

Table 61: Batch Print Manager Context Menu Definitions 

Option Description 

Always 
Queue 

Select this option to change to Always Ask. which lets you choose the badges you want to print. This change is in effect only for the 
current session with the Batch Print Manager. When you close the Batch Print Manager, this setting reverts to the value set with 
C•CURE ID Badge Setup. See Setting Up Batch Queue Mode on Page 53. 
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Batch Print Manager Context Menu Definitions (continued) 

Option Description 

Auto 
Print 

Select thisoption to change to Auto Print. which sends badges to print immediatety as they are queued. Thischange is in effect onty 
for the current session with the Batch Print Manager. When you close the Batch Print Manager, this setting reverts to the value set with 
C•CURE ID Badge Setup. See Setting Up Batch Queue Mode on Page 53. 

Suspend 
All 

Select this option to deselect all entries in the queue. Each entry in the queue with a v changes to 

Delete 
Entire 
Queue 

Select thisoption to delete all entries from the Batch Print Queue. 

Exit Select this option to close the Batch Print Manager dialog box. When you close the diabg box. any badges that are in the queue 
remain in the queue. 

Batch Print Manager Definitions 

The following fields and buttons are available on the Batch Print Manager dialog box: 

• Batch Print Manager Toolbar in Table 62 on Page 246. 

• Batch Print Manager dialog box Queue tab in Table 63 on Page 247. 

• Batch Print Manager dialog box Status tab in Table 64 on Page 247. 

Table 62: Batch Print Manager Toolbar Definitions 

Field/Button Description 

AtwaysAsk You can select this setting from the drop-down list if you wish to change the Batch Print Queue setting for the current session to 
Always Ask, so that badges are added to the queue rather than being printed automaticalty. When you close the Batch Print 
Manager. this setting reverts to the value set in System Variables. 

Auto Print You can select this setting from the drop-down list if you wish to change the Batch Print Queue setting for the current session to 
Auto Print. so that badges are printed a utomaticalty when added to the queue. When you close the Batch Print Manager. this 
setting reverts to the value set in System Variables. 

Always Queue You can select this setting from the drop-down list if you wish to change the Batch Print Queue setting for the current session to 
Always Queue, so that badges are added to the queue rather than being printed automaticalty. When you close the Batch 
Print Manager. this setting reverts to the value set in System Variables. 

Pause Click this button when the queue is set to Auto Print to pause printing. Click this button again to resume printing. 

Select All Click this button to select all entries in the queue. As appears to the left of each entry in the queue. 

Deselect All 
Click this button to deselect all entries in the queue. A M appears to the left of each entry in the queue. 

Print Selected 
Badges 

Click this button to print all of the currentty selected l7badges in the Batch Print Queue. 

Delete All Click this button to delete all of the currentty selected l7badges in the Batch Print Queue. 
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Batch Print Manager Toolbar Definitions (continued) 

FiekUButton Description 

Up Click this button to move the currentty highlighted entry in the queue one position nearer the top of the queue. Selected badges 
are printed in order from the top of the queue. 

Down Click this button to move the currentty highlighted entry in the queue one position nearer the bottom of the q ueue. Selected 
badges are printed in order from the top of the queue. 

Print Click this button to print the currentty highlighted (not necessarity selected e) badges. 

Delete Click this button to delete the currentty highlighted (not necessarity selected MI) badges. 

Table 63: Batch Print Manager Queue Tab Definitions 

Field/Button Description 

Selected This column in the queue displays whether or not the badge in that row is selected El for printing. 

Name Thisoolumn displays the name of the badge in this row of the print queue. 

The name is the file path of the badge print file in the queue. 

Card Number This column displays the Card Number for the badge in this row of the print queue. 

Description This column displays the Badge Layout file used for this badge in the print queue. 

Badges Per 
Sheet 

This field lists the setting for the number of badges per print sheet. If you have enabled sheet printing during Badge Setup, the 
number isderived from your sheet layout. If you have not enabled sheet printing, this setting is 1 (every badge printson a 
separate sheet). 

Status The status message on the left at the bottom of the window shows the current status of the Batch Print Queue: 

• Printing Disabled if the Queue is set to Always Ask or Always Queue. 

• Printing Paused if you press the Pause button. 

• Printing Automatic if the Queue is set to Auto Print. 

Badges 
Remaining 

The status message on the bottom right of the window displays the number of badges currentty selected to be printed, and the 
Batch Print Queue status (Disabled, Paused, or Automatic). 

Table 64: Batch Print Manager Status Tab Definitions 

Field Description 

Badge Printing 

Automatic 
Printing 

This field displayswhether Automatic Printing is enabled or disabled. 

Badges 
Printed Since 
Restart 

T his field displays how many badges have been printed since the start of the current Batch Print Queue session. 
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Batch Print Manager Status Tab Definitions (continued) 

Field Description 

Last Badge 
Printed 

This field displays the Date/Time that the last badge was printed. 

Sheet Printing 

Sheet Printing 
Status 

This field displayswhether Sheet Printing is enabled or disabled. 

Badges per 
Sheet 

This field displays the setting for the number of badges per sheet. 

Sheets Printed This field displays the number of sheets of badges printed during this session. 

Starting 
Position 

T his field displays the current starting position (where the next badge will be printed on the sheet for sheet printing. 

Click this button to change the starting position of sheet printing on the current sheet. Changing the starting position is useful if 
you are using a partialty printed sheet or you want to oantrolwhere on the sheet the next badge is printed. a 
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8 

Smart Card Programming, Enrollment, 
and Printing 

This chapter explains how to program, enroll, and print a Smart Card with C•CURE ID. 

In this chapter 

Smart Card Programming and Enrollment 250 
Smart Card Data Confirmation Form Definitions  256 
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Smart Card Programming and Enrollment 

Smart Card Programming is the process of writing information to a Smart Card from a record in the Personnel 
database. The amount of information that can be programmed depends upon the type of Smart Card programming 
device and the Smart Card templates configured for your Smart Card programming device. You can only program 
MIFARE cards. 

Smart Card Enrollment is the process of reading information from Smart Cards and writing it to a record in the 
Personnel database. The amount of information that can be enrolled depends upon the amount of information stored 
on the cards, and the type of Smart Card being used. You can only program up to 16 bytes per block, since a block 
only consists of 16 bytes. Data will be truncated if this limit is exceeded. 

There are three ways that you can Program/Enroll Smart Cards: 

• Using the Enroll/Program Smart Card Button on Page 251. 

• Using Print Badge for Smart Card Enrollment, Programming, and Printing on Page 251. 

• Using Batch Print Badge for Smart Cards on Page 252. 

You can enroll/program a single card or you can set up a batch printer that can program multiple cards from a 
queue (you cannot enroll cards using a batch printer). You can also program cards and print them in a single 
operation (see Using Print Badge for Smart Card Enrollment, Programming, and Printing on Page 251). 

To program and/or enroll Smart Cards, you need: 

• A Smart Card programming/enrollment device or a badge printer with a Smart Card encoder configured on 
your system through_C•CURE ID Badge Setup (see Smart Card Device Configuration on Page 89). 

• One or more programming and/or enrollment Smart Card Templates configured for that device. When you 
create an enrollment template, you define the fields that will be populated by data from the Smart Card. When 
you create a programming template, you define the fields that will be used to write data to sectors on the Smart 
Card. See Smart Card Templates on Page 98. 

• The Enroll/Program Smart Card button on the Personnel Badging tab. 

NOTE 
If you have configured a printer as a Smart Card device using C•CURE ID Badge Setup>Badge 
Printer Configuration, you can program/enroll a Smart Card by clicking Print Badge on the Personnel 
Badging tab. 

C•CURE 9000 provides the ability to do these badging tasks: 

■ Program and modify MIFARE smart cards from personnel records. 

■ Enroll MIFARE, iCLASS, and DESFire smart cards into a personnel record. 

■ Use the Enroll/Program Smart Card on Selected Credential button on the Personnel record Badging tab to 
program and enroll smart cards. 

■ Use the Print Badge button to program, enroll, and print Smart Cards to a printer-based smart card encoder in 
one step, from the Personnel record Badging tab. 
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Using the Enroll/Program Smart Card Button 

If you have set up a badge printer or Smart Card Wedge device using C•CURE ID Badge Setup>SmartCard settings, 
you can use the Enroll/Program Smart Card button to program MIFARE Smart Cards. 

To Enroll/Program Smart Cards Using the Enroll/Prog. Smart Card Button 

1. Click on the Badging tab in the Personnel Record. 

2. Select a badge from the list of badges. 

3. Click Enroll/Program Smart Card on the Badging tab. 

4. If you have configured more than one Smart Card template for your Smart Card device, the Smart Card Print 
Options dialog box appears. Choose the template that you want to use from the drop-down list and click OK. 

5. If you selected Confirm Enrollment Data when you configured the Smart Card Template, the Confirm 
Enrollment Data dialog box for the card type appears. Click Confirm to proceed with the programming or 
enrollment or click Cancel to cancel the operation. 

Using Print Badge for Smart Card Enrollment, Programming, and Printing 

You can use the Print Badge button on the Personnel Badging Tab in two different ways for Smart Card 
Enrollment/Programming and Printing. 

• Individual Processing - If you configured a badge printer for Smart Card programming and enrollment from the 
C•CURE ID Badge Setup>Printer Options dialog box, you can click Print Badge to perform programming, 
enrollment, and printing for a person's Smart Card. See To Enroll/Program Smart Cards Using the Print Badge 
Button on Page 251. 

• Batch Processing - If you configured a badge printer for batch processing of Smart Cards from the 
C•CURE ID Badge Setup>Batching Options dialog box, when you click Print Badge, the badge is added to the 
Batch Queue Manager for programming and printing. See To Batch Program and Print Smart Cards Using the 
Print Badge Button on Page 252. 

NOTE 
You cannot enroll Smart Cards using a batch printer, therefore batch processing is only useful for 
programming MIFARE cards (you cannot program DESFire and iClass cards). When you configure 
the batch printer for use with Smart Cards, you are prevented from adding any Smart Card template 
that includes an Enroll action. You also can configure only one template with a batch printer. See 
Configuring a Smart Card Device on Page 91 for more information. 

To Enroll/Program Smart Cards Using the Print Badge Button 

1. Click on the Badging tab in the Personnel Record. 

2. Select a badge from the list of badges. 

3. Click Print Badge on the Badging tab. 

4. If your printer has more than one Smart Card template configured, the Smart Card Print Options dialog box 
appears. You can choose which Smart Card template to use to enroll/program the Smart Card and click OK, or 
click Cancel to cancel the programming/printing of the card. 
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5. If you chose the Prompt for Print selection when you configured the printer, the Smart Card Print Options dialog 
box appears. You can choose which Smart Card template to use to enroll/program the Smart Card, and which 
operation you wish to perform: 

• Print the badge, do not program the Smart Card. 

• Program the Smart Card, do not print the badge. 

• Program Smartcard and print Badge. 

6. Choose one option and click OK, or click Cancel to cancel programming and printing the badge. 

7. If the template was configured with the Confirm Programming/Enrollment Data option, the Smart Card Data 
Confirmation form appears so that you can Confirm the programming/enrollment that will occur, or click 
Cancel to cancel both programming and printing. See Smart Card Device Configuration Definitions on Page 96 
for definitions of the fields on the Confirmation form. 

8. If your template includes enrollment, the enrollment data is included if needed when the badge is printed, and 
then the data is enrolled into the Personnel record, so that enrollment and printing can be done in a single step. 

 S 
To Batch Program and Print Smart Cards Using the Print Badge Button 

If you have configured your badge printer using Badge Setup>Batching Options to support batch operations, Print 
Badge works differently. With batch printing, only MIFARE cards can be programmed, only one template can be 
assigned to the batch printer, enrollment is not available, and badges are queued to the Batch Print Queue for 
processing. 

1. Click the Badging tab in the Personnel Record. 

2. Select a badge from the list of badges. 

3. Click Print Badge on the Badging tab. 

4. The badge is processed according to your Batch Queue Mode setting: 

• If the mode is set to Auto Print, the badge is programmed and then printed. 

• If the mode is set to Always Ask, the Batch Print Manager dialog box is displayed to let the user choose 
whether to print a single badge, print all badges in the queue, or add the badge to the batch print queue. 

• If the mode is set to Always Queue, the badge is added to the batch print queue, and the Batch Print 
Manager dialog box is displayed to let the user choose whether to print a single badge, print all badges in the 
queue, or leave the badge in the batch print queue and print it at a later time. 

5. To print the badge from the Batch Print Manager, select the badge from the badges listed in the queue and click 
Print on the toolbar. See Batch Print Manager on Page 244 for information on other batch printing options. 

Using Batch Print Badge for Smart Cards 

If you have set up a batch badge printer using C•CURE ID Badge Setup>Batching Options, you can use the Batch 
Print Badge selection on the context menu for one or more Personnel records in a Dynamic View to program 
multiple MIFARE Smart Cards in one operation. 
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NOTE 
You cannot enroll Smart Cards using a batch printer, therefore batch processing is only useful for 
programming MIFARE cards (you cannot program DESFire and iClass cards). When you configure 
the batch printer for use with Smart Cards, you are prevented from adding any Smart Card template 
that includes an Enroll action. You also can configure only one template with a batch printer. See 
Configuring a Smart Card Device on Page 91 for more information. 

To Program Smart Cards Using Batch Print Badge 

1. From a Dynamic View of Personnel records, select one or more Personnel records. 

2. Right-click to display the context menu. 

3. Click Batch Print Badge. 

4. If you had set the Batch Queue to Auto Print, each badge is first programmed according to the Smart Card 
Template you configured for the printer, then printed. If you set the Batch Queue to Always Ask or Always 
Queue, each badge is added to the Queue. You can program/print any or all of the badges from the Batch Print 
Manager dialog box. 

Performing Batch Enrollment for Proximity Cards 

You perform batch enrollment for proximity cards from the either the Personnel or Credential Dynamic View by 
selecting the persons whose badges you want to enroll and choosing Batch Print Badges from the context menu. 

If your Personnel have more than one badge, you can control which badges you enroll by using the Credential 
Dynamic View to select only the credentials you want to enroll. The Credential Dynamic View lists each person's 
credentials in a separate row, so you can choose which of a person's credentials to associate with the proximity card 
you want to enroll/print. 

To use this capability, you must have: 

• Configured your printer to perform batch enrollment of Proximity Cards (see Configuring Batch Enrollment for 
Proximity Cards on Page 41). 

and 

• Set up an Import definition to import the card number from the Proximity card into the corresponding Personnel 
record (see Configuring an Import Definition for Batch Enrollment on Page 44). 

To Batch Enroll Proximity Cards 

1. Choose Personnel or Credentials from the Personnel pane drop-down list. 

2. Click Pal to display a Dynamic View listing all Personnel (or Credentials). 

3. Select the Personnel whose proximity cards you want to enroll from the list (using CTRL+Left-click to select 
multiple Personnel). 

4. Right-click to display the context menu, and select Batch Print Badges. 

5. C•CURE ID displays a log window to show the progress of your queuing request, and the status of the badges 
you queued. 
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Figure BO: Batch Print Badges Log Window 
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6. Click OK to close the log window. 

NOTE 
The Print button on the log window prints out the log window, not the badges themselves. 

You can click Email to email the message box to the recipient who was configured in the System 
Variable Email Address under Customer Support 

(The Email function is intended to provide a way to email information to Customer Support for your 
site. See the C• CURE 9000 System Maintenance Guide for more information.) 

7. Depending upon the options you have chosen for Batch Printing, the badges you queued are either processed 
immediately or are held in the Batch Print Manager. 

• If you had set the Batch Queue to Auto Print, each badge is first programmed according to the 
Smart Card Template you configured for the printer, then printed. 

• If you set the Batch Queue to Always Ask or Always Queue, each badge is added to the Queue. 
You can program/print any or all of the badges from the Batch Print Manager dialog box. 

8. When the printer prints the badge, it also encodes the card number and Personnel record data to a .CSV file. 

9. The Import Watcher notices the new .CSV file and uses the Import definition you defined to import the data. 

10. For each of the Personnel you selected, the card number of the proximity card you printed as a badge is enrolled 
to the correct Personnel record. 

Performing Individual Enrollment for Proximity Cards 

You perform individual enrollment for proximity cards from the Personnel Badging tab. 

• Click Print Badge to print and enroll the proximity card selected on the Badging tab for this Personnel Record. 

• Click Enroll/Program Smart Card to enroll the proximity card selected on the Badging tab for this Personnel 
Record without printing it. 

To use this capability, you must have: 

• Configured Printer Options in Badge Setup to perform printing and enrollment of Proximity Cards (see 
Configuring Individual Enrollment for Proximity Cards on Page 42). 
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or 

• Configured Smartcard settings in Badge Setup to perform enrollment of Proximity Cards (see Configuring Batch 
Enrollment for Proximity Cards on Page 41). 

• You also must have set up an Import definition to import the card number from the Proximity card into the 
corresponding Personnel record (see Configuring an Import Definition for Batch Enrollment on Page 44). 

To Enroll Proximity Cards 

1. Choose Personnel or Credentials from the Personnel pane drop-down list. 

2. Click flitit to display a Dynamic View listing all Personnel (or Credentials). 

3. Select the Personnel whose proximity cards you want to enroll from the list. 

4. Right-click to display the context menu, and select Edit. The Personnel Editor opens. 

5. Click the Badging tab. 

6. Select the badge you want to enroll from the table listing the badges for this Personnel record. 

7. Click Print Badge to print the badge and enroll it, or click Enroll/Program Smart Card to enroll the badge only. 

8. When the printer prints the badge, it also encodes the card number and Personnel record data to a .CSV file. (If 
you used the Enroll/Program Smart Card button, the card is enrolled but not printed). 

9. The Import Watcher notices the new .CSV file and uses the Import definition you defined to import the data. 

10. For each of the Personnel you selected, the card number of the proximity card you printed as a badge is enrolled 
to the correct Personnel record. 
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Smart Card Data Confirmation Form Definitions 

If you select Confirm Programming Enrollment Data when you define a Smart Card template, the Smart Card Data 

Confirmation Form is displayed when you use that template to program data to or enroll data from a Smart Card. 

This form lets you preview the operations that will be performed, and gives you an opportunity to confirm and 

continue the operation, or cancel the operation. If you cancel the operation, the card is ejected from the printer 

without being printed. 

NOTE 
The Default Smart Card Templates do not have Confirm Programming Enrollment Data selected. If 

you want to have the chance to confirm data, create a template that has Confirm Programming 

Enrollment Data selected. 

Table 65: Smart Card Data Confirmation Form Definitions 

Field Description 

Sector 
Number 

This column displays each of the sectors that are being programmed or enrolled. 

Sector 
Label 

T h is colu m n displaysthe user-defined Labeler the sector. 

AID Value This oolumn displays the Application Identifier (AID) value of the sector. 

Value Displays the Card Serial Number read from the card. 

Enroll to 
Field 

Displays the Personnel database field to which the Card Serial Number is being enrolled. If this field is blank, the 
Card Serial Number is not being enrolled. 

Block 
Name 

Each row of thisoolumn representsa blockon this sector of the card. Blocksare 0, 1, and 2. 

Data This column displays the actual data that is being programmed to the block or the data that was enrolled from the card. 

Operation Thisoolumn displays the operation being performed - Program. Enroll, or None. 

Data 
Field 

This column displays the data field that was configured in the template in the Field or Format field for this block. 

Optional 
Fields 

If a template is performing operations with a Card Format, additional columns representing the Card Format fields are added to the 
data grid. These columns represent the data fields that are being programmed or enrolled. 

Confirm Click Confirm to proceed with the Program/Enroll operation as d ispLayed on the form. 

Cancel Click Cancel to cancel the Program/Enroll operation and eject the card. 
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